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Foreword

When we launched Cubase Version 1.0 at the 1989 Frankfurt music fair, we at Steinberg were
convinced that we had found the right concept, but none of us really knew whether the user would
agree. We had, it’s true, gained a large amount of experience programming MIDI recording
software. We could look back on the success we had had with the Pro-16 on the C 64 computer,
and we were responsible for developing the first MIDI sequencer for the Atari ST, the Pro-24.
The Pro-24 saw in a new era in music software. It enabled musicians all over the world to relate
to the new technology and all that it could do. Most of these musicians had had little experience
with computers and were, essentially, navigating uncharted waters. All this happened in *86
through ’88 in a way that exceeded our wildest dreams.

Something that we failed to predict was the variety of uses that musicians would find for the Pro-
24. We had, and continue to maintain, a close relationship with our users, one which we feel is
very important. The result is an on-going exchange of ideas, with suggestions, criticisms and
ideas for improvement. Many of these were incorporated in the Pro-24 but, as happens in the
studio, when you’ve filled up all the tracks, when you’ve used up all the effects and the desk’s
faders are all the way up, you either say: "that’s as good as it gets", or you start over.

So we started over. The aim was to come up with a new concept; an open one, with plenty of
potential for future expansion. A program that allowed the musician to concentrate on what he
or she was good at: the making of music. The musician should have control over the musical
arrangement at all times, with plenty of opportunity to try out ideas and to radically alter the
arrangement and other things using simple tools. All this planning led to Cubase.

"Don’tstop the music!" was one of our ground rules: no matter what the user wants to do, whether
it be opening an editor, rewinding, adding a few notes or even saving the song on disk, the music
should carry on playing. Very few musicians find having to wait for a whirring disk drive very
creative, and waiting for the screen to refresh before you can carry on working can become very
irritating.

This was one of the reasons we at Steinberg developed M*ROS = MIDI Realtime Operating
System, a further milestone in MIDI software development, and at the heart of the Cubase
concept.

But back to the beginning of my foreword. Cubase became a huge success. Its simple, straight-
forward concept speaks for itself, and every user has since spread the word as no advertising
campaign can. Its success spurred us on to strive for further improvements in the concept, helped
by the contact with Cubase users.

Music can be anything from a single note to interlocking, complex musical structures, from folk
to jazz, pop to classical or movie soundtracks to avant-garde. Inevitably, this means that there
are all kinds of ways of approaching the program. Although Cubase is easy to operate, and the
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Foreword

user manual goes a long way to describing the individual functions, additional help in the form
of practical examples makes it that much easier to get to grips with the software: that’s what this
book is intended to do. There are still secrets to be discovered in Cubase, in the score printing,
the editors, synchronization, the Interactive Phrase Synthesizer, and much more. Following an
example is often a better way of understanding a function than simply reading a description about

what it does. MIDI recording is a world in its own right, and this book will help you to enter it.
But whatever you do, keep in mind that musicians love to play so above all, have fun!

I hope you enjoy this book, this world, and this program. Maybe you have a few ideas you would
like to share with us and other Cubase users. We would certainly appreciate it.

Manfred Riirup
Steinberg Soft- and Hardware Hamburg, March 1992
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Introduction

During the early stages of electronic music, no-one could have foreseen the rapid development
that has taken place in this field. Not only has the equipment become increasingly powerful, it
has also gone down in price: a development more than welcomed by everybody. Instruments that
used to reach the dizzy heights of $6000 a few years ago are now available at a fraction of that
today - with the added bonus of increased power.

Although the concept of using computers with music was around a long time before the MIDI
era, it was the introduction of the MIDI interface in 1982 that really got things going. Early
experimentation with the Commodore C 64 computer hinted at the possibilities offered by the
hardware, but it took higher performance computers such as the Apple Macintosh and Atari ST
to raise the standard to a level acceptable for professional applications.

On the downside, the progress in technological development is making big demands on the user.
Modern synthesizers and software programs often contain hundreds of functions which have to
be understood before a program can be used to the best of its abilities.

This book is designed to familiarize you with one of the professional programs in this field:
Steinberg’s MIDI recording system, Cubase. Unlike Cubase’s operating manual, this book is
based on practical applications. Its numerous examples will help you to quickly grasp the
prograin’s functions. Strong emphasis is placed on the more complex parts of Cubase using
practical examples to bring you and Cubase closer. It therefore makes sense to have your
computer to hand as you work your way through this book: not only will you become completely
familiar with Cubase but, as an added bonus, you will learn a lot about MIDI and computers.

The original version of Cubase ran on the Atari ST only. Since then, the Cubase family has grown,
giving us streamlined Atari versions, and versions for the Apple Macintosh and MS-DOS
computers.

You don’t have to be a computer expert to be able to use Cubase or understand this book. All the
steps you have to take are explained in detail. You will soon see that there are often several
different ways of achieving the same result. Try them all out, and choose the method that suits
you best. There’s also additional information on computers and peripheral equipment, in so far
as it affects Cubase, in the appendix.

There were a number of people directly or indirectly invelved in the creation of this book, and
I would like to take this opportunity to thank them for their input: Gunther Carstensen, Peter
Gorges, everyone at Steinberg, especially Manfred Riirup, Karl Steinberg, Ralf Schliinzen and
the programmers, Apple Germany, Sabine and Caro, the sub-editors for the English language
edition and everyone else who in whatever way contributed to the final result.

Udo Weyers July 1992

17



e

18

!n_’rroducﬂgn_ -



Setting up the Computer

Installing the System

1.1 Versions

This book is based on Cubase version 3.0 for the Atari ST/TT. If you have not yet acquired this
update, you should definitely consider doing so as it contains a number of useful new features
and functions. The cut-down versions, Cubeat and Cubase Lite, are similar enough in operational
terms to the larger Cubase program for most of the information in this book to apply to them as
well. The same is true of the Macintosh and MS-DOS Cubase versions, although their user
interfaces differ slightly from the Atari version. A separate chapter at the end of this book
covering installation and operation is addressed to Cubase Mac users.

1.2 Installation

Let’s first look at what you need to operate Cubase. All the examples in this book are based on
an ST configuration consisting of an Atari 1040 ST/STE, Mega ST/STE or a TT computer with
ahighresolution monochrome monitor such as the Atari SM 124 or SM144. If you own additional
hardware, such as a hard disk, large-screen monitor or printer, you will find the relevant
information in the appropriate chapters.

From version 3.0 on, Cubase users whose computers have a single megabyte of RAM may find
themselves running out of memory, depending on the program configuration selected. We’ll
return to this topic later.

1.3 Setting up the computer

Connect all the computer components, i.e. the mouse, keyboard (for the Mega ST/STE and TT
models), monitor and AC mains cable following the steps in your Atari manual. Use of a mouse
mat is also recommended to keep your mouse clean.

You probably can’t wait to switch your computer on, but please wait just a little longer!

1.3.1 The dongle

The Cubase package includes two manuals, two Additionals disks, and a "dongle", or key. This
small red or black (depending on the version) electronic module ensures that Cubase cannot be
copied or distributed illegally. Please note that version 3.0 has a new dongle: version 2.01 will
not run using the 3.0 dongle and vice versa.

19
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Installing the Sysfem

Using a dongle has both advantages and disadvantages. The main advantage is that you can (and
should) make as many backup copies as you need of the program disks which themselves are not
copy-protected. Never work with the original program disks in case you inadvertently alter or
delete important files.

You cannot run Cubase without the dongle. It must be inserted in the computer before you start
the program. If you lose the dongle, you effectively lose your program, sO keep itin a safe place.

Insert the dongle into the ROM port located on the left side of your Atari, which is also where
the MIDI ports are on the 1040 ST. The Mega ST has its keyboard port there, too. Please keep
two important factors in mind: first, make absolutely sure your Atari is switched off before you
insert the dongle; second, ensure the dongle is inserted with the "Steinberg - This side up"
inscription facing up. Failure to observe these two caveats may lead to damage to the dongle or
the computer. Or both.

Don’t use brute force to insert the dongle - it’s easy to plug in, and it’s all too easy to damage the
ROM port’s terminals. If you run into problems after switching the power on (no picture, disk
drive will not activate), more often than not the source is an incorrectly seated dongle. Turn your
computer off and insert the dongle correctly.

1.3.2 Disks

Consult your Atari manual on how to make backup copies of disks, though you will find a better
method described in the appendix of this book. Youneed 3.5" blank disks to make a backup copy
of the program and save the results of the work we’1l be doing - these are available from computer
shops, mail order companies and large department stores” computer sections.

The Atari works with "double-sided, double density” (often labelled "2DD") disks. Do not buy
High Density (HD) disks as your Atari cannot correctly process this format; however, some
Mega STE and TT computers come with a high-density drive which is intended for HD disks.
Besides the relatively expensive brand-name disks, many shops offer "no-name", unbranded
disks. These disks are usually manufactured by brand-name companies, and appear to suit our
purpose perfectly well.

Before you can use a new disk, you have to format it. An unformatted disk is a bit like a record
without grooves - your computer will rejectit. Formatting divides the disk into tracks and sectors
which enables the computer to store data at specific locations on the disk and to retrieve the data
later. Computer companies use different methods to apply tracks and sectors to disks, which
means, forinstance, that adisk formatted by an Atari computer cannot be read at all, oronly under
certain conditions, by an Apple Macintosh, and vice versa.

Along with your backup copy, format several more disks following the instructions in your Atari
manual. We will later be saving the results of our work on these blank formatted disks. If at some
point you discover you have created a musical masterpiece but do not have a formatted disk
available, don’t panic! You can format disks without leaving Cubase. But more on that later.

As your Atari manual will have explained, every 3.5" disk can be mechanically write-protected
using the little tab in one corner of the disk. Your program disks (original and backup) should
always be write-protected, though obviously you shouldn’t write-protect disks you want to save
songs and Arrangements on. Write-protecting does not stop the computer from reading a disk,
only writing data to it or deleting data on it.

1.3.3 Hard disks

In the past, hard disks were generally peripheral to a normal Atari setup. The new TT and Mega
STE models have changed all that: both versions come factory-fitted with hard disks, or at least
offer them as options. The 1040 ST/STE cannot be fitted with an internal hard drive; the old Mega
ST can be, though any Atari model will support an external hard drive.

Hard disk drive owners should copy all Cubase files on to the hard disk. For further details, see
the appendix of this book.
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1.4 Cable connections

Connect your MIDI master synthesizer and any other MIDI sound modules to your sound
system.

(Please note: we will use the term "master synthesizer" or just "master” in this book to mean the
MIDI synthesizer that you are using to transmit data to the computer. This catch-all term includes
any MIDI device that produces a sound and that has a way of transmitting MIDI data - it could
be a synthesizer, sampler with keyboard, MIDI "workstation", MIDI guitar with expander and
so on. If you have a "mother" keyboard which produces no sound, this is essentially the same as
having a master synthesizer for our purposes; example 4 below is for you.)

Next, connect the Atari to the other MIDI components in your system using good quality MIDI
cables available from any music shop. Because there are lots of setup variations that depend on
what instruments and peripheral equipment you use, this section contains a few examples of
connections.

Whichever example you follow, set your master synthesizer’s "MIDI Local Control" function
to "Off", provided it supports this function. Disabling "Local Control" means that the circuit
connecting the master’s keyboard to its sound-generating section is internally severed. Some
older models do not offer this feature: if this applies to you, use the method described in "The
classic stumbling block: MIDI Thru".

MIDI OUTA' MIDI IN
Cubase
Sound-
> Generation
L This connection is disabled
(Local Off)
The MIDI Local Control function
MIDI OUT
A MIDI IN CUbase
MIDI IN| [MIDI OQUT

M —— sz

il

Example 1: connecting the master synthesizer to the computer/Cubase
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Cubase as MIDI recorder: the information generated when you play your master’s keyboard is
transmitted from the master’s MIDI Out port to the Atari’s MIDI In - where it can be recorded

by Cubase.
Cubase as realtime MIDI processor: furthermore, this data being generated by your master’s

keyboard can be instantly processed (in "realtime") by Cubase and immediately sent back from
the Atari via its MIDI Out port to your master, even if you don’t record it in the sequencer.

Cubase combining both of the above functions: the data being generated by your master’s
keyboard can be merged in realtime inside Cubase with the data already recorded and being
played back, and both sets of data sent back from the Atari via its MIDI Out port to your master.

The last paragraph describes the standard configuration on which most of the exercises and
examples in this book are based. However, these examples can easily be adapted to other
configurations.

Whenever we discuss Cubase functions that require additional hardware or software (Midex,
SMP 24 etc.), your attention will be drawn to it. If at all possible, create a multitimbral setup for
the more advanced exercises in this book, either within your master synthesizer (if it is
multitimbral) or using several additional synthesizers. Assign a piano sound to MIDI channel 1,
bass to MIDI channel 2 and strings to MIDI channel 3. Add drums on MIDI channel 10, if
available.

In case you’re wondering, "multitimbral” means "able to respond to more than one MIDI channel
simultaneously, allocating a different sound to each channel”.

MIDI OUT Modules
i MIDI IN Cubase
Y
MIDI IN| [MIDI OUT MIDI IN
C | -
MIDI THRU MIDITHRU e
i — n

L) —
m [

=l [®):::

A0 T

Tiﬂ-mm

Example 2: the master synthesizer plus several MIDI devices

Use of a multitimbral setup, whether it’s within one instrument or spread over several, is the best
way of making full use of Cubase’s capabilities.

Essentially, example 2 shows you the same setup as example 1, the only difference being that
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messages entering the master’s MIDI In are instantly sent on to various additional modules via
its MIDI Thru port.

This setup should not create any timing problems if you are using modern MIDI equipment.
However, if you add too many (older) devices to this system you may run into response delays,
which are perceived as timing fluctuations.

If you are fortunate enough to own several MIDI devices, do try and use a MIDI Thru box. This
results in a "star" system, as follows:

MIDI OUT
|
4 ¢ MDIN| cubase
Modules
MIDI IN
MIDI THRU Box
| MIDI THRU L _» IR gﬂ BT
\ o
B IN
MIDIIN| | MIDI OUT L [®)::

000
.
IN

i
30 A A

Example 3: the master synthesizer plus several MIDI devices and a Thru box

-D:Z:EEEE]:I
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1
B B e

The Thru box instantly sends all the data it receives to the devices at the same time. This means
that if you are using a MIDI device that has problems re-transmitting the Thru data on time, you
are bypassing the problem altogether!

Plus, thanks to this "star" system, it’s much easier to keep track of what cable is going where -
and each device has only one cable going to it.

(Note, however, that it is rare for a MIDI device’s MIDI Thru circuitry to give problems - MIDI
timing problems are much more likely to be due to too much data being sent at the same time via
the same MIDI port, or due to a device reacting too slowly to data being sent to it. Where MIDI
Thru circuitry may well give problems is in devices that have a "soft" Thru, where you can switch
a port between MIDI Thru and MIDI Out - but that’s another story.)

You can, of course, replace the master synthesizer in our examples with a "mother" keyboard.
Mother keyboards are sophisticated "mute" keyboards that don’t generate sound, only MIDI
commands. You don’t need the MIDI connection back to the keyboard, and mother keyboards
have no MIDI Local Control function as they don’t need them:
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MIDI OUT
—

[ { MDIN

3 Cubase

Modules

MIDI IN

MIDI THRU Box

MID! THRU | MiDHiN

Y

Yy VvV L

MIDI QUT

M

T .N

Example 4: using a "mother” keyboard instead of a master synthesizer

000
388

One more suggestion on cable connections: the MIDI In and Out inscriptions on the Atari’s ports
are fairly small, and on the 1040 models, difficult to get at. You might find it useful to label your
Atari’s MIDI ports so it’s easy to make out which is which.

1.5 Power up!

Now we’re ready to start. Insert abackup copy of your program disk into the disk drive and switch
your computer on. After a short while the standard Atari desktop will appear.

The Atari desktop
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Power up!

Your screen may differ slightly from the diagram above, depending on which computer model
you use, whether hard drives are installed, and so on. However, in principle and for our purposes,
operations are identical in all Atari ST, Mega and TT models.

Note that the contents of the disk may appear in a window that opens automaticaily. This is fine
- all it means is that the disk was programmed to display its contents automatically on start-up.
This doesn’t stop you from carrying on with your reading!

There is not a great deal to see or change on the desktop. If you are already familiar with the
Atari’s basic operations, you will already know about the range of functions available here.
However, if you are a computer novice you may want to investigate the desktop area. The best
way of getting to know the Atari computer is by becoming familiar with its manual’s contents.
It covers basic operations such as handling the mouse, plus all the other useful things you need
to know. This book on Cubase has to assume that you have read at least the basic topics in the
Atari manual.

Let’s look at the contents of the Cubase program disk, which you should already have inserted
in drive A. To do this, activate disk icon A by placing the mouse pointer on it and clicking the
left mouse button twice in rapid succession (called "double-clicking"). A window will now open
displaying the contents of the disk.

=]

oy

A
e R
—r

FLOFFY COIZK

A disk icon

Beginners may find double-clicking awkward, but you will soon get used to it. If, however, you
are having real problems here, there is a simpler but more time-consuming alternative to double-
clicking. Click disk icon A once (the icon is now "highlighted", i.e. it reverses shade). Place the
mouse pointer on the File menu heading in the Menu Bar across the top of the screen: a "drop-
down" menu appears. Move the pointer down to menu item "Open" (as you move the pointer to
an item, it becomes highlighted) and click the left mouse button once. The disk’s contents will
now appear in a window.

Desk File View Options

Selecting disk icon A

Hew Folder...

Close
Close Hindou

Selecting "Open"
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The disk’s contents will look something like this:

CUBRASE «DAT EXAMPLEZ GDosE MROS CUBASE .FPRG . .
DEF .5ET IMNSTARLL.PRG INSTALL.RSC KEVSLOT .AC LINKEDIT .REC READ_ME . TXT SATELLIT.AC

SHAF_A.FIZ SWITCHER “PRG SWITCHER .RSC SWITCHER.SET TEET .ARR

¢ F

An Atari ST window displaying the contents of the Cubase program disk

If you are already familiar with the Atari’s windows, so much the better: skip the following
paragraphs and go to "Initial settings". If not, try the following exercises: they will help you make
full use of Cubase in due course.

- Move the mouse pointer onto the shaded bar along the top of the window (the "Title Bar"). Press
and hold down the left mouse button. You can now "drag" the window to another position on the
screen by carefully moving the mouse pointer. Releasing the mouse button completes the
operation.

- There are two "scroll bars” in the window: one along the bottom of the window and one down
the right edge. The arrows at each end move ("scroll") the window’s contents in the direction the
arrow is pointing to. You may need to scroll a window’ s contents if you want to view information
which is not currently in the window. A quick glance at the scroll bars will tell you whether there
is more information to be seen. If the window’s contents continue beyond its borders, the scroll
bars become speckled in the corresponding direction, and a "scroll box" appears which you can
drag along the scroll bar. For more on scroll bars, see the Atari manual.

- You can change the window’s size. Click and hold the symbol in the bottom right corner (the
window’s "size box'"), which causes the window frame to appear as a dotted line. Drag the size
box until the dotted line is showing the window size you want, and release the mouse button.
- Click the diamond symbol in the top right corner (the "zoom box") to enlarge the window to
its maximum size. Clicking the zoom box again returns the window to its previous size. This
allows you to toggle between two window sizes.

- Click the symbol in the top left corner (the "close box") to close the window. Follow this by
double-clicking disk icon A to open the window again.

For more on window techniques, see the Atari manual. As you gettoknow Cubase, you will come
across these basic techniques again and again.

1.6 Initial settings

Being creatures of comfort we’ll let the computer do some work for us. The window we have just
opened contains all the file names on the disk, one of which is the important program file called
CUBASE.PRG: double-click it, and the computer will load (or "boot") the sequencer program .
into its memory.

If you do not see this file on your screen, you have either loaded the wrong disk, or the window
section on your screen is not displaying it: scroll the window’s contents by clicking and holding
the appropriate scroll bar arrow as described above. If you are having problems double-clicking
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the program file, use the alternative method ("Open" in the File menu) which we described
earlier, but try not to make a habit of it.

Loading takes approximately one minute. This can be reduced to about 15 seconds if you use a
hard disk. After loading is completed, Cubase’s main screen, called the Arrange window, will
appear.

{» File Edit Structure Functions Options Modules Windows

OBRA 1 npp [FOLL ]

SEnap BAR | Mouse 1. 1. ] Quantlze 16 lcucie Rec Mix I_ﬁl
A |l~| |C IT ITrack Chry |Instr~unent l"‘ I | 1 b ] 1 ] [ 1 | G

J Track 2 2 i

Py Track 3 3

4 Track 4 4

Py Track 5 5

Iy Track & &

Fy Track 7 7

& Track 8 8

& iTrack 9 9 k

Fy Track 18 16

4 Track 11 11

4 Track 12 12

g Track 13 13

Fy Track 14 14

Fi Track 15 15

$ Track 16 16

The Cubase 3.0 Arrange window

At first, the amount and variety of information in this window may confuse you. Don’t worry,
it’s the job of this book to help you find your way around Cubase! You’1l find that most operations
take place in the Arrange window, including such basic and essential functions as recording,
arranging, copying, and many more.

For your first Cubase steps, set your master synthesizer to receive on MIDI channel 1. Do not
select a multitimbral program. Play a few notes on its keyboard. Two small displays, labelled I
(MIDI In) and O (MIDI Out), should be moving in the lower right portion of the screen. This
means that information is being received from your synthesizer (I) and is being sent out again
from the computer (O). The master synthesizer, silenced by having its MIDI Local Control
function disabled, is sounding again because its sound-producing section is now receiving MIDI
messages.

The MIDI In/Out displays
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Please note: to ensure everything works the way that has been described, the first Cubase Track
must be selected (Track 1 is highlighted), and its MIDI channel must be set to 1: these are the
program’s default settings. If for some reason this is not the case, do carry on for the time being.
We will come back to this topic in a little while.

1.7 The classic stumbling block: MIDI Thru

If nothing moves on the screen, please repeat all the previous steps.

If the MIDI In display moves, but the MIDI Out does not, then Cubase’s MIDI Thru function is
not active. The Atari is receiving your master’s signals, butis not returning them back toit. Move
the mouse pointer to the Options menu heading in the Menu Bar across the top of the screen and
select menu item MIDI Setup....

A new dialog box will appear on your screen. For the time being, we are only interested in the
MIDI Thru Active function. There should be a checkmark in the box to the left of thistitle. If there
isn’t, click the empty box once. The checkmark will appear and denote that the MIDI Thru
function is now active. Checkmarks are used to activate functions throughout the program.

Suoowiie FEid Sivmstare Fuspilons  Helisns magutes  Bindosms

ARRANGE - DEF.ARR

BAR | Mouse 6. 1. a8 || muantyze 16 | cucie mec Mix "_H_Q_

Defining the Thru function

The Thru Off channel display directly underneath MIDI Thru Active can be significant. It
provides the solution to a specific problem, where you have a synthesizer that does not suppoit
MIDI Local Control, but you want to use it as your master.

This is not really a problem if you are using your master to transmit data to the sequencer using
a MIDI channel that Cubase is not transmitting on; all that happens here is that you will hear your
master’s sounds while you are playing its keyboard (as there is no MIDI Local function to turn
it off) together with the sound of the device Cubase is transmitting to. If this bothers you, simply
turn your master’s volume all the way down.

A problem only arises when you are transmitting on the same channel that Cubase is set to re-
transmit on. Here, the master is receiving two sets ol messages as aresult of the cable connections
suggested in the examples above: one directly from its internal circuit, and the other from the
Atari, via Cubase’s MIDI Thru circuit. The resultis anunwanted doubling of everything you play
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on that channel. By dialling in the offending channel in the Thru Off Channel function, you are
blocking that channel from being passed through Cubase and back to the master.

Once you have entered the correct settings, exit the dialog box by clicking OK or tapping the
Return key on your computer keyboard.

1.8 Control: mouse v keyboard

Let’s end this chapter with a brief word on basic operations. There are two ways to execute many
functions: via the mouse or your computer keyboard. For the time being, you will find yourself
relying on mouse control, i.e. moving the pointer and clicking a mouse button, because mouse
control is very intuitive. In the following examples you will be asked to execute functions with
the mouse button: please ensure you always use the left button unless specifically told to use the
right one.

Many functions, however, can be executed much more quickly using the computer keyboard.
Once you become more familiar with the program, you will probably combine the two control
methods, so this book describes both of them. Each operation is accompanied by its corresponding
key command in brackets. Simply press the appropriate key or key combination on the
alphanumeric keypad or the numeric keypad (the latter is the calculator-type cluster at the far
right of the Atari keyboard).
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2 The Basic
Functions

Now that we have booted Cubase, we will spend some time looking at the Arrange window in
detail.

It consists of three basic elements:

- The Menu Bar along the top of the screen is used to select additional commands or call up other
areas of Cubase. Move the mouse pointer onto the Menu Bar: as it touches each menu heading,
a drop-down menu appears, containing a number of items. As you move the pointer down a list
of items, they highlight in turn: clicking a highlighted item selects its function.

To get rid of the menu without selecting any item, simply click anywhere outside the menu.

<> File Edit Structure Functions Options Modules Windows

The Menu Bar

- The Transport Bar located along the bottom of the screen contains functions that correspond
roughly to those of a tape recorder. It is used to start, stop, and execute other control commands.

mi}l OVERDUE

. PUHCH 5T LOCAT

The Transport Bar

- Between the Menu and Transport Bars, which are identical throughout Cubase’s various screen
pages, you will find a window, which in this case is the Arrange window. This Arrange window
can itself be divided into three elements:

- The lefthand area contains the sequencer Tracks with their MIDI channels and other assignment
functions. Cubase defaults to displaying 16 Tracks, which can be increased to up to 64 if required.

- The major area of the Arrange window consists of a white surface which we’ll call the Part
Display: this is where graphic information is presented, showing you if and when the Tracks are
playing. The line directly above it containing numbers (1, 5, 9, 13...) is the Position Bar which
tells you where you are within the song at any given moment.
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Now for an overview of the Transport Bar.
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Record mode (Overdub/Replace)

Soloing
individual
Tracks

1. 1. 8
. EDSoLa
N 5. 1. 8
—{ CYCLE
Cycle ? '
on/off Punch in/out Right and Left Locators

There’s also the Functions Bar, containing terms such as "Snap”, "Bar", "Mouse", etc., located
between the elements of the Position Bar and the Menu Bar. We will learn more about this later;
meanwhile, here’s a quick overview:

] Enlarges window to
Closes the window

l Name of the current Arrangement maximum size
Il snap BAR Il Mouse 1. 1. a I quarts ze 16 lcocie Rec Mix Il ra
T T N Quantization Cycle functions /
Snap resolution Current mouse position resolution

Automatic quantization
in Cycle mode

The Functions Bar

The following diagrams show you the individual elements of the Arrange window in detail.

Left locator
Song Position Triangle
l Right locator

v

M e I B i ! = 1)
-
Position Bar
k
Scroll Bars —
LeB
The Part Display
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Activity display
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The Track List

If you record something in a Track, horizontal beams appear in the Part Display. Each beam
represents the length and location of a recording. This beam is called a "Part”, as it forms part
of an overall Track. This is rather like multitrack recording on a tape recorder; in fact, the way
Cubase works and is displayed leans heavily toward multitrack recording with tape. If you have
ever seen amultitrack tape recorder’s track sheet, you will find the following illustration familiar.
Your Arrangements will look something like this later on.
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The Arrange window containing recorded Parts
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2.1 Your first recording

The best way to become familiar with the many functions and displays of the Arrange window
is to try them out and experiment, so let’s record something. Loosen up your fingers, we’re ready
to roll.

We willrecord a Part on the first Track. To do this, you must first select a Track. A selected Track
1s denoted by a black beam that highlights it,

:F'I IM I: T Tr-acl-c. Chn Instr-unent
‘i iTrack 1 i1

A selected Track
A |M]C |T |Track ki Instrument
4 Track 1 1

A Track that’ s not selected

After you have booted Cubase, the first Track normally defaults to MIDI channel 1. If this is not
the case, click on the word "Track 1".

Move the mouse pointer to the first Track’s MIDI channel display (Chn) and set the value to 1
as described in the following paragraphs.

2.2 Important! Entering values

There are two ways to enter values in Cubase. Try them both out,

- Click the MIDI channel’s value with the left or right mouse button. The value will change with
each click, moving up with the right button and down with the left. Keeping a mouse button
depressed makes the values scroll further. To accelerate the scrolling in either direction, press
the computer’s [Shift] key in addition to the mouse button, or press the other mouse button in
addition to the first one.

- You can also type in values. Double-click the value you want to change: an empty input field
will appear. Enter the desired value via the top line of the alphanumeric keypad or the numeric
keypad. Then press the [Return] key.

Go for the method you feel most at home with.

These two inputting methods, i.e. using the left and right mouse buttons or double-clicking and
typing numbers + [Return], are used to enter all the values in the program. Use one of these two
methods when you are asked to enter a value.

2.3 Back to the song

After this short but essential detour, we return to our recording. Ensure your computer monitor’s
volume is turned all the way up. Start the recording by clicking the Record button (computer
keyboard: [*] on the numeric keypad).

The Record button
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Cubase will provide you with a two bar count-in, after which the recording starts. Record
something as long or as short as you like (a song can be up to 9999 bars long!) though around
eight bars would seem like a good length to start with.

Stop the recording by clicking the Stop button (computer keyboard: [Spacebar], or [0] on the
numeric keypad).

The Stop button

Cubase ends the recording process and stops at the current position in the song. We now want
to listen to the results, so the sequencer must be "rewound". At this stage, there are two methods:
click one of the spooling buttons to move freely throughout the song (computer keyboard: [(] for
rewind and [)] for fast forward on the numeric keypad).

The spooling buttons

Pressing the [Shift] key in addition to the mouse button, or additionally pressing the other mouse
button, accelerates the "spooling”. However, we will use a much simpler method:

If you press the Stop button a second time, Cubase automatically returns to the beginning of the
song. Do this, then start the playback by clicking the Start button (computer keyboard: [Enter]
on the numeric keypad).

The Start button

You can interrupt playback at any given time, whereupon Cubase will stop at the current song
position. When you start playback again, your song will continue from this position.

The Start button operates in a "Continue” mode, i.e. Cubase will always continue playing from
the current song position when Startis pressed. If you have had the opportunity to work with other
sequencers, you will notice a difference here as most other sequencers automatically return to
the beginning of the song when Start is pressed.

2.4 Changes

During recording and playback, you may have noticed a few things that call for an explanation.
After the two bar count-in, a little triangle called the Song Position Triangle begins to move in
the Position Bar, accompanied by a vertical dotted line in the Part Display. It tells you where you
are within the song. When it reaches the border on the right side, the Position Bar scrolls on, and
the next bars are displayed.

At the same time, a counter bearing the inscription "Song Position", located in the Transport Bar
at the bottom right of the screen, displays the exact bar position as a numeric value. Beneath this
counter is another one entitled "SMPTE Time".

We will come back to that one later. The previously blank Arrange window now contains a black
beam, representing our first recording, i.e. our first "Part”.
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This is what your screen should look like now

When you are in playback mode, the activity display in column A (at the front of Track 1) shows
when MIDI data is being sent.

If you are not satisfied with the results of your efforts, or if you have made a mistake, simply
delete the Part with the help of the [Backspace] or [Delete] keys and record a new one. Later on,
you will be introduced to far better methods for deleting errors.

If the problem is due to timing and not incorrect notes, the quantization function may help.
Quantizing can correct timing errors within a certain framework. Move the mouse pointer to the
Menu Bar and choose "Over Quantize" from the Functions menu (keyboard: [Q]). Cubase will
now attempt to adjust your recording to the correct time. This function normally does the trick,
but it might not. Listen to your recording again.

We will examine quantization and how it works later on in greater detail.

Did you record more than eight bars? If so, you have probably noticed that the Position Bar has
moved. The Arrange window defaults to displaying approximately 16 bars. When you go beyond
this limit, the Position Bar moves on. This is called "scrolling" as well, something which we will
encounter again at later stages.

If you want, you can switch the scroll function off. Go to the Options menu and choose "Follow
Song": its checkmark disappears, and the Position Bar no longer moves when the Song Position
Triangle reaches the screen’s right border. Click "Follow Song" again to reactivate it.

Despite this assistance, being able to see only a few bars on the screen can become bothersome.
But don’t panic, help is at hand. You can change the Position Bar’s display resolution by
"zooming" it.

Two scroll bars containing arrows at either end are located at the bottom and the right edges of
the screen. Place the mouse pointer on the left arrow of the horizontal scroll bar and press the right
mouse button.

The scale of the display has changed! More than 16 bars are now being shown. If you keep the
mouse button depressed, the zooming will continue - upwards of 100 bars can be displayed at
atime in the Arrange window. To reverse the scrolling and return to the original scale, click and
hold the right mouse button on the righthand scroll arrow of the scroll bar.
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If you find that the number of bars shown is still inadequate for your purposes, there is yet another
method to enlarge the display area. Point at the vertical double lines between the Track List and
the Part Display. The mouse pointer will change to a hand. Press and hold the mouse button and
drag the mouse to the left: this drags the line with it. Release the mouse button at the desired
position.

You have now enlarged the Part Display. More bars can be seen, but unfortunately, both the
Track names and the MIDI channels are concealed. Later on, you will have to decide if you can
live with this situation.

We will leave the Part Display at its standard size for our purposes. In other words, move the line
back to its original location (mouse pointer on the line (hand appears), press and hold the mouse
button, drag it back to the right).

The Transport Bar can be removed from the screen to not only display more bars, but also more
Tracks. Go to the Windows menu and choose "Hide Transport". You cannot now access the
Transport Bar with the mouse, but keyboard control is still possible. Choose this function again,
now entitled "Show Transport", and the Transport Bar returns to the screen.
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The Part Display at maximum size (on a standard monitor) with the border moved left

This principle of horizontal zooming applies to the vertical direction as well. Click the vertical
scroll bar’s upper (zoom out) or lower (zoom in) arrows to determine the number of displayed
Tracks. Do you recall the information about how to handle the Atari’s windows at the beginning
of this book? The Arrange window behaves in the same way as a normal Atari window.

Go ahead and try a few things out. Go to the white square in the bottom right corner of the Part
Display: this is the "size box". Press and hold the left mouse button and drag the size box to alter
the size of the window. Click the Full button at the top right of the screen to return the window
to its original size.

2.5 The tempo

If you liked neither the tempo nor the count-in, you can easily change them. The current tempo
is displayed in the box next to the SMPTE time. It defaults to 120 when the program is first started.
Place the mouse pointer in the box and change the value using one of the methods described
above.

There is a third inputting method used for nothing other than changing the tempo: tapping the
plus/minus keys on the numeric keypad.

2.6 The count-in

Was the count-in too long, too short, or maybe you didn’t like the sound? No problem. Go to
Options in the Menu Bar and choose "Metronome". A box containing a number of parameters
appears, in which all sorts of changes can be wrought to the count-in.

First, we will turn our attention to the "Precount Active" function ("Precount" is what Cubase
calls a count-mn). The checkmark denotes that the count-in is active. Clicking the checkmark
makes it disappear and disables the count-in. You can adjust the length of the count-in in the field
to the right of the "Bars” inscription (you know how: right/left mouse button or double-click,
enter number, press [Return]).
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The Metronome box

The "Beep" inscription refers to the actual metronome itself. It can be switched off using the same
method that we came across with "Precount Active". The program even offers you the luxury of
being able to adjust the monitor metronome’s pitch for the first beat of a bar separately from the
following beats. Experiment with these functions (low and high) and find a setting you like.

Should you prefer to record at high volumes, you will soon find the Atari monitor’s maximum
volume level far too quiet. The "MIDIclick" function is the solution, where the metronome clicks
are sent via MIDI to an instrument of your choice, allowing you to determine both volume and
sound.

Set the MIDI channel to that of the sound module you’ve chosen, in this case MIDI channel 1.
The pitch of the metronome signal can be adjusted in the same manner as that of the monitor
metronome, i.e. separately for the first and the following beats. You can edit the volume and
velocity of the MIDI clicks as well. Find the settings you prefer. To avoid dissonance and
clashing notes, you might like to select pitches that are compatible with the key your composition
is in.

Do you have a drum machine, sampler, or does your keyboard feature built-in drum sounds?
Great! In this case, don’t use just any old MIDI note, but choose instead a cowbell, sidestick, or
hihat sample. Set the metronome’s MIDI channel to the MIDI receive channel of your drum
machine or sound module (this can also be a MIDI channel of your master synthesizer, of course).
Many manufacturers use MIDI channel 10 for drum sounds, which explains why Cubase defaults
toit. The MIDI note settings must match those of your MIDI device’s samples: consultits manual
to find out which sounds are assigned to which MIDI notes, or use the mouse to scroll through
the low/high values until you hear the sounds you want. You can create an accent on the first beat

by setting a higher velocity value.

When you have finished with the Metronome box, press [Return] to go back to the Arrange
window. In some situations, you may not need the metronome, in which case click "Click" at the
bottom right of the Arrange window to turn it off (keyboard: {C]). The MIDI metronome and the
monitor’s metronome are now disabled, and only the count-in for the recording will still be heard.

2 7 New Tracks - the MIDI channels

1et’s now continue working on our song, recording another Track in addition to the first. Click
Track 2 (keyboard: [down arrow]) to highlight it. Ensure that MIDI channel 2 is selected. Play
a few notes on your keyboard. If you are using our initial multitimbral setup, you should be
hearing a bass sound. If your instrument is not capable of playing several sounds simultaneously,
and you have just the one instrument available, then set the MIDI channel of the second Track
back to 1 and continue to work with the piano sound.
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This example shows that Cubase’s MIDI Thru function re-routes incoming MIDI signals (the
keys that you are playing) to the MIDI channel you’ve selected in an empty Track. Your
keyboard’s transmit channel is ignored. There’s one exception to this rather practical rule: if you
set a Track’s MIDI channel to "Any", then the incoming MIDI notes are not re-routed to a new
channel, but go to the MIDI device dictated by your master’s transmit channel.

Continue with the rest of the Tracks as you see fit. You are now in a position where you can play
on virtually as many Tracks as you like on the same or on different MIDI channels. If the standard
16 Track setup is insufficient, you can call up additional Tracks by double-clicking a free (white)
section of the Track List (keyboard: [Control]}[T]).

2.8 Mute and Solo

If you want to listen to only certain of the Tracks of your composition, you can silence those
Tracks you don’t want to hear with the help of the Mute function. Click the "M" column to the
left of the Track’s name. This Track is now marked with a dot, which denotes that the Track is
muted. To reactivate the Track, click the mute dot. Ensure that you do not mute while recording,
because the action of muting can be recorded and played back, too.

< File Edit
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The first two Tracks are muted

It is advisable to listen to Tracks one by one when attempting to find mistakes. You can do this
quite quickly by selecting the desired Track with a mouse click and clicking the "Solo" function
in the Transport Bar (keyboard: [S]): every Track other than the one you have selected is now
muted. Repeating this disables the soloing. By the way, the computer’s up/down cursor keys can
also be used to move between Tracks.

The Cueing function can also be useful here. Go to the beginning of the song and keep the right
mouse button pressed on the Fast Forward button. Your Arrangement will now play back until
you release the mouse button. Drag the mouse to the left to increase playback speed, to the right
to decrease it. Simultaneously pressing [Shift] or the left mouse button achieves more rapid
tempo changes. Note that the tempo change is only temporary: your song’s actual tempo does
not change.

Using Mute and Solo together is helpful for some applications. To listen to three Tracks out of
a total of 24, you could manualty mute the other 21, impractical as it might seem. A far better
method is to select a Track, solo it, and switch the other two Tracks back on.

Additionally, Cubase offers a way of pre-programming up to ten Mute configurations:

First mute the desired Tracks as described above. Press and hold the [Shift] and [Alternate] keys,
then press the [F1] function key at the top of your computer keyboard. The mute configuration
isnow saved. Let’s try it out. Reactivate the muted Tracks by clicking each mute dotindividually.
Press [Alternate] and [F1] simultaneously. The mute configuration you just set up should
reappear. As your Atari ST has ten function keys, so you can set up ten mute configurations.

To delete a stored mute configuration, set up and save a new one using the same function key,
whereupon the previous configuration is replaced.
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It’s a good idea to have one configuration in which none of the Tracks is muted, so you can
quickly switch back to normal. This is because it’s not possible to switch off the pre-programmed
mutes by simply pressing the same function key again. In order to make best use of the
programmable mutes, it makes sense to get used to working in quite a structured way. When
recording, make it a habit to always assign specific instruments to the same Tracks, such as using
the first three Tracks for drums and percussion, the fourth for the bass, etc. This will ensure that
you make best use of the mutes (e.g. muting just "drums" or "drums and bass").

2.9 Recording mutes

We mentioned earlier that Cubase records mutes if they are activated during the recording of a
Track. You can stop this happening by going to the Options menu and looking at the menu item
called Record Tempo/Mutes. A checkmark by the item denotes all mutes are recorded. Click the
item once to remove the checkmark.

The recording of mutes can and should also be used creatively, such as for simple arranging
within a lengthy song. Not only are manual mutes recorded, but you can also record the mute
configurations described earlier by recalling them using the function keys during your recording.

2.10 Naming Tracks and MIDI channels

At the moment, the Tracks are entitled "Track 1", "Track 2," etc, which doesn’t tell you very
much. You can enter more descriptive names by double-clicking the name "Track 1": a frame
will surround it. Delete it by pressing the [Esc] key on your computer keyboard, or by using the
[Backspace] key. Enter a new name, such as "Piano" and confirm the entry by pressing the
[Return] key. Name all the other Tracks recorded so far using the same method.

A blank space called "Instrument" is located next to the MIDI channel column, which is where
you can assign names to MIDI channels. Select an empty Track and set it to MIDI channel 1.
Double-click the blank space between the Track and MIDI channel: the naming frame will
appear. Enter aname for MIDI channel 1. If you are using several instruments, the ability toname
a channel according to its instrument is a boon. You may find that entering the name of a
particular sound is not particularly helpful, as one Track could contain a number of different
sounds. Nevertheless, the choice is up to you and how you organize your work.

Confirm the entry by pressing [Return]. Now set this Track’s MIDI channel to 2. Name the
second MIDI channel as described above. Of the remaining 14 channels, name those you are
using for the composition. The Track List containing a recording, complete with a set of names,
could look something like this:

A C|T jTrack Chn [ Inst rument outpuat
o) Basic 1 :Ju-88 ATARI
LI Drum Guide {18 { R—8M ATARI

i Drurm 18 | R—-8HM ATARI
i Drum Add 18 | R—-8M ATARI
4 Piano 16 :Sv¥-—-99 ATARI
i Bass 3 Oberheim: ATARI
i Groove 5 SY-77 ATARI
J Strings 3 Oberheim: ATARI
4 Special 9 MicrowaviATARI
4 adds 18 | R-8M ATARI
AP Zap i2 :5-11688 ATARI
J Zap Zap 12 i5-1168 ATARI
4 add Perc 13 D4 ATARI
The Track List
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Naming Tracks and MIDI channels is not absolutely essential, but it does help you find your way
around. Being able to name MIDI channels has another advantage: have you named several
MIDI channels? Then click and hold on an empty Track’s Instrument field. A "pop-up" menu
appears, containing the MIDI channel names you’ve already entered. Drag the mouse through
the list while holding the mouse button down - to select a name once it is highlighted, release the
mouse button; this selects that name’s MIDI channel as well. You can see why this is a good way
to work: it means you can go by the instruments’ names when you're assigning Tracks to
instruments or sounds instead of having to memorize the individual MIDI channel numbers. This
also allows you to quickly set the MIDI Thru function, and it’s easy to alter the channel of
already-recorded Tracks.

Now change the first Track’s MIDI channel back to 1 if it’s not already there.

A C|T |Track Chn Instrum=ant output
8 Basic 1 Ju-8a ATARI
@ IPrum Guide {18 { R—8M ATARI

& Drun 18 | R-8M ATARI
& Drum Add 18 |R-8M ATART
&£ Piano 16 ot _on TARI
& Bass 3 D4 TARI
g Groove 5 J0-888 TARI
J iStrings 3 mgnl
Fy Special 9 Microwap WWaRrRl
& Adds 18| pberheim [TRRI
4 Zap Zap 12 $-1168 TARI
& Add Perc 13 TARI
iy More Perc 13| Y7 TARI
;! [Guitar 15| $Y-99 TARI
J Strange Wavestat

The MIDI channel "pop-up"” menu

2.11 Personalizing your Cubase

Many of the exercises we have completed so far have served to tailor Cubase to your personal
needs. It would be rather tedious to have to re-install all these parameters every time you start
Cubase. The good news is you don’t have to - Cubase can save all the important settings so that
they are automatically loaded every time you start the program. The chapter called "System
Functions" describes in detail how you go about this.

By the way, the Track List’s columns can be repositioned. This little luxury, available from
version 3.0 onward, allows you to personalize the Track List’s setup. Click and hold one of the
column headings (A, M, C, T, Track, CHN, Instrument, or Output) using the left mouse button.
The heading and its fields below are now framed by a dotted line. Keeping the mouse button
pressed down, you can drag the entire column to the left or right until you reach the desired
position. All columns can be repositioned by dragging them to where you want them.

2.12 Track handling

Now that you are familiar with the basic recording steps, let’s find out more about what a MIDI
recording system can do, and get to know many more of Cubase’s functions.
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2.12.1 Deleting Tracks

A Track’s complete contents can be deleted, provided no Part is active (black) in the Part Display.
Click any blank space in the Arrange window. Select the Track you want to delete as usual, i.e.
click it or use the cursor keys [up] and [down].

The Track can then be deleted by pressing [Backspace], [Delete], or clicking "Delete Track" in
the Edit menu, at which point the selected Track and its contents will disappear from the Arrange
window. Try this out on Track 1.

Note: if you have accidentally activated a Part, then only the Part will be deleted, and not the
entire Track. The menu item changes depending on what is selected, e.g. if you selected one or
more Parts, then the menu entry will read "Delete Parts". Conversely, ifa Trackis active, the entry
reads "Delete Track".

2.12.2 The Undo function

Almost every action can be reversed using the Undo function. Press the Atari’s [Undo] key or
select Undo in the Edit menu, and the deleted Track is back. Be aware that only the last step can
be undone. For example, if you deleted two Tracks in succession, then the Undo function will
only pull the last Track out of the hat. The other Track is lost forever.

Once you have executed the Undo function, you can rescind it by pressing the [Undo] key again.
Delete a Track as described above. Press the [Undo] key. The Track re-emerges. Press [Undo]
again, and the Track disappears again.

Be warned that Undo cannot recall all actions. Your attention will be drawn to the situations
where it won’t work as and when we encounter them in this book. By the way, the last action you
have undone is entered in the Undo item of the Edit menu.

2.12.3 Moving Tracks

Click and hold Track 1 with the mouse button. It does not matter if there’s a Part selected in the
Part Display. The selected Track is now surrounded by a dotted line. Dragging the mouse up and
down now inserts the Track at another position in the Track List.

Drag the first Track to Track 3’s position and release the mouse button: this alters the order of
the Tracks. The essential fact here is that this moves the (erstwhile) first Track’s entire contents,
complete with its MIDI channel and instrument name. You will soon see that this can encompass
a great deal more than the one Part we have recorded on it so far.

2.12.4 Copying Tracks

You can not only move Tracks, but, using a similar method, copy them as well. Follow the steps
described above for moving Tracks, but instead of using the mouse button on its own, press and
hold the [Alternate] key throughout the operation as well.

Copying a Track, i.e. transferring its contents to another Track or another location in the Track
List, copies its contents only (the MIDI data); the name and MIDI channel are those of the
destination Track, i.e. the one to which you copy the contents of the original Track.

2.12.5 Overdub/Replace

What happens if you accidentally record on a previously-recorded Track? Try it out and see.
Select Track 1, start the recording and play something. After a while, stop Cubase and listen to
the result. You will hear both the original and the new recording. Cubase defaults to merging the
old information with the new.

You can prevent this by using the Record Mode switch in the Transport Bar. When you start
Cubase, this switch is set to "Overdub” which means that the recordings are merged. Click this
box once and the mode changes to "Replace”.
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At this setting, any new information is not added to’the original, but overwrites it: the old
recording is deleted. If you stop the recording before the Part ends, then the original notes located
between the current song position and the end of the Part are not deleted. Let’s try this out. Set
the Record Mode to Replace and start to record on Track 1. Play a few notes, say a bar, then stop
Cubase. Go back to the beginning of the Track and listen to the result (to avoid confusion, activate
the Solo function to silence the other Tracks). You should hear the new material only on the first
bar of the Track, after which you should be able to hear your original recording.

Use the Undo function to recall your original material. Note the following:

- In Replace mode, Cubase deletes old Parts only if you actually play in something new.

- On the other hand, even if you only play a brief note in Replace mode, Cubase will continue
to delete from that point on until you stop the recording.

2.12.6 Manual Punch In/Out

The two techniques discussed above are suitable for adding to a Track, as well as correcting
minor mistakes. What if the position where you want to add or improve material appears much
later in the song? Enter Punch In and Punch Out, terms used to describe the following:

Select the desired REC MODE (Overdub/Replace) and the correct Track. Start the playback (not
the recording) of your song. You will hear the material you have previously recorded. Once you
get to the point in the song where you want to record, "Punch In" by activating the Record mode
(click Record, or better still, press the [*] key in the numeric keypad). Now you can replace
material, or add to the original. "Punch Out" by pressing the Record key again to end the
recording. The playback will continue. You can repeat this set of operations at any time during
playback of a song.

2.12.7 The locators/automatic punching

You may think having to time the right moment for your Punch In, and having to play the new
notes at the same time is a bit awkward, and you’d be right. A professional program should be
able to provide better tools for situations like this.

Cubase has locators to help you here. They can help you define a specific point in your song for
recording and have lots of other uses as well. In our Punch In/Punch Out situation, the left locator
defines the starting point and the right locator the end of the recording. Replace any two bars in
Track 1 of your song, such as bars 5 - 7. Switch to Replace mode to do this.

re Functions Options Modules

ARRANGE - DEF.ARR

1. 1. a Quantlze 16

| | I _?H |

The locators’ default positions

45



The Basic Functions

The locators default to bars 1 and 5 when Cubase is started. We will now change their positions.
The program offers several different ways to go about this, so let’s start by selecting the simplest.
Use the left mouse button to click bar 5 in the Position Bar. The small field above the Position
Bar labelled "Mouse" helps you to locate the position more precisely. When moving the mouse
sideways across the Part Display, the Mouse display tells you what bar you are currently in.
Right-click bar 7 in the Position Bar to position the right locator (R).

ture Functions Options Modules Windows
ARRANGE — DEF.ARR

L L e e ——
1. 1. a Quantize 16 lcacle Re
strument “ ‘lP" | | | dE' | [ F: 1 |

The locators in position

Now that we have defined the area in which we want to record, we have to tell Cubase what to
do with it. For our purpose we will use the Transport Bar’s Punch buttons. Click both In and Out
so that they are highlighted. Cubase now knows thatitis intended to switch on Record mode when
the left locator is reached, and exit that mode at the right locator.

Go back to the beginning of the song. You may have to click the Stop button not once, but twice
- you will soon see why. Remember that the position of the REC MODE defines the nature of

the recording (Overdub/Replace).

When you are ready to record, start the playback. The sequencer starts and you hear the previous
recording. Cubase starts to record upon reaching bar 5. For this exercise, play two bars of
material, after which Cubase returns to Playback mode and continues in it until you press Stop.
Go ahead and listen to the recording.

You are still owed an explanation regarding the stop button. To be precise, the stop button has
three functions, two of which you are already familiar with: if you press it once during recording
or playback, Cubase stops at the current song position. Press it a second time and the Song
Position Triangle moves back to the left locator (provided the current song position is beyond
the locator’s position). Click the button a third time and Cubase returns to the song’s start.

Reminder: until now, you have clicked the stop button twice to return to the start position. This
was fine because the left locator’s position was identical to the starting position of the song.

So far so good: start the playback and listen to the results of your work. In principle the procedure
is the same as the one used for manual Punch In, only substantially easier.

2.12.8 Options

If the position you want to record atis well into the song, always having to listen to the bars before
it may become somewhat tedious. Here’s how you can steer clear of this problem: position the
locators and instead of starting the playback, press Record. You now hear the count-in, then the
recording starts as usual. The difference though, is that it does not start at bar 1, but at the position
of the left locator: in this case, bar 5. You are not required to select Punch In as the program does
it automatically. However, do select Punch Out, otherwise Cubase will continue to record
beyond the right locator’s position.

Should the metronomic count-in not appeal to you for this recording, you have another more
musical alternative. You can choose it by calling up the metronome box discussed earlier
("Metronome" in the Options menu) where you will find the "Preroll” function. Click its box to
select the function, and exit the metronome box by pressing {Return].

Now, start the recording again, refrain from playing, and listen: Cubase does not start at the left
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locator, but one or more bars prior to its position, and plays the Tracks back in the normal manner.
Once it reaches the left locator, the program switches to Record mode. If the click still bothers
you, turn it off (key [C]). You can tell Cubase how many bars you want to hear before the Punch
In commences in the Metronome box’s "Bars" field. The length of the metronomic count-in and
of the Preroll is identical.

2.12.9 Target practice

Cubase offers you variations to the locator positioning method in addition to the two methods
described above. This will also give us the opportunity to look at a few more functions of the
Transport Bar.

You will find the left and right locator displays to the left of the Transport buttons (stop, start,
etc.). When you position the locators via mouse click in the Position Bar, these two boxes show
the position as a numeric value. This value consists of:

- the first number (before the first decimal point), which corresponds to the bar,

- the second number (between the two points), which corresponds to the quarter note,

- finally, the third number is substantially more precise (up to 384 possible positions, from 0 to
383).

LEFT LOZATORE |

FEIGHT LOCZATOR

The left and right locators

This of course requires an explanation. Cubase version 3.0 operates on an internal resolution that
breaks down into 1536th notes, i.e. each bar is subdivided into 1536 positions. The shortest
possible note is, therefore, a 1536th note. This smallest possible unit is referred to as a "tick".
1536 ticks equal a whole note, 768 a half note, 384 a quarter note, etc. Below, a list of note values
and their relationships to ticks:

Value Ticks

11 1536
1/2 768
1/4 384
1/8 192
1/12 128
1/16 96
1/24 64
1/32 48
1/48 32

To simplify the picture, Cubase not only divides musical time into bars and ticks, but also into
quarter notes. An example should clarify the matter: the fourth eighth note in the first bar would
be at position 1576. This is not exactly the clearest way of putting things, so the programmers
used a clearer, more musical, measuring method, where every bar is subdivided into quarters.
Cubase counts

Bar 1, first quarter: 1.1.0
Bar 1, second quarter: 1.2.0
Bar 2, third quarter: 2.3.0, etc.

Each quarter is then divided into 384 ticks as discussed above. If you want to position a locator
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on the first eighth note in bar 1, then 1.1.192 is the corresponding value. The third eighth note
is located at 1.2.0, and the fourth at 1.2.192.

The chapters 14 "Timing" and 15 "Quantizing" take a closer look at this somewhat unusual
method of counting beats. Right now it is more important for you to understand how Cubase
defines and controls positions and lengths.

Note: Cubase version 3.0 features an improved internal resolution. The value scale of 1536 ticks
per bar is twice as precise as in version 2.01. This of course has ramifications for the display of
positions and lengths in the program. The values quoted above apply to 3.0 users only; those of
you using version 2.01 must divide the values by two, as you have only half the resolution!

2.12.10 Back to the locators

Let’s get on with our target practice. As well as using the mouse to click locators into position
in the Position Bar, they can also be positioned by directly manipulating the LEFT and RIGHT
LOCATOR numeric displays. Change the locator values using the familiar methods: clicking
with right/left mouse buttons, or via a double-click followed by typing the desired value
(keyboard [L] or [R] plus value entry). The second method requires that you enter a period, a
space, or a plus sign between values. If you just want to locate to a bar, and not a specific position
within it, the bar number suffices (e.g. 5 for bar five). You will see that the locators move to the
position you have just entered.

Clicking the LEFT LOCATOR or RIGHT LOCATOR displays moves the current song position
to the respective locator position.

You may prefer to mark the position by listening to the playback and stopping at the desired
position. In that case the following entry method may be of help to you. Press the [Shift] key and
[1]in the numeric keypad simultaneously. The left locator adopts the current song position. Press
the [Shift] key and [2] in the numeric keypad simultaneously to situate the right locator at the
current song position. This method also works during recording.

2.12.11 Cue points

The recording method you have been introduced to thus far, i.e. recording entire Tracks, best
meets the requirements of those of you who view songs as one complex entity, and use
sequencers as virtual tape decks. Long songs can make the search for specific passages difficult
and time-consuming. A solution is the use of what are commonly called "cue points” in tape
recorders. Cubase also features cue points: these mark specific positions within your song.

You can program up to six cue points using a simple method. Go to the desired song position via
the fast forward/rewind keys, or by typing the values directly in the Song Position box, or by
listening to the song and stopping at the desired location during playback.

Press and hold the [Shift] key and one of numbers [3] - [8] on the numeric keypad. The current
song position is saved as the number you have selected. Move Cubase on in the song. Recall the
stored cue point position by pressing its number (this time without [Shift]). Cubase jumps back
to that position. This feature is especially handy for marking changes of section within a song,
such as intro to verse or verse to chorus.

Apart from those we have seen so far, there are anumber of other ways of locating song positions.
Go ahead and try these out:

- As with the locators, you can enter the song position directly using the right/left mouse buttons,
or via a double-click (keyboard [P]), typing in the desired value and pressing [Return]. But there
is yet another way. When entering a new value, you don’t have to type in the desired numbers:
you can also subtract from or add to the current value. Double-click the Song Position box, enter
[+] then [10] and confirm with [Return]. The Song Position Triangle moves ten bars forward.
This works for the locators as well.

- Another very simple pointer-positioning method: double-click the desired position in the
Position Bar.
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- Click the highlighted Left Locator or Right Locator box once, and the pointer moves to the
respective locator position (keyboard [1] or [2]).

- The [Clr/Home] key moves the pointer to the left border of the Arrange window (this position
need not be bar 1, as the Position Bar may have been scrolled forward).

- If you stop Cubase, re-start it, but now, for whatever reason, want to move back to the original
Stop position, press [9] in the numeric keypad while the sequencer is running. Cubase jumps back
to the last Stop position, and continues playback. You can jump back as often as you like, creating
a sort of manual cycling.

All of these positioning functions can be used while the sequencer is running. Numeric entries
are not executed until you confirm by pressing [Return]. Don’t fret if you find the range of
possibilities overwhelming: everyone feels that way at first. There is no iron-clad rule that says
you have to use all the methods. Select those you feel best fit your way of working and you feel
most comfortable with.

2.12.12 You’ve got the power - Snap!

After you have tried out all the different positioning methods, you will note that the locator is
always placed at the beginning of a bar no matter where you click in the Position Bar, but
positioning via the Song Position or by typing in values gives you the in-between values as well.
This is because the Position Bar has a coarser resolution: Cubase defaults to a resolution of one
bar. However, you can change the Position Bar’s resolution using the "Snap" function: click and
hold in the Functions Bar’s Snap box with the mouse pointer, and a pop-up menu appears.

<» File
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Snap settings

Now you can determine the resolution of the positioning by mouse click: Off (unrestricted), or
to the nearest bar, half, quarter, eighth or sixteenth note. Select the Off position and try to place
the locator at the beginning of a bar in the Position Bar. You will probably find positioning is a
lot more difficult than it was before. Now select the 1/8 Snap setting and slowly move the mouse
across the Part Display. The Mouse display changes in units of 1/8th notes, beginning with 1.1.0,
then 1.1.192, 1.2.0, 1.2.192,1.3.0, etc. The value of 192 is arrived at due to Cubase’s resolution,
as 192 ticks equal one eighth note.

Try the other settings and watch the Mouse display change. In a moment and later on, you will
see that the Snap function is of great importance for other operations as well (e.g. copy and move
functions).

2.12.13 Saving the work so far

Before we get to know new techniques, we should save the results of the work we have done so
far. Insert a new formatted disk in the drive and choose "Save" from the File menu (keyboard:
[Control][S]). Never save song or other such data on the program disk!
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6 Drun Mo

[ cancel | 7 set up |

The "Save” dialog box

Select "2 Arrangement" in the dialog box (key [2] in the alphanumeric keypad). After a few
moments, the Atari’s Item Selector will appear. Itis used for managing files on disk (loading and
saving). The look of the Item Selector may differ from the one shown here, depending on your
Atari’s TOS version and whether you have a hard drive attached.

=S —— = ——
FILE SELECTOR

Directory:
A:\}. ARR

Selection:

———————————— & | Cancel |

The Atari Item Selector (TOS 1.4)

Whatever the look of the Item Selector, the "Selection” line is always used to name files. Afile
could be a Cubase song, or the text of a word processing program. When you save an
"Arrangement”, the Selection line defaults to showing the name DEF.ARR. Delete this name by
pressing the [Backspace] key several times, or by pressing [Esc] once. Enter a new name with
amaximum of eight letters. Please use numbers or letters only. Do not enter anything in the three
spaces after the dot as Cubase will enter the extension automatically. Once you have entered the
name, confirm by clicking OK (keyboard: [Return]). You have now stored your first recording.
Further essential information on saving, loading, disks, etc. is covered in chapter 6 entitled "Data
Management'.
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3 The Parts

Up to this point, we have recorded several Tracks and each Track contains only a single Part. This
is, of course, not all Cubase has to offer. A Part is merely one single recording of a passage of
a specific length, but you can determine the length and position of additional recordings thanks
to the locators.

We need different examples for our next exercise, so delete the Parts you have created until now
(but not the Tracks). To do this, simply select the first Part (it highlights) and press the [Delete]
or [Backspace] keys. Select the second Part, delete it, and carry on until all the old Parts of our
Arrangement have been deleted. If you find this method somewhat long-winded, don’t worry as
there are simpler ones coming up later in the book.

Our next goal will be to create a clearly structured song. We want to come up with identical
results, so please follow the listed structure, otherwise your song’s bar positions will not be the
same as the ones in this example:

4 bars Intro

8 bars Verse
8 bars Verse
8 bars Chorus
4 bars Verse

You could, of course, achieve this with the information you have learned so far, but would have
torecord this structure as individual Tracks from beginning to end. The following method makes
the assembly of the song easier and offers a number of other advantages.

3.1 Let’s go

Place the left locator at the beginning of bar 1 if it isn’t there already. Place the right locator at
the start of bar 5. Assign the MIDI channels to the Tracks according to the devices in your MIDI
system. Ifat all possible, stick to the format "piano”, "bass", "strings", "drums". If you do not have
several instruments at your disposal, don’t worry. Simply record fewer Tracks with the different
sounds you do have.

Activate Punch Out, and select the first Track. Start the recording and play an introduction.
Cubase records the first Track, then switches from Record to Play mode at bar 5 and continues
running until you stop it. If you haven’t done so already, stop it now. The Part you have just
recorded is exactly four bars long.

You can individually name all the Parts you record. Double-click the Part while holding the
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[Alternate] key down. Press the [Esc] key once to delete the previous name and replace it with
one of up to ten letters.

Naming Parts is not absolutely essential, but you will see as we go on that naming things gives
you a clearer overall picture. Confirm the name entry by pressing the [Return] key. If you press
the [Alternate] key at the same time, all the Parts in the current Track will receive this name. We
will see this feature again later.

In principle, you could select a second Track and name all its Parts, and so on with the other
Tracks; however, there is a more user-friendly method which we’ll discuss later.

3.2 The Cycle

Cycling in Cubase is what is known as "shuttling” in a tape recorder, where a section of tape is
automatically repeated over and over, except that a computer can do instant Cycles whereas a
tape has to spool back between them. In Cubase’s Cycle mode, a specified number of bars is
repeated as often as you want. The length of the Cycle is determined by the left and right locators
which are already in position. Now all you have to do is switch to the Cycle mode by clicking
the Cycle button in the Transport Bar (keyboard: [/] in the top row of the alphanumeric keypad).

I CYCLE

Cycle mode onloff

Ensure that the song is at bar 1 and start the playback. Cubase will run to the end of bar 4, but
then the Song Position Triangle will jump back to the first beat of bar 1, then start again. This
will carry on until you stop the sequencer, and means that the material you recorded earlier on
Track 1 is being repeated over and over.

You can play along during the playback. If you want a different sound on another MIDI channel,
select the next empty Track, and assign its MIDI channel to the desired instrument. You’re not
required to stop Cubase. By the way, most functions can be executed while Cubase is running.

Back to our recording, where we’ll now use the Cycle mode. Ensure that REC MODE is set to
Overdub and not Replace, then click the Record button or activate Record mode at any time
during playback. All the notes you record now will be played back in the next Cycle. You can
continue to add to these notes since everything will be recorded. You can just as easily record
the first Part in its entirety during the first Cycle and hear it repeated in the next one, as add bits
of the Part in each Cycle until you have assembled the complete picture. Take your time, there’s
1o need to add notes in every Cycle. There are different Cycle modes for different applications.

3.3 The Cycle modes

The Cycle modes are accessed by clicking the "Cycle Rec" field at the lefthand end of the
Functions Bar. Of the three choices in this special menu, click "Mix".

Windows

::I Cucle Rec Mix
|s Miu

Punch
Norma |

The Cycle modes
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The Mix Cycle mode is the one we have just used in which you can add notes at any time. All
data is recorded, and then played back during the following Cycle. Although it may seem as if
it doesn’t matter whether you are in Overdub or Replace mode, they apply to situations where
you are recording on a Part that already contains notes:

If REC MODE is set to Overdub, all newly added notes are merged with what was already in the
Partin each Cycle. In Replace mode, the Part’s original notes are deleted, and only the new notes
are recorded and mixed. The REC MODE has no significance if you are recording from scratch.

The Punch Cycle mode does something different. To see how it actually works, let’s create anew
working Part. First select an empty Track, assign ita MIDI channel and Solo it to silence the other
Tracks. Activate the Punch Cycle mode and start recording.

Record a simple line of notes, such as eighth notes at the same pitch (C3), using a piano-type
sound. Do not continue to play after the first four bars, but listen to the results in the second Cycle.

In the third Cycle, let the first two bars run unchanged. In bars 3 and 4, play eighth notes that are
two octaves higher (C5). You will discover, based on this simple exercise, that this mode replaces
the original notes. Listen to the result in the next Cycle without playing anything. Cubase has
replaced the original notes in bars 3 and 4 (pitch C3) with those of your second take (pitch C5).

What exactly happens? The sequencer switches to Punch Inmode as soon as you play something,
and switches back at the start of a new Cycle. All the original notes are deleted from the point
you start to play until the right locator, no matter how little you play. If you play nothing, the
original is not affected.

Try it out: stop the sequencer and delete your last take using [Backspace] or {Delete]. Now create
a new Part using the same method as before. First take: eighths at pitch C3, then listen to the
second Cycle. For the third Cycle, play a single note at C5. The following Cycle will show that
everything following the C5 is gone.

As before, the REC MODE (Overdub/Replace) setting applies to previous recordings only:
original notes are immediately deleted in Replace mode, but are kept safe in Overdub mode.

What does the final Cycle mode, Normal, have to offer? Here too, a practical demonstration
provides us with the answer. Delete your first working Part. Select the Normal Cycle mode, start
the recording and play something. In the second Cycle you will find that the Track contains no
notes! The entered notes are only saved if you stop Cubase before the end of the Cycle. The
previous Cycle is deleted with each new Cycle! Once again, Replace and Overdub apply to
previously recorded material only: Overdub keeps the original notes, whereas all notes are
immediately deleted in Replace mode.

The following point should be clearly understood: the choice of Cycle mode (Mix, Punch,
Normal) is only relevant for notes that are being recorded. Other previously recorded material
will be handled according to the REC MODE switch. Overdub merges old and new notes. What
then happens to the new notes depends, as you now know, on the Cycle mode. Either way,
Replace mode deletes old material.

3.4 More on cycling

You may have made a mistake in one of your takes. You already know how to correct minor
timing fluctuations with the Quantize function. While the recording is running, go to the
Functions menu and select Over Quantize ([Q]). A simpler way is to activate the automatic
quantization by clicking the grey letter combination "AQ" right at the end of the Functions Bar.
After each Cycle, your previous take’s timing is corrected by "Over Quantize". Bear in mind that
this automatic function works in Cycle mode only.

If you are in Overdub mode, some puzzling things can happen while you are cycling. Your
enthusiasm may take over, and you play through one Cycle and on into the next. If this happens
and you get duplicated notes, choose the Delete Doubles command from the Functions menu,
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whereupon doubled notes of the same pitch and on the same beat are deleted. You can also do
this while the sequencer is running. This function is important in other respects, too: see chapter
14 on "Timing".

Another critical point is the use and recording of performance controls such as a sustain pedal,
pitch bender, modulation wheel or joystick. These can interfere with each other from one Cycle
to the next. For instance: say you used a piano sound for recording the first Verse (bar 5 to 12).
You pressed the sustain pedal in bar 11 and released it in bar 6 in the following Cycle. If you are
listening to the Cycle only, everything seems alright. However, keep in mind that this Part s just
a small portion of the overall Track. If you then play the Part back with Cycle mode disabled,
you’ll find the sustain off message comes before the sustain on message: the messages are the
wrong way round!

Moral: always use performance controls carefully.

3.5 Useful items

Cubase offers several other helpful items in the Cycle mode. Delete your working Partand switch
Cubase to Cycle Mix mode. Start the recording and play the repeated eighth notes again. During
recording, click and hold the mouse button on the Cycle Rec field (not on the word "Mix"!). A
new menu will appear, which can only be activated during recording.

Modules Windows

[CrucL ]
16 cucle Rec HMix E
| | Delete Last Uersion
Delete Subtrack

Key Erase

Quantize Last Version

: |

Cycle aids

Now temporarily leave the menu and play an additional note (C5) in the Cycle. Go back to the
small menu and select Delete Last Version, or press [V]. This last note is deleted. The function
deletes the most recent Cycle in which you actually recorded something, even if you followed
it by listening to several Cycles without playing in anything new.

"Delete SubTrack" or [B] deletes all Cycles. The advantage here is you don’thave to stop Cubase.
Whatever you do, do not press [Backspace] or [Delete] while recording in the Cycle mode or you
will delete the entire Track. However, should such a mishap occur, you can use the Undo
function.

The last two Cycle aids are easy to explain. "Quantize Last Version" or [N] quantizes the most
recent Cycle take using the Quantize value in the Functions Bar: this defaults to sixteenths.

"Key Erase" allows you to delete specific notes, ironing out minor errors. Start recording and play
a wrong note at some point. Press and hold that wrong key on your instrument during one of the
following Cycles and select Key Erase or [K]. The wrong note disappears.

But be careful: this function deletes all notes of the same pitch within the Cycle. If you want to
remove a specific note from the Cycle, but this note also appears at other positions in the Cycle
which you want to keep, you end up deleting those too. This function is good for correcting basic
mistakes, such as accidentally hitting the wrong key when you really wanted to play the one next
to it, and so on.
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3.6 Let’s get started

So far, we have been leaming about the Cycle mode. Now let’s see how this knowledge can be
applied. You will find out the quickest way to transfer your ideas to the computer’s memory.

Use the take on the first Track as a foundation or record something new. Ensure the basic settings
are correct:

- Left locator: 1.1.0

- Right locator: 5.1.0

- Cycle active

- REC MODE: Overdub

- Cycle mode: Mix

- No Tracks muted

- Automatic quantization: On

- The MIDI channels of Tracks 1 to4 should be set so they address drums, bass, strings and piano,
and select these sounds on your instrument(s). The instrument/sound you begin this exercise with
is up to you.

Select Track 1. Keep in mind that you want to create some kind of introduction. Start recording
and play for four bars, e.g. drums. You don’t have to do this within one Cycle. Take your time:
you can first enter the bass drum, then the snare, hihat, etc.

Do not stop Cubase. Remember, you can delete the last Cycle or the results thus far via the Cycle
Rec menu’s Delete Last Version or Delete SubTrack. Keep the other Cycle aids in mind, too.

Once you are satisfied with the first Track, select the next one. Here again, do not stop Cubase.

You can now enter the bass line. As you have already preset the MIDI channel, Cubase
automatically activates the MIDI Thru function. The same options discussed above apply to this
Track as well. Once the bass line is in, record the other Tracks in the same manner.

Following these simple steps, you can create a section four or more bars long, depending on the
locators’ positions, using almost any number of Tracks; all this without stopping Cubase, even
for a second. This section of music is called a Pattern.
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The finished Intro
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3.7 The first Verse

Next on the agenda is the first Verse. You will obviously want it to start after the Intro, so you
must re-position the locators. Our first four bars are already in the can, so place the left locator
on bar 5 and the right on bar 13 so that our Verse is eight bars long. You cannot position locators
during recording, only in Stop or Playback modes.

Start your Verse Pattern on Track 1. As a rule, you should work within the Cycle, but the Preroll
or Punch In methods, which we encountered earlier, can also be used. Switch Punch In on and
place the Song Position Triangle at the start of the song. Start the playback. Cubase plays the
Intro. Once it reaches the left locator, it goes into Record mode. You can record now. From bar
5 on, the Cycle takes over. The same holds true for the Preroll function: Cubase starts before the
beginning of the Cycle, then the Cycle takes over, and repeats the Verse indefinitely.

Note that the cycling is between the two locators only - it does not include any Preroll.

The reason for listening to what comes before the Verse Cycle is so that you can hear upbeats
and so on in their correct musical context: you can hear, for instance, a run-up to the Verse,
allowing you to record the final note of the run-up on the downbeat of the Verse.

If you want to hear something of the Intro each time yourecord anew Part in the Verse, you must
stop Cubase each time you have finished recording a Part and start the sequencer in the new Track
from the desired position prior to the Cycle.

Of course, you don’t have to line up a song’s patterns exactly on the bar as in this example. This
would make the recording of upbeats unnecessarily difficult.

Say you want to start the Verse’s upbeat on the Intro’s "four and...". Place the left locator at
position 4.4.192 instead of 5.1.0. The Intro and Verse will slightly overlap, but Cubase doesn’t
mind, and it makes the recording of upbeats so much simpler. Ensure the Snap function is at the
appropriate resolution or you will not be able to locate the proper position on the Position Bar.

3.8 Programming the locators

So far, we have been placing the locators manually; however, there is an alternative where you
can program up to ten locator configurations and recall them when required. For the first Verse,
Jeave the locators at the current positions: the left locator at 5.1.0 and the right locator at 13.1.0.
Press and hold the [Shift] key, then press [F2]. The Verse’s locator positions are now saved and
can be recalled by pressing [F2] without [Shift]. You encountered this way of working in the last
chapter.

You can save a locator pair on each of the ten function keys. Cubase comes with preprogrammed
locator positions: take a look at them by pressing each function key in turn. You can see [F1]
already defines the Intro locators, which is why we programmed the Verse locators using [F2].

You will encounter yet another helpful locator positioning function later on, where the
[Alternate][P] key combination places the left locator at the start of a selected Part, and the right
locator at its end.

3.9 The second Verse

After this little excursion, we return to our song. In principle, you could continue creating the
remaining Patterns using the same method discussed earlier. However, the second Verse is
identical to the first! So why go through the hassle of recording the same thing again?

In Cubase, Parts can be manipulated very flexibly. Let’s see how this can be done quickly and
sensibly.

Select the first Track’s Verse Part by clicking it so that it is highlighted. Keep the mouse button
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pressed down: the Part is framed by a dotted line. Drag the Part to the desired position by moving
the mouse: forward, back, or even to other Tracks (in which case, the Part adopts the destination
Track’s MIDI channel assignment). Drag the Part to position 13.1.0 on Track 1 by watching the
position display in the Mouse field. The Snap function will help you position the Part properly.

Once you have found the correct position, release the mouse button. Youhave just moved aportion
of the Verse and left a gap between bars 5 and 13 of Track 1. If you haven’t already done so, zoom
the display to get a good view of this portion of the song.
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Moving a Part on Track 1

The result we have achieved is not the one we intended, as the idea was to copy the Part. So drag
the Part back to its original position, but this time, press and hold [Alternate], or press and hold
the right mouse button as well as the left one once you have selected the Part.
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Copying a Part on Track 1 by pressing and holding [Alternate] or the right mouse button

After you have done this, you will discover you have copied the Part. It occupies bars 5 to 13,
and bars 13 to 21.
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All youneed to do now is copy the remaining Verse Parts to the desired positions. Fear not, there
is an easier method. Select the remaining three Parts simultaneously by clicking them one after
the other while holding [Shift] down. The Parts are highlighted. If you selected the wrong Part
by mistake, you can deselect it by clicking it again, provided you keep [Shift] depressed. If you
want to deselect all the Parts, click any free area of the Part Display without pressing [Shift].
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Three Parts are selected

Release [Shift], then click and hold one of the three Parts. All three Parts are surrounded by the
dotted line, denoting that they can now be dragged. Keep the mouse button depressed and drag
this trio to bar position 13.1.0. Watch the Mouse field as it tells you where the mouse pointer
currently is.
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Moving three Parts

Copy the three Parts back to their original positions by pressing and holding [Alternate] or
additionally pressing the right mouse button.
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3.9.1 Selecting Parts

The techniques discussed above are some of Cubase’s best features. Here are more exercises and
hints on selection techniques.

Select the Parts of one Track. There are several ways of doing this:

- Clicking the Parts one after the other while pressing [Shift].

- Pressing [Shift] and double-clicking any free portion of the Track.

- Selecting the Track, holding [Shift] and pressing the right or left keyboard cursor keys.

To select Parts of several Tracks, click them one after the other while pressing [Shift]. You can
select as many Parts as you like. They do not have to be consecutive or touching.

There are two other possibilities. The Select All commaild (keyboard: [Control][A]) in the Edit
menu does exactly what it says, by selecting all the Parts of an Arrangement.

The final option is provided by a feature referred to as "rubber banding". This is described in the
Atari owner’s manual, but here’s a quick run-down. First, copy several Parts to Tracks 13 - 16.
This will look something like this:
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Parts copied to other Tracks

Now click a blank space just before/after and above/under the Parts and, keeping the mouse
button pressed, move the mouse diagonally across the Parts. You will see that you are drawing
a dotted "rubber band" around the Parts.
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59



The Parts

All the Parts touched or surrounded by this rubber band are selected when the mouse button is
released.

This method is recommended for selecting large groups of adjacent Parts. If you want to select
Parts that abut each other and which are surrounded by other Parts, you probably won’t find a
free space in the Part Display to start the rubber band. Here too, there is a solution you will not
find documented in the manual.

Press [Shift] before and while you are drawing the rubber band. This enables you to separately
select Parts that are close together. Keep in mind that a Part does not need to be completely
surrounded by the rubber band, but only needs to be touched by it.

Parts, once selected and regardless of how you selected them, can be moved and copied as you
please. The gaps between the Parts are maintained. Parts may overlap partially or completely,
in which case they are played back simultaneously. You will discover a few things during your

experimentation:
- If you copy or move a selected Part and wander beyond the screen’s right border, the Position

Bar is automatically scrolled on.
-If you release a Part below the final available Track, Cubase automatically creates a new Track.

3.10 Repeating Parts

There is yet another useful function available should you want to copy Parts one after the other.
Select the desired Parts, go to the Structure menu and select Repeat, or press [Control][K].
Designate the desired number of copies and confirm by pressing {Return].

The selected Parts are copied from the end of the original Part for as many times as you chose.
Try it, then delete the Parts using the technique you have learned: [Backspace] or [Delete]. The
"Ghost Copy" parameter will be discussed later.

3.11 Deleting Parts

You already know one method by which a selected Part may be deleted: using [Backspace] or
[Delete] on a selected Part. You can also use the Delete Part(s) command in the Edit menu. Both
of these variations delete all the selected Parts.

Delete all the Parts that you have created in these exercises with the exception of those designated
for the original Arrangement.

3.12 Merging Parts

Say you move one Part so it partially or completely overlaps another. No problem. Both Parts
are played back, and their contents remain complete.

Pressing [Control] and [Alternate] together gives you another option if you actually want to
merge two Parts. Here, the selected Part, the source Part, is merged with another Part, the
destination Part. The source Part’s MIDI data, as well as that of the destination Part, remains
unchanged.

This applies when REC MODE is set to Overdub. The same operation in Replace mode deletes
the destination Part’s notes and replaces them with those of the source Part.

Now we know that it is unlikely that both Parts will have precisely the same length. So what
happens if two Parts of different lengths are merged, or if the source Part is not placed at the start
of the destination Part, but somewhere inits middle? In this case, the additional notes are attached
to the end of the destination Part. Let’s do an experiment that will help us distinguish copying
and merging.
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Destination part

Source part
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Result in Overdub mode

The data of both parts is merged

Result in Replace mode
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The source Part's data replaces
that of the destination part

Merging Parts while pressing [Control] and [Alternate]

Select a blank Track and silence all other Tracks via their mutes so that they don’t interfere. Use
the locators to enter a Part with a length of four bars, and ensure its MIDI channel is correctly
assigned. Go to the next blank Track and enter a Part eight bars long. Record low notes in the
first Part and high ones in the second so you can distinguish between them in the experiments
below.

Ensure Overdub mode is active for the following experiment. Press [Control] and [Alternate] and
move the longer Part onto the shorter one so it starts at 1.0.0. It would appear that nothing has
happened. Let’s take a look. Mute the Track containing the longer Part and start the playback.
The shorter Part now actually comprises the contents of both Tracks. Even after the Part has
reached its end on the screen, you can still hear data being played: a phenomenon which we’re
about to look into.

Reverse the merge via [Undo] and again copy the longer Part onto the shorter one, this time
starting at 3.0.0 and not at 1.0.0. Listen to the result. The notes of the copied Part are merged
starting from 3.0.0. Try the same thing when Replace mode is active.

Before we can return to our song, we must first delete both new Parts. Instead of doing it the way
we learned earlier, this time we’ll use the Toolbox.

3.13 The Toolbox

Cubase has another surprise in store concerning the handling of Parts. If at some time you have
accidentally clicked the Part Display with the right mouse button, you will already know what
the surprise is. If not, click and hold the Part Display with the right mouse button. A new box
appears containing a set of symbols: the Toolbox.
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The Toolbox

Tool selection is quite easy. Press and hold the right mouse button on top of the Toolbox, then
move the mouse slowly to the right. One after another, the tools are highlighted. To select a tool,
release the mouse button when it is highlighted. Select the Scissors tool: the mouse pointer
disappears from your screen, replaced by the Scissors. You can move it the same way you move
the mouse pointer.

Select all the different tools, one after another, those in the bottom row t00. You can recall the
normal tool, the Arrow, by briefly clicking the right mouse button.
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Selecting the tools, in this case the Eraser

Now that you know how to access these tools, you’re probably asking yourself what they are used
for. The first and most important tool, the mouse Arrow, has been covered to a certain extent in
the previous sections, so let’s move on to the next one, the Eraser. Press and hold the right mouse
button and select the second tool from the left in the upper row: the Eraser. We will save the
neighboring "Match Quantize" tool for the "Quantizing" chapter.

MATCH

Q.

The "Match Quantize” tool

3.13.1 The Eraser

g

The Eraser tool
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This tool’s function is easy to explain. You canuse it to delete ("rub out") Parts quickly and easily.
Incontrast with the methods we have learned so far, it is not necessary to select the Part first. Place
the Eraser on one of the two Parts created for the last exercise, that are now no longer needed.
Click the left mouse button: the Part disappears. You can press [Undo] to recall the deleted Part.
Please note: under normal conditions, you only delete the Part that the Eraser is on. Delete the
second superfluous Part, too.

To delete all the Parts in a Track, press and hold [ Alternate] and click on the first Part of the Track.
All the following Parts are deleted right along with it. The important thing to note is all the Parts

after the selected Part are deleted.

The Magnifying Glass tool

The Magnifying Glass is not just amusing, but is also a useful tool. A short example will clarify
this. Select the Magnifying Glass from the Toolbox. Click the first Part of the first Track with
the mouse button. Keep the mouse button depressed.

3.13.2 The Magnifying Glass
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The Magnifying Glass alters the Part’s appearance

The appearance of all the Parts in the first Track has changed. Instead of the name, you see a
number of vertical black lines. These lines represent the individual notes and their respective
time values. Move the Magnifying Glass slowly over the first Part while holding the mouse
button down. As soon as you reach a black line and move across it, its corresponding notes are
played. You can move the Magnifying Glass at any speed you like. You can even move it
backwards to hear the Part played back to front.

This function enables you to quickly spot mistakes without having to mute the other Parts, engage
Solo or use the transport commands. Bear in mind that the Magnifying Glass can only be moved
across the selected Part. If you want to listen to all the Parts in a Track, you must first click the
initial Part, move the tool across it, briefly release the mouse button, click on the second Part,
move across it, etc.

The Magnifying Glass can also be helpful during playback. If you click a Part while pressing
[Alternate], this Part is played along with the Arrangement, even if the song position is nowhere
near where the Part is. The Part is played once, beginning from the next bar.

You can make the display of all the Parts in an Arrangement stay the way they are described in
this section by choosing Part Appearance from the Options menu. Click Show Events in the Part
Appearance dialog box and confirm by pressing [Return]. All Parts now display the events they
contain. This feature is especially helpful when you are dealing with sparse musical passages
where there are long gaps between notes: you can see when and where notes will play.
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The Part Appearance dialog box

The Part Appearance dialog box contains a number of other display options. "Show Names", the
default option, displays the Part names. "Show Frames" displays only the empty Part beams.
Below, a number of display filters are listed allowing different types of MIDI data to be excluded
from the display

Cubase defaults to showing every type of data when "Show Events” is selected. If all you want
to see is notes, switch off the other types of event such as Poly Pressure, etc. These settings affect
the display only, and do not affect the data in the Parts nor its playback.

3.13.3 The Part Mute

FMUTE

X

The Mute tool

The Part Mute tool is also easy to explain. Once you select it, the mouse pointer changes to an
X Parts clicked with this X are muted and become speckled grey. Click again to unmute. You
can mute as many Parts as you like.

Mauted Part and non-muted Part

3.13.4 Pencil, Scissors, Glue and a little relaxation

Before we approach the remaining three tools, you should kick back and relax for a while. Now
itis time to create the Chorus for your song. Record four Parts on the four Tracks from bar21.1.0
to bar 29.1.0. Note that the normal display size does not include the last portion of the Chorus
in the Arrange window. The right locator must be placed slightly outside the screen.

There are two ways to go about this. Either enter the position as a numerical value, i.e. 29.1.0 in
the right locator display, or if you prefer to work with a graphic display, scroll the Position Bar
forward. Here again, you have two options. You can zoom the display scale, or click in the
Position Bar’s outermost left corner. Each click moves the left locator later by two bars.
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The method you ultimately use is entirely up to you. For now, zooming the display scale is
preferable as it gives a better overall picture of the song.

Now that you have recorded the Chorus, your first song is virtually complete. Your next goal
should be to record the third and final Verse. It should be identical to the first two, with the one
difference that it is only half as long. Copy the Parts of the first Verse to bar 29.1.0, i.e. directly
after the Chorus. Put your new-found knowledge to work!

To refresh your memory:

- Press and hold [Shift] and click the four Parts (bar 5.1.0 to bar 13.1.0) on Tracks 1 through 4.
- Press and hold [Alternate].

- Drag the Parts to position29.1.0, and release them there. By the way, if you are not using another
display magnification, the Position Bar is automatically scrolled forward/back when you reach
the right/left borders of the Arrange window.

Youhavenow copied the Verse to the position right after the Chorus. Here is where the remaining
tools come into play. Select the Scissors from the Toolbox and click the following position: the
middle of the third Verse, i.e. position 33.1.0 in the first Track. You have just cut the Part in half!

\o

The Scissors tool

You will not hear a change as all notes are still intact. Click anywhere free in the Part Display
to deselect the Parts. Now you can see the cut you have just made more clearly. Drag the latter
portion of the Part further back. You can now see that the Part is indeed cut. Return the latter
portion of the Part to where it was. Select the Glue tool and click the first half of the severed Part.
The two portions are again restored to a single Part, and can be moved and copied as such.

t“
The Glue tool

We wanted the final Verse of the song to be half the length of the others. To achieve this, you
could use the Scissors to cut the Parts at Position 33.1.0 and use the Eraser to delete the severed
portions. However, there’s an even easier method: select the Pencil from the Toolbox and click
bar 33.1.0 of all four Parts. The superfluous portions are removed (bars 33.1.0 to 36.1.0).

Z

The Pencil tool

3.14 Summary and useful tips

The final three tools are powerful performers, so a brief synopsis with some additional
information is in order:

- The Scissors divides Parts at the selected position. The remaining portions can be handled in
the same manner as normal Parts. Bear in mind that the Scissors can cut large structures, allowing
you to record a long Track, then use the tools to keep the best bits.

- Pressing [Alternate] at the same time as using the Scissors divides the Part into equal lengths.
Let’s assume you recorded a Part 20 bars long. If you cut at the end of bar 2, Cubase dissects the
Part into ten two-bar Parts. Cut at the end of bar 4, and the result is five four-bar Parts.
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- The Glue connects a Part with the next one situated after it. Any gap between two Parts will
be closed. Clicking the newly connected Part again adds the following Part to this original Part.
Continued clicking in this manner merges all the Parts in the Track.

- Pressing [Alternate] automatically glues all the Parts located after the selected Part together.
- The Pencil shortens a Part. This always functions from back to front. You can only delete the
latter portion of a Part via this method. Toremove the front portion, Scissors the Part at the desired
spot, and delete this front Part.

- The Mouse field and the Snap function really come into their own when using the Scissors and
Pencil tools.

- Cubase handles all Parts in such a manner as to avoid cutting notes that are still sustaining, so
preventing the dreaded MIDI drone. Its method of recording notes is the decisive factor.
Normally, a sequencer records the start of anote and its end (see the following chapter on MIDI).
If you shorten a Part, you could theoretically Tose the Note Off command and be saddled with
a drone. Cubase follows the same routine at first by recording the beginning of the note, but then
it computes the note’s length after it receives the Note-Off command. This length remains intact,
with the following example being the sole exception.

- What this all means is easily demonstrated by a practical application. Select a sound that can
be played sustained or staccato. Record an eight-bar passage containing quarter note chords, plus
a sustained note beginning with the downbeat of the first bar, lasting throughout the Part. Use
the Pencil to shorten the Part to half its length. You will notice that the last four bars of chords
have gone, but the sustained note carries on playing for the full eight bars.

—This tells us that all MIDI data after the cut disappears. Data initiated prior to the cut is executed
forits designated length. This can confuse, as the display is showing four bars, yet you are hearing
eight, and might be undesirable where you wish to append other Parts after the first four bars.
- To avoid this problem, utilize the Cut Notes command from the Structure menu. This function
ensures all notes are cut at the designated point. The selected Parts now actually end at precisely
the position displayed on your screen. If the notes in the Part started prior to the cut, but their
endings extended beyond the cut, Cubase simply moves the note endings earlier to the cut
position.

- The Pencil allows you to not only cut Parts, but also extend them. Click and hold anywhere in
the Part. Move the mouse to the right keeping the mouse button depressed. Once you have
reached the length you want, release the mouse button. The Part is extended. If you shortened
a Part earlier, the notes you cut away are retrieved, provided you did not use the Cut Notes menu
command. Lengthening a Part does not change or move its notes in any way.

- The Pencil can also be used to make copies. Press and hold [Alternate], click a Part and drag
the mouse to the right. Release the mouse button when you have reached the desired position to
create a copy of the selected Part.

- You can easily create a blank Part. Select a Track and place the locators at the start and end
positions of the Part you want to create. Double-click somewhere in the Part Display or press
[Control][P]. The purpose of this function will be explained later on.
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4 Additional Arrange
Functions

4.1 The Inspector

So far, we have been moving, copying, deleting and merging Parts and Tracks as a whole. It is
also important to be able to alter a Track or Part in its own right. Cubase has numerous options
available to achieve this. We are about to see how this works in practice.

Select a Part and click the "Inspector” symbol in the bottom left corner of the Track List.
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This is where the Inspector is enabled

The Inspector is anew display that appears next to the Track List and contains essential data about
the selected Part. If you have not selected a Part, the Inspector displays the data for the selected
Track. This means you have the choice of editing the entire Track, or individual Parts. After you
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have done your edits, you can move on to other Tracks and Parts by simply clicking the desired
Track/Part, or choosing the right/left cursor key to select Parts of the same Track, or using the
up/down cursor key to select other Tracks.

The Inspector will then switch to the corresponding Track or Part without your having to leave
it. It will always display the current Track’s or Part’s name. This is just one example of why it
is important to name Parts and Tracks, to help you distinguish one from another.

All the parameters accessed here are "play” parameters, i.e. they solely affect the way data is
played back, not the way itis recorded. For this reason, you can always reverse alterations or enter
new ones.

4.2 The Inspector’s functions

The functions available for manipulating Tracks and Parts are identical. The first few items in
the Inspector will be familiar to you from the Track List.

- The Part/Track name is displayed at the top. A single click on the box allows you to enter a new
name.

- The Instrument field is the name of the MIDI channel.

- The Output field is covered in one of the following chapters (M*ROS Timing).

- The MIDI channel.

Changes to these fields are made in the usual way.

4.2.1 PRG Change and Volume

You can insert Bank Select, Program Change, or Volume Control Change messages at the
beginning of each Part. Simply enter the desired values. Bear in mind that these Program and
Volume commands are transmitted while you are entering the values: this allows you to audition
the alterations as you make them.

Bear in mind also that the Program Change numbers may not coincide with those of your MIDI
device. Some devices have other ways of displaying their memory locations, €.g. "A-1", "Internal
6-6", etc. Refer to the conversion table in the appendix for the most common formats.

The Bank Select command is relatively new to the MIDI protocol, and many devices don’t
support it. Bank and Program selection functions are explained in detail in chapter 5 which deals

with MIDI.

4.2.2 Transpose

Throughout this book, the explanation of a function is supported by practical examples. No
change here: let’s use the Parts in Track 4 (the piano Track) for this exercise. Switch the Track
to "Solo" so you aren’t distracted by other Tracks.

- Click the Track’s second Part. You can see that the Inspector automatically displays its

parameter values.
_ Move the Transpose value up or down, and start the Arrangement from the top. At first, the

Track plays as normal. However, the notes of the second Part are transposed up or down,
depending on the value you have entered. All changes entered in the Inspector are later played
by Cubase.

4.2.3 Velocity and Compression

Cubase adds to or subtracts from the velocity values of the data that already exist in the Part. Of
course, this can only work if your instrument supports velocity. This function is used to do things
like reduce the aggressiveness of a sound, etc.

Compression works in a similar way. However, the velocity values are dictated by percentage
and not absolute values. A 50% setting halves all velocity values, 200% doubles them, subject
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to the maximum MIDI value of 127. This function s suitable for, amongst other things, balancing
different instruments’ velocities.

4.2.4 Length

The Length parameter, too, uses a percentage scale. A Length value of 50% halves the duration
of all notes in a selected Part. Values exceeding 100% add to the original notes’ lengths.
Remember that this function, like all the others in the Inspector, applies to the playback only. You
can recall the original values simply by resetting the parameter to "0" or "Off".

4.2.5 Delay

Delay enables you to move the positions of the notes of a Part earlier (a "negative delay" or
"push") or later, relative to the other notes in the Arrangement. The value is expressed in ticks.
We will take a detailed look at what this means in a later chapter. Experiment with values of 48
and 96, which equal a thirty second and sixteenth note. Notes can be moved only within the
boundaries of a Part. If you use a "negative delay" to push a Part’s notes, those whose start times
come before the Part’s start will no longer be played. The same principle holds true for the end
of the Part if you delay notes. The Delay function is useful in all sorts of ways, quite apart from
the fun aspect:

- Some synthesizers, especially some vintage models, react rather slowly to MIDI commands:
you can compensate for their timing delays by moving the Track earlier in time.

- Enter various drum instruments on several different Tracks and, especially for the snare, try
some minor delay value changes to create a different feel for each instrument.

- Play a Part featuring eighth notes. Copy this Part to two other Tracks. Set the first copy’s
Transpose parameter to 12 and Delay to 96, the second copy’s Delay value to 48. Listen to the
result.

You can see that experimentation and the careful use of various parameters can lead to interesting
effects.

4.2.6 Exercise

To get to know the Inspector’s functions better, let’s Cycle the working Part so that it is
continuously repeated. As a reminder: position the left and right locators at the start and end of
the Part. The easiest way to do this is to select the Part and press [Alternate][P]. Switch Cycle
mode on and move the Song Position Triangle to the left locator, or press [1]. Start the playback,
and Cubase continuously repeats the Cycle. Experiment with the Transpose, Velocity, Delay,
Length, Compression and Volume values while the sequencer is running.

As mentioned earlier in the chapter, values in the Inspector apply to the MIDI data in playback
only, and do not affect the data itself. In some situations, however, it is necessary that the data
itself adopt the play parameters, e.g. when exchanging songs between different sequencer
programs. For this purpose choose Freeze Play Parameter from the Functions menu. You can find
detailed information on this function in the "System Functions" chapter.

4.2.7 Ghost Parts

In the previous example for the Delay parameter where identical Parts were copied one after the
other, it was not actually necessary to make a complete copy, because only the play parameters
of the Parts were altered. So next time, press [Control] instead of [Alternate] during the copy
operation. The copy you make using this method is distinguished by the dotted line that surrounds
it. You can move these "Ghost Parts", copy them, assign other MIDI channels to them, and
change their play parameters.

But there is one fundamental point to bear in mind: any changes you make to the source Part (the
Part they’re ghosting), e.g. via the Editors (we will get to these in due course), apply to the Ghost
Parts as well. On the other hand, as soon as you cut, merge or add a Ghost Part to a regular Part,
it is automatically converted into a normal Part.
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4.2.8 Part Info

Each Part has its own Part Info box, where certain data can be excluded from the playback. To
do this, just click the type of data you want to filter out. This function is of use when you want
to suppress data-intensive MIDI information such as Aftertouch. The chapters on "MIDI" and
"Timing" take a closer look at this function. The Part Info also allows you to move a Part or alter
its length.

Activate a Part of your choice, then choose Info from the Edit menu or press [Control] (Il. You
can use the skills acquired thus far to change the settings in the dialog box. Bear in mind that the
changes affect the selected Part only. You cannot select another Part while the dialog box is on
your screen. Y oumust first press [Return] to go back to the Arrange window, select another Part,
and then open its dialog box again.

NOTE OM
FOLY FRESSURE

PROGRAM CHANGE

AFTER TOUCH

The Part Info box

By the way, from version 3.0 upward, all of these types of dialog boxes can be treated like
conventional windows and moved around the screen. If at some time you are uncertain about
which Part is currently selected, click and hold the top bar of the dialog box and drag it aside so
you can see the Part Display.

4.2.9 The realtime aspect

So far as Program Change and Volume Control Change messages are concerned, we have seen
that they are sent via MIDI directly to the instruments while they are edited. The same principle
applies to Transpose, Velocity, and Compression: you can hear the effect of the edits as you
execute them. Change a Part’s Transpose value when the sequencer is in Stop mode; at the same
time, play something on your instrument. Your computer executes the changes inrealtime, which
allows you to set the parameters prior to recording.

Program Changes and Volume Control Change commands are also very handy options for live
applications. Create two successive blank Parts on one Track. Enter a Volume setting and a
Program number in the first Part’s Inspector. Assign different values to the second Part. Start the
playback from the beginning of the first Part and play anything you like. When the first Part is
over, Cubase changes programs in your synthesizer and changes its volume setting, provided
your instrument supports this kind of information. This exercise shows that you can execute
functions similar to those of a mother keyboard via Cubase, using a blank Track containing
merely the play parameters.

Although this experiment is not complex, it shows that you can get maximum results with a
minimum of effort. Experiment away! You will encounter tricks and shortcuts as you continue
working with Cubase that will dwarf the one above.
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4.2.10 The Clipboard

Apart from selecting a Part and copying it with the aid of the mouse, there is a another copy
function which can be used in other areas of the program too: the Clipboard. The Clipboard is
unassigned computer memory which you can access to temporarily save various items. The
following example illustrates how the Clipboard can be used for Arrangements.

Select all four Parts of the first Verse. Choose Copy from the Edit menu ([Control][C]). The four
Parts are now copied to the Clipboard. Place the Song Position Triangle at bar 35 or later. Choose
Paste from the Edit menu or press [Control][V]. The four Parts are inserted at the current song
position. Select the four Parts again, if they are not already active, and this time, choose Cut, not
Paste, from the Edit menu ([Control][X]). It seems that.the Parts have been deleted, but actually
they are in the Clipboard. You can insert them at any given song position.

The way the Clipboard works is easy to explain. Copy enters a copy of the selected Part(s) in the
Clipboard, leaving the original(s) in the Arrangement; Cut removes the Part(s) from the
Arrangement and lodges it/them in the Clipboard. Paste copies whatever is in the Clipboard to
the Arrangement’s current song position. You will see later that Clipboard Parts can be inserted
in other Arrangements as well. Once something is in the Clipboard, it can be pasted as often as
you like.

Try the following exercise. Select the Verse Parts again and copy them to the Clipboard. Set the
song position to bar 40.1.0. Activate the Paste function, and the Verse is inserted in the
Arrangement at bar 40. Set the song position to bar 48.1.0. and activate the Paste function again.
As you can see, the Verse is inserted again, which shows that it does not matter where you insert
the Clipboard contents. You can even overlap Parts.

There are two important rules to keep in mind concerning Clipboard operations. The information
you copy to the Clipboard is saved temporarily. As soon as you Cut or Copy new material to it,
the previous contents are lost. You can use this to your advantage. Once a Part is no longer
needed, remove it with the Cut command, and just leave it in the Clipboard. That way, the
Clipboard assumes another function, that of the trash.

The second important rule: Parts copied to the Clipboard can be inserted anywhere within an
Arrangement, but only on the same Tracks. The four Parts you just copied from Tracks 1 to4 can
be moved forward and back, but must remain on their respective Tracks.

You will encounter these Clipboard functions again and again. Work with them for a while so
you are familiar with them when they crop up again.

4.3 More Arrange functions

Several additional features round off the Clipboard’s attributes. Are the Verse Parts still in the
Clipboard? Then copy them to the end of your song, three times in succession from position
40.1.0. Position the locators at bars 42.1.0 (left locator) and 45.1.0 (right locator). Choose Global
Cut from the Structure menu and watch what happens. Cubase cuts the information between the
locators and moves the remaining portions after the right locator to the left locator. This allows
you to quickly remove sections from the Arrangement and join the remainder seamlessly to the
first portion. All the material between the locators is removed. The exceptions are muted Tracks
which are excluded from the cut and remain unaffected.

The counterpart to Global Cut is Global Insert, which is also in the Structure menu. Check out
this feature. This time the section between the locators is not removed, but a blank space is
inserted. This is useful when you want to create a break in the Arrangement. Here too, muted
Tracks remain unaffected. You can fill the blank space using the skills acquired so far.

Two other similar commands are listed in the same menu. Global Split is comparable to the
Scissors in the Toolbox, but here all the Parts in the Arrangement are divided at the left and right
locators. If you want to execute a single Scissors cut only, either place both locators at the same
position, or put one in a blank space somewhere in the Arrangement.
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Copy Range executes a function you are already quite familiar with, but more simply: the section
between the locators is copied and inserted at the current song position. For these two functions
the following also applies: muted Tracks are excluded from any alterations.

4.4 Group Tracks

You are by now familiar with all the basic techniques used for creating songs. You know the
Arrange window’s layout and how to utilize its features to record a song and edit the results. If
you prefer to record one complete Track after another you probably knew it all after the first few
pages anyway. If you work in a more pattern-oriented fashion, you have already mastered the
basics.

However, Cubase has another jewel in its crown for those who prefer to work along pattern-
oriented lines: the Group Tracks. Before we get down to business, ensure the original song
structure is intact. Delete all Parts created during the last few exercises, provided they are not an
integral Part of our basic song structure.

Now save the results so far. Click "Save' in the File menu or press [Control][S]. Select
" Arrangement” in the dialog box that appears or press [2]. You will be confronted with the Item
Selector. If a name is already in the Selection line, use [Esc] to delete it. Enter a name for your
new Arrangement, e.g. "Basic" (bear in mind that the name may not exceed eight letters) and
press [Return].

4.4.1 Creating and editing Groups

Your song is divided into five separate sections: the Intro, three Verses, and the Chorus. Upto
this point, when you wanted to manipulate a section within the structure, you were forced to
select all its relevant Parts, and then move them. The Clipboard makes things a bit easier, but
Cubase has an even easier method in store for you.

Activate all four Intro Parts. Go to the Structure menu and choose Build Group ([Control]{U]).
A dialog box appears. Delete the default name "Group 1" by pressing [Esc] and enter anew name,
e.g. "Intro". Confirm the entry by pressing [Return] or clicking the New button.

Build Group

The Intro’s four Parts are grouped...

...named...
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...and added to the Group List

Cubase returns to the Part Display. A new column appears to the right, in which the Groups you
create are listed. You can hide the display by choosing Hide Groups from the Structure menu
([Control][J]). To recall the display, activate this command again.

Now let’s define the next Group. Select the Parts of the first Verse. Call up the Build Group
function again ([Control][U]), assign a new name, e.g. "Verse", and enter the new Group in the
Group List by pressing [Return]. Use the same method with the remaining sections of the
Arrangement. The Group List should then look like this:

Verse
Chorus ‘

| DOWN |

The Group List
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Before creating a Group, ensure that you select only Parts that actually belong to the Group.
Cubase doesn’t really care what you define as a Group. The Parts you select for a Group do not

have to be adjacent; their relative positions are maintained, together with the individual Parts’
MIDI channel settings and play parameters.

The final number of selected Parts is also up to you. Bear in mind that the first Verse is identical
to the second, so you just need to define one single Group.

After you have assigned all your song sections to different Groups, you are probably asking
yourself what the reasoning behind this is. Here is a little experiment to clear things up:

We first need to define a Group Track. The Track Classes are what you use to do this. These are
called up for every Track using the "C" column of the Track List.

Click and hold column C of, say, Track 16, which is currently showing a note symbol. A menu
featuring five or more choices will appear, depending on the Cubase version and the modules you
are using. The default position is "MIDI Track", denoting a Track on which standard MIDI data
is recorded. In order to convert this Track from a MIDI Track to a Group Track, select the

corresponding item.

Ji iTrack 12 i12 |
Ji iTrack 13 (13!
Ji {Track 14 14 |
Ji iTrack 15 i15
16
Drum Track |: |
Group Track [ &
Tape Track
50 s 1 a
Mix Track
EDEQLO
N 5. 1. 8

CYCLE

Selecting the Track Classes

The symbol in the column changes and the Track is now a Group Track. You can cancel this
definition at any time, provided there is no data in the Track. Essentially, any blank Track can
be made into a Group Track. The other Classes such as "Drum Track", etc. are discussed in later

chapters.

a iffdLK ALL 4L
i) Track 12 12
& Track 13 13
J Track 14 14
™ Track 15 15
(g) Track 16
e
3
ELl &l
soL OVERDUE 1. 1. @
ensolo
[n 5. 1. 8

[y g

Track 16 is now a Group Track

Click and hold the first Group you have created, Intro, in the Group List. You can drag this Group
as you would any Part by holding the mouse button down as you move the mouse. Drag the Intro
Group to position 1.1.0 of the Group Track. Place the following Groups behind it, in any order.
The result should look like this:
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The Intro Group is in place

Mute all Tracks other than this Group Track. Play the results back. Even though you muted all
the other Tracks, you can still hear their original notes: this is because the Groups contain all the
necessary information.

To recap: a Group can contain as many Parts as you want. The Groups can then be arranged in
any order on a separate Group Track. Of course, you can name or completely delete a Group
Track just as you would any other Track. A Group Track cannot have a MIDI channel assigned
to it, for the MIDI channel is determined by the Tracks of the individual Parts that make up a
Group.

The Group Track’s components can be regarded as normal Parts. You can move, delete and mute
them, edit them via the Pencil and copy them using [Alternate]. However, you cannot merge,
Scissors nor Glue them, nor can you record on a Group.

If you copy a Group to a position occupied by another Group, then the rest of the Groups are
moved later. In other words, the Group is inserted into the Arrangement. You can superimpose
a Group on another one. Double-clicking a Group allows you to rename the entire Group.

Change the structure of your Arrangement again and watch how the defined Groups always
correspond to the original Parts. If you delete a Part that was assigned to a Group, then that Part
isremoved from the Group as well. If you delete all the Parts assigned to a Group, then the Group
disappears too. You can add new Parts to a Group whenever you want: press and hold [Shift] and
select the desired Part and the destination Group. Open the Build Group menu and click Add
instead of New. The selected Part is added to the Group.

"Replace” in the Build Group menu replaces all the Parts in a Group you had defined previously
with those currently selected in your Arrangement.

Double-clicking a Group in the Group List allows a new name to be assigned to it. Dragging a
Group and moving it up or down out of the Group List deletes it.

4.4.2 What Groups can do

Now that you know how to create and edit Groups, let’s take a look at their many versatile
applications. One of these we have already applied during a practical exercise, namely how to
quickly change the order of sections in an Arrangement.

You don’t always have to assign Groups as Choruses or Verses. You could just as easily group
together percussion or wind Parts and insert them at the desired position within the Arrangement.
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4.4.3 More Arrangements

In this context, another one of Cubase’s abilities we have yet to discuss comes to mind. So far,
you have created just one Arrangement. But Cubase can keep up to 16 Arrangements in its
memory at any given time, seven of which can be displayed simultaneously on the screen. Click
the Close box of your Arrangement, press [Control][W], or choose Close from the File menu.

ile

The Close box

You now have several choices available. Cancel does what it says, it abandons the operation.
Discard deletes everything you have created so far! Let’s choose Keep. Your Arrang  ntisno
Jonger visible, but it is still lodged in the memory.

Go to the Windows menu. You will find the name of your Arrangement listed here. Click it to
display it on your screen again. After this little exercise, we return to the Groups.

. Do you want to keep
. the arrangement ?

[keer | [oiscarp] [ canceL |

Discard deletes the Arrangement, Keep saves it

Choose New from the File menu or press [Control}[N]. A blank Arrangement appears in which
you can still see the Group list. Create a new Group T  k and arrange the Groups in any order
you like. At some point in time, you will have to zoom the Position Bar display. Now listen to
the results of your efforts.

& File Edit Structure Functions Options Modules Windows
BAR se 1. 1. a I auantize 16 lcwcle Ree Mi

a M C‘T Track ny 1 1 | 1 1 1 [= 0

Chorus

First create a new Arrangement...
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<» File Edit Structure Functions Options Modules Windows
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...then drag the Groups to the Group Track

<» File Edit Structure Functions Options Modules Windows
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The basic Arrangement is completed

Create a normal Track with [Control}[T], or double-click the Track List. Assign it to the MIDI
channel of your piano sound and record a Track to accompany the Arrangement as it plays. Do
not position the locators nor activate Cycle mode, and switch the metronome off. Record more

Tracks if you want.

<» File Edit Structure Functions Options Modules Windows
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You can record new Parts on the remaining Tracks
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The ability to keep several Arrangements in the memory opens up additional possibilities. You
could for instance create drum Parts in one Arrangement, define them as Groups and then insert
them into another Arrangement. The Clipboard can also be used to exchange information
between different Arrangements.

Keep the following differences in mind: once Parts are entered in the Clipboard, you can move
them within a single Track only, and not on to other Tracks. If you move Parts from one
Arrangement to another, as many Tracks as required are automatically added. You can see that
the Clipboard functions somewhat differently in this sort of situation.

All Arrangements can be saved together as a "Song". Detailed information can be found in the
chapter "System Functions". :

You can simultaneously display up to seven windows on the screen. The new Arrangement you
have just created is superimposed on the original one. Click and hold the right bottom corner of
the current Arrange window and reduce its size.

When you release the mouse button, the other Arrange window becomes partially visible. Click
the bottom window to move it to the top.

Keep in mind that windows can be reduced, enlarged, or moved about as you see fit. Tile
Windows in the Windows menu is a handy function: it lays out the available Arrange windows
in such a way that they are all fully visible - in so doing, it adjusts their sizes: the more windows
there are, the smaller each window has to be.

Arrangements saved with the Keep command need to be opened before they can be included in
the Tile Windows operation. Simply click the desired Arrangement name in the Windows menu.
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Several windows can be open at the same time

Note: you will come across other types of window that can be displayed on your screen as you
work through this book. Too many open windows cloud the overall picture. Try to limit yourself
to a sensible number and ignore the number technically possible.

If you prefer to work with as many windows as possible, you should consider acquiring a larger
monitor. Detailed information is provided in the appendix under "Additional Hardware".
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Tile Windows adjusts the window sizes

Due to the Atari’s operating system, only one window at a time can be active, and you can make
changes in the active window only: you’ll recognize it by its highlighted black Title Bar.
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The left window is inactive, the right active

Aninactive window can be activated by clicking anywhere onit. Note that only one Arrangement
at a time may be played.

4.4.4 Realtime Groups

As a crowning glory, we will insert Groups in the Group Track in realtime. Choose New from
the File menu to call up a new Arrange window. Create a new Group Track and place the Intro
at Position 1.1.0. Place the Song Position Triangle at the beginning of the Arrangement and start
playback. Cubase plays the Intro. While the Intro’s final bar is playing, press [Control] while you
click a Group in the list. This Group is inserted right after the Intro and is played back.

Cubase places Groups selected using this method on the downbeat of the following bar. For
instance, if you click a Group while bar 4 is playing, then the selected Group is inserted at position
5.1.0. This function allows you to create an Arrangement structure and listen to it at the same
time. This way you could, for example, insert additional horns or strings into an existing
Arrangement.

4.5 A first brief summary

Now we have gone through all the Arrange functions. Close the windows one after another, and
this time, confirm with Discard instead of Keep. All the Arrangements are being deleted. Do not
forget to activate and delete the Arrangements saved in the Windows menu.

You can load your basic Arrangement at any time from the disk you saved it on: choose Open
from the File menu and "Arrangement” from the dialog box that then appears, or press
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[Control][O] followed by [2]. The Item Selector displays the disk’s contents. Select your
Arrangement entitled "Basic” with a double-click. You could also click the file name and select
OK or press [Return]. Your practice piece is loaded back into the memory.

Now it is time to kick back, relax, and reflect on a job well done. If you have run through all the
exercises conscientiously, then the basic handling of Cubase should no longer pose a problem.
You can create Arrangements based on your personal preferences using long Tracks and/or
Patterns. You can save these Arrangements on disk and load them at any time.

The next chapters delve more deeply into Cubase’s more advanced features. Here too, please
keep experimenting, as "practise makes perfect” - that’s the only way you’ll be able to
concentrate on the music without letting the technology get in your way.
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5 mipi

If you have worked with Cubase this far, you have been introduced to the basics of MIDI. Yet
the power of the MIDI standard goes far further than these basic applications. A thorough
understanding of MIDI is necessary before you can really know the ins and outs of Cubase. This
chapter will give you the necessary technical background, and establish the connection between
technology and practical application.

5.1 A short history of MIDI

Sequencers were in existence well before the era of digital technology. At first, these were limited
to analog devices, which were usually monophonic and operated on control voltages. The first
sequencers featuring digital communication were roughly comparable in operation to the
principle of MIDI, but they had one major disadvantage: they only supported certain synthesizers
from the same manufacturer as the sequencer. For example, the Oberheim DSX sequencer did
not support the Sequential Circuits Prophet V, an extremely popular device at the time: you had
to use the Sequential sequencer, which in turn could not communicate with the Oberheim OB-
Xa, OB-38, or the Roland Jupiter 8. Everyone was confronted with a problem to which there
seemed to be no real solution.

To get to grips with this problem, electronic musical equipment manufacturers set about
developing a universal interface. The goal was to establish a communications medium for all the
diverse models of different manufacturers. After a lengthy developmental phase, the MIDI
standard was firstintroduced in 1982. The first MIDI devices, a Roland Jupiter 6 and a Sequential
Circuits Prophet 600 were connected at a trade fair, and the long-awaited communication
standard was established. The Prophet could by driven by the Roland’s keyboard, and vice versa.
This new development was given the title, "Musical Instrument Digital Interface", in short,
MIDI. Its enormous success can be measured by the fact that today virtually no device reaches
the market without the obligatory MIDI ports.

5.2 The hardware

Costconsiderations dictated arelatively modest hardware configuration. Most devices incorporate
three standard ports:

- MIDI In receives information sent by another instrument or computer.

- MIDI Out transmits the information a device produces.

- MIDI Thru passes on the information it receives at its MIDI In to other devices without
modifying the data, which means several devices can be connected in series. Some economy
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models do not feature this port and in some cases, it may be integrated in the Out port. However,
the function remains the same.

MIDI data is transferred via a standard five-pin cable, comprising two wires and the shielding.

5.3 Communication

In addition to the hardware question, the manufacturers had to agree onacommon communications
protocol in order to make sure that musical devices could communicate with one another. This
MIDI standard, with a few additions along the line, remains the standard today.

To gain an understanding of data transmission in general, and MIDI and sequencer applications
in particular, let’s now take a look at the basics.

In order to transfer the information that is created when you hit a key on your keyboard in the
form of a digital MIDI command, the information needs to be broken down into individual steps.
The source instrument tells the destination instrument which note was played, and the velocity
with which the key was struck since most instruments now respond to velocity dynamics.

A computer processes only numbers, which is where its strength lies. For this reason, it is
necessary to translate musical information into numeric values.

The MIDI protocol performs this task as follows: to switch a note on, the source instrument sends
three consecutive numeric values to the destination instrument. The first value is referred to as
the "status byte". It tells the destination device what type of MIDI message will follow, in this
case, the command to play a note. The next value defines the note in question. Finally, the
velocity tells the device how hard or softly the key was struck. These second and third messages
are called "data bytes".

MIDI In
*

»10010000,00111011,01011000«
»90,3B,58«

»Play note B2 with a velocity of 88«
MIDI Out

|

A MIDI message prompts the sound module to generate a note
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5.4 Bits and bytes

The term "byte" is derived from the computer world and is transmitted in a specific numerical
format, i.e. binary. Let’s take a brief look at the mathematics involved. A detailed analysis is
reserved for the section entitled "Hard stuff”.

Computers process data and numbers using a switching process, and MIDI messages are treated
the same way. Computers distinguish between just two states, on and off, and they translate this
by switching a current between two numbers, 1 and 0. The digital representation of these values
is called a "bit". In order for a computer to be able to deal with larger numbers, it combines eight
bits together to form a byte. A byte can represent up to 256 different numbers.

The MIDI protocol is based on this eight-bit concept. The computer uses the first bit to
distinguish between a status and a data byte. If the first bit is set to one, the byte in question is
a status byte. Conversely, a zero in the first position denotes a data byte.

1
}abit(00r1)
(o]

|o|o|ol1|110|ol1|}

first bit = zero:

[O[ATAT1T 00l 1] 1] J databyte
Bytes

[1[olol1]ololol0O]Y . .

(switch on note) first bit = one:

[TTo0l0lolojol ol o] 7 Sttusbye

(switch off note)

Bits, status bytes and data bytes

By distinguishing between 1 and 0, the computer or synthesizer is able to transmit the necessary
information. Your instrument and the computer are exchanging virtually endless sequences of
numbers telling each other what to do in response to what you or Cubase are playing. The
important fact here is also the source of some irritation among many MIDI users: MIDI is a serial
protocol.

Within the MIDI cable, only one of the wires is used for MIDI data transfer, which means that
the MIDI messages have to be sent one after another, not simultaneously. In the example above,

. the status byte is sent first, followed by the two data bytes. Even though this occurs at a very fast
rate, you should always keep in mind that an incredible amount of information has to be
transmitted while you play. A situation involving a complex Arrangement of instruments and a
large number of MIDI Tracks full of notes can, under some extreme circumstances, cause the data
transfer to lag behind the song’s tempo.

The correct timing of notes and other data is essential in music, so you can see where you might
run into problems. That some MIDI messages are much more data-intensive than those that
simply convey information on notes means that the problem is compounded.

However, before you decide to chuck away all your MIDI gear, let me reassure you on a few
points: despite certain disadvantages, MIDI allows for a great deal of headroom in musical
applications before you even come close to encountering these problems. Plus, there are a
number of ways of coping with or even preventing them altogether. We will take a closer look
at both of these points later on.

Now back to our MIDI note. A MIDI Note On message comprises three sections which are sent
as three separate bytes, and interpreted by the receiver. Note commands and their velocity can
contain up to 128 different values, so for velocity, this means that a note can be played at one of
128 steps of velocity. The following diagram gives you an idea of the musical range that can be
achieved via MIDI:
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The tonal range of MIDI (with a standard piano keyboard above for comparison)
showing note pitches and their corresponding MIDI note numbers

The range exceeds that of a standard piano. Each MIDI note number is sent with a preceding
status byte which tell the receiver to play the corresponding note.

There are lots of other types of MIDI commands, not just note messages, and we’ll be discussing
them all in due course. All MIDI commands have one thing in common: they all have a status
byte. It is usually followed by one or two data bytes. Special applications such as sound data
transmission can have huge numbers of data bytes.

5.5 Additional MIDI commands

The MIDI message telling the receiving sound module to play a note is called a "Note On event".
Obviously, you will release the key sooner or later. This entails a similar process: a status byte
is sent containing the Note Off event. The two following data bytes specify the note number and
the speed at which the key was released. The latter is called "release velocity". This means that
on some (very rare) devices, you could program the decay time of the sound to correspond to the
speed with which you release the key. However, very few synthesizers can send or interpret
release velocity.

If no Note Off followed the Note On, the note would simply sustain until you switched the device
off. You can try this out: select something like a string sound, press any key and hold it. Now
unplug the MIDI cable from the receiving module. Even if you release the key the note will drone
on. Some devices have a way of stopping such drones: if yours doesn’t, simply switch the
receiver off.

Apart from the Note Off message, the MIDI standard includes another way to switch notes off,
where a Note On command is sent with a velocity value of zero. Thisis adefault setting in Cubase.
This may lead to problems in very few devices which don’t recognize this command.

Almost no-one has ever run into this problem with a sound module. It is less rare when using a
mixer automation system that uses Note On/Note Off commands to mute audio channels. If you
are using a device which recognizes Note Off commands only, choose MIDI Setup from the
Options menu. The Note Off entry in this dialog box is not usually activated. Click the blank box
to activate the Note Off mode. Only do this when you are left withno other choice. You will later
see that this function adds even more data to the MIDI load.

In some especially difficult situations you may have to resort to the Length Correction function
in the MIDI Setup dialog box. Length Correction puts a little gap after Note Off commands if
they are followed by more Note On commands of the same pitch and on the same MIDI channel
This is because some synthesizers with slow reaction times sometimes have problems. So, if your
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device has problems reacting to rapid staccato notes, try experimenting with the Length
Correction values.

- [/ 4
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[Control 8

Reset &
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The Note Off and Length Correction functions

5.6 MIDI and sequencers

We have seen how one or more notes of a sound module can be played and stopped in any order
via MIDI messages. Switching notes on and off in any order is usually referred to as playing
music (think about it!). This takes us away from technical matters and back to the music.

If we carry thislogic a step further it will shed some light on the way sequencers and hence Cubase
operate. A sequencer is no more than a recorder that sends messages to an instrument, telling it
when and with what velocity to switch notes on and off. The sounds themselves are not recorded,
but simply the note parameters. What kind of sound this note information triggers depends
entirely on the receiving synthesizer or sampler.

| ‘

| |
_‘l Il |/

T

Switch Switch Switch

note G3 notes F3 note F3

on and A3 on on
Switch Switch Switch
note G3 notes F3 note F3
off and A3 off off

How a Note On and Note Off sequence relates to notes

However, complex music consists of more than just a number of notes playing the same sound:
itnormally comprises many different sounds produced by one or more different instruments. The
MIDI standard must do more than just generate notes in an instrument via remote control; it must
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also be capable of controlling several devices at the same time via one simple cable. This is
accomplished with the help of MIDI channels, of which there are 16.

WIDI Thru MIDI Inl MIDI channel 3
a2} [ o FE X - JC8
miDi in| MIDI channel 2 D i
MID! Thru
mipi Thew| MIDI channel 1 MID! In
s ===
i o i MIDI channel 4

MIDL in

»MIDI channel 3, play note C3, velocity 120«
»MID! channel 2, play note A2, velocity 100«

Sending commands via MIDI channels

Sound modules that are programmed to listen to a certain channel will only react to MIDI
messages sent on that channel. In the diagram above, the modules can "hear" if a MIDI message
s sent intended for them: the devices set to channels 2 and 3 recognize their respective MIDI
messages and each of them executes the command to play a specific note. The other two modules
are not addressed, so they remain silent.

Why does MIDI feature only 16 channels? The answer is based on the structure of the MIDI data
format, and requires a more detailed look at the technical aspects. In practise, you won’t have
to deal with the maths, unless you decide to delve into Cubase’s advanced applications.

5.7 Hard stuff: the data formats

Every decimal number (that’s the way normal people count) canbe converted to abinary number.
We’ve just seen that the computer and MIDI use binary numbers to transmit commands and

subsequently translate them into music. The binary system of numbers is fairly easy to
understand. Each of the eight bitsina byte is a multiple of 2, hence the term "binary". Asa mini
rule-of-thumb, the significancies of each of the places in a binary number can be computed by
starting with the number 1 and repeatedly multiplying each by 2.

Bit 8 Bit 1 Byte

8 7 6 5 4 3 2 1
2 2 2 2 2 2 ) 2 power of two

128 64 32 16 8 4 2 1 product in decimal numbers

The following byte
0 0 0 0 0 0 0 1
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corresponds to number 1. The byte
1 0 0 0 0 0 0 0

corresponds to number 128. The following method simplifies the conversion of decimal into
binary numbers. Just split up the decimal number by 2. So, 120 is

Ox128)+(1x64)+(1x32)+(1x16)+(1x8)+O0Ox4H+0x2)+(0x1)

The number 120 is therefore represented in the binary system as:

120 =0111 1000.

The number 129 is factored as

(1x128)+(0x64)+(0x32)+(Ox 16)+(0x8)+(f)x4)+(0x2)+(1 x 1) = 1000 0001.

The highest value which can be represented by a byte is 255. In computer terminology the two
halves of each byte, each containing four bits, are called "nibbles".

(1x128)+(1x64)+(1x32)+(1x16)+(1x8)+(1x4)+(1x2)+(1x1)=255=11111111.

In this example all bits in the byte are set. If you include the value 0 (0000 0000), there are a
maximum of 256 different values. MIDI distinguishes between status and data bytes when
transmitting messages. The computer does this by taking the left bit as a reference. If it is set to
1, you are dealing with a status byte. If not, the byte concerned is a data byte. In equation form,
it looks like this:

Byte > 1000 0000 (decimal 128 and higher) = status byte
byte <0111 1111 (decimal 127 and lower) = data byte

So we can conclude that data byte values cannot exceed 127 as all values above 127 are treated
as status bytes. This applies to a large number of MIDI messages such as note range and velocity
values. If a higher data resolution than 127 is required, MIDI uses a little trick, but more on this
later.

We still haven’t explained why there are only 16 MIDI channels. The information you have been
given so far gives you a clue. The channel coding is always lodged in the second Part of the status
byte, its second "nibble". Let’s look at a Note On event in more detail:

First nibble Second nibble

1001 0000

There are sixteen possible values for the second nibble:

8421

0000=0
0001=1
0010=2
0011=3
1111=15

0 through 15 gives sixteen different values.

5.8 Still more numbers

If you wade your way through one of your devices’ operating manuals, you are bound to run into
character combinations such as F0, 11, 12, BO or F7. Sometimes these codes are preceded by a
$ symbol or followed by an "H", e.g. $F0, $11-FOH, B5H. These codes are derived from a format
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used in MIDI based on the hexadecimal system. The dollar sign or the H serve to distinguish
hexadecimal numbers from decimal numbers.

We looked at binary numbers in order to gaina better understanding of how a computer operates.
Hexadecimals in turn are essential for programming some of Cubase’s more advanced features,
such as creating your own MIDI Mixer applications.

The hexadecimal system is a more compact way of representing numbers. One hexadecimal
place can represent 16 different values, as opposed to two in the binary system and ten in decimal.
The values are represented by the following symbols:

Hexadecimal : Decimal

0=0
1=1
2=2
9=9
A=10
B=11
C=12
D=13
E=14
F=15

Because MIDI uses 256 values, we need two places in the hexadecimal system. The first place
is computed following the method depicted in the table above. The decimal value of the second
place is the result of a multiplication by 16. The hexadecimal value of $FF is therefore:

F (= decimal 15) x 16 =240 + F (= decimal 15) = 255. We know that this must be a status byte.

The hexadecimal value $61 is: 6 (= decimal 6) x 16 = 96 + 1 (= decimal 1) = 97. This number
is a data byte.

More examples:
$A0 =160 (10x 16) +0
$34=523x16)+4

We don’t need to get into too much detail regarding this data format. However, there’s an easy
way to convert hexadecimal into binary numbers and vice versa. The binary number is divided
into its two nibbles. Each nibble can represent 16 different values. This is exactly the range of
values which one place of the hexadecimal value can represent. And here’s how the conversion

works:
1st Nibble 1000  2nd Nibble 0000 from 1000 0000

equals decimal 8 0
equals hexadecimal 8 0 you get ($)80(H)

ist Nibble 1111 2nd Nibble 1111 from 1111 1111
equals decimal 15 15

equals hexadecimal F F you get ($)FF(H)

You can now breath a sigh of relief. The following dissection of a MIDI Note On event will
represent the end of our mathematical excursion:
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binary hexadecimal message
Status byte 1001 0000 144 Note On MIDI channel 1
Data byte 1000 0000 40 MIDI Note 64 = E3
Data byte 0000 1101 0D Velocity = 13

This knowledge won’tdirectly benefit you in your musical endeavours, but it will help when you
want to program, say, a MIDI Manager application that Steinberg hasn’t included in the Cubase
package.

The appendix includes a complete conversion table for binary, decimal and hexadecimal
numbers. :

5.9 MIDI Program Change events

Back to the MIDI interface. It has many more applications than just controlling notes. For
instance, you may want to switch to a different sound on your synthesizer at some place during
asong. Youcancallup any sound with a simple MIDI command. The message consists of a status
byte and one data byte, so up to 128 programs can be accessed.

Program Change events are bound by the 16 channel limit, allowing a maximum of 16 different
sound modules to be addressed. This, of course, includes the virtual "devices" within a
multitimbral synthesizer.

Bar 1 Bar 9
| No. 5 Piano No. 6 Heavy Metal Madness\\
Sound

MIDI Program Change

A Program Change

The example above illustrates how Cubase switches to another sound upon reaching bar 9 of a
particular Part. The section on the Inspector in the previous chapter showed how you can do this.
The Program Change event simply calls up a memory location in the receiving device on a
specific MIDI channel: the sound in this memory location depends on the receiving device.

Record a Part of your choice and at the same time switch programs at the device itself. Cubase
records the Program Changes (providing the device is transmitting to Cubase) and plays them
back.

MIDI can address a total of 128 programs. The majority of modern devices offer substantially
more sounds, so the manufacturers of MIDI equipment decided some time ago to expand the
MIDI standard, which led to the introduction of the Bank Select command. In theory this
command can access 16,384 banks, and within each bank you get the 128 standard Program
Changes. This means you could address a total of 2,097,152 programs. Satisfied? The Bank
Select command can also be found in the Inspector.

There is a ground rule that governs all MIDI options, including the Bank Select command:
regardless of all the great things Cubase and MIDI have to offer, the receiving device must be
capable of processing the information it receives, which is far from the case. As of yet, few
devices can deal with Bank Select commands. The actual MIDI command consists of a
combination of two "Control Changes" which we’ll take a closer look at in one of the following
sections.
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5.10 Possible problems

Basically, a Program Change is a simple process. However, you can still run into problems. The
good news is there is a solution for each of these problems.

If you send Program Changes in rapid succession, your device may react to them rather slowly.
The root of the problem is fairly obvious: some Program Changes require the device to reset
literally hundreds of parameters. Depending on the device’s performance specifications, this can
take a brief moment and may even cause extrancous noise. Such noise can occur when a Program
Change is received while notes are still sounding, or where a program has a fairly long envelope
release phase, even if you can no longer hear the sound. Most devices abruptly cut the sound off
when the next Program Change command isreceived, though some instruments are quite capable
of dealing with this problem.

To avoid this kind of problem, you should avoid sending Program Changes on the downbeat of
the bar, but slightly before it. For this reason, Program Changes executed by the Inspector are
sent prior to the downbeat. If you are still having difficulties with Program Changes, i.e. delays
and noise, change the Play Parameter Delay in the MIDI Setup dialog box. Negative delay values
move the Program Changes to a position before the downbeat, which is usually prior to the new
notes. Try different settings until you have resolved the problem.

The Play Parameter Delay

As arule, you should keep Program Changes to aminimum in your songs. Program Changes can
be annoying in other respects. If you load new sounds into your instrument via MIDI or froma
cartridge, the Program Change commands are still valid but the sounds called up by the numbers

will be completely different. This is particularly irritating if you prefer to work with sounds you
have programmed yourself.

Let’s assume you have modified asound without saving it afterwards. You naturally want to hear
the edited version in a musical context. You play the song back. If a Program Change comes
along, it may destroy the results of all your efforts. Why? Many synthesizers temporarily store
edited sounds in a buffer. If you accidentally switch to a new program in Cubase, the
corresponding sound is loaded into the buffer, deleting your edited sound.

Cubase displays Program Changes as decimal numbers, from 1 to 128, such as in the Inspector.
However, some synthesizers use other counting systems: the Roland D-50 operates on an octal
system (11-18, 21-28,...), the Kawai K1 on a bank system (A-1, A-2,...). Others don’t offer the
whole range of programs allowed by MIDI (the first Yamaha DX7 had just 32 programs). Others
such as the Oberheim Matrix 1000 have way more than 128 program locations.
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These devices interpret MIDI Program Change events differently; for instance, Program Change
3 could call up Program 203, and so on. Please make up a conversion table when using devices
that count differently to MIDIL

5.11 The General MIDI standard

The General MIDI Standard (abbreviated as GM) further helps to co-ordinate Program Changes.
In the GM standard, sounds are assigned to categories such as piano, strings, etc. Similar sounds
are allotted to the same program numbers in a GM device. This means that you can configure your
channel assignment, knowing that the sounds will be correct, no matter which GM device you
play back on, as in the following situations:

- you have bought a new instrument and you want to play your old sequences on it.

- You want (or have to) play a finished Arrangement on another instrument.

- You are exchanging Arrangements with another musician.

- You have bought MIDI disks containing ready-made songs.

If you stick to the GM standard, your Program Change commands will call up similar sounds,
whatever the device, though of course no two devices from different manufacturers will sound
identical. The Yamaha TG 100 and the Roland Sound Canvas each offer different sounds. You
can recognize a similarity in the sound material though, and then select the ideal sound or take
such a sound as the starting point for further editing. Without the GM standard, a piano Track
might trigger drum sounds, your bass line could be played by Ukrainian cowbells, etc. In short,
your masterpiece might not sound like one! Note that Roland use something called the "GS
standard" which is a version of GM.

5.12 Chase Events

Cubase automatically deals with a problem which all sequencers face: you may have Tracks
containing Program Changes and start the sequencer, not at the beginning, but halfway through
the Arrangement: this means the MIDI devices don’t get the Program Changes that are located
earlier on in the song, so that it starts off with the wrong sounds. The solution is the "Chase
Events" function: go to the Options menu and enter a checkmark by that function. Cubase will
now comb the Tracks for MIDI commands prior to the position where you started the playback.
In a way, the program simulates what would have happened if you had started from the
beginning, and executes the previous commands. You can decide what type of MIDI commands
Cubase should search for.

Choose Chase Events from the Options menu. In the menu which now appears you can switch
Chase events on and off and designate which type of MIDI message Cubase should search for.
You might notrecognize all of these commands yet, but we’ll discuss them later on. Unfortunately,
you can only select one command at atime. You have to access the menu again for each new item.

Z Active

Note On
Controllers
Program Change
Aftertouch
Pitch Bend
Suskxn

Y MIDI Miser

RPN 8 NRPN

e S RS S

The Chase Events menu
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5.13 Other non-note events

The term "controllers” has become rather over-used in the MIDI world, and this is not helped by
Steinberg being equally vague within the software itself: in this book we attempt o rectify the
situation as follows:

_ "MIDI Control Change events" are the MIDI events that come under the MIDI Control Change
status byte: they do specific jobs such as modulation, sustain, volume and so on;

- "performance controllers" are the physical devices which produce these MIDI Control Change
events, such as a pitch bending wheel, sustain foot switch, volume pedal, etc;

- Cubase lumps all non-note events under the generic, unofficial title "controllers": its Controller
Display (see later in the manual) displays everything from velocity to Pitch Bend events. We are
forced to follow the same nomenclature in the book, but where possible we’ll make a distinction.

MIDI non-note events represent an interesting area of MIDI. They are the software equivalent
to faders on a mixing desk, or knobs on an analog synthesizer in that they carry out specific
functions of your MIDI device. Your synthesizer probably features several performance
controllers, such as a pitch bending wheel or joystick, a sustain or a volume pedal, etc.

On the face of it, performance controllers simply affect the synthesizer’s internal sound generator
and have, in principle, nothing to do with MIDL But at the same time their use can generate
different kinds of MIDI non-note events which can be transmitted to other devices.

Ideally, the receiving device should be able to support all kinds of MIDI information; this is not
always the case as many devices don’t have the necessary functions. Many drum computers, for
example, do not understand the MIDI Control Change event for Volume, so that if you send
volume commands from Cubase or your master keyboard to your drum computer, nothing
happens. Let’s take a closer look at the different types of non-note MIDI events.

5.13.1 Pitch Bend

MIDI Pitch Bend data is used to smoothly alter pitch values in the destination sound module. As
with note commands, Pitch Bend commands are MIDI channel-specific, so that a maximum of
16 instruments can be addressed. The same holds true for all MIDI non-note events. After all,
not too many players would appreciate it if their pitch bending efforts during a solo affected the
pitch of the entire Arrangement! A MIDI Pitch Bend event is similar in structure to a Note On/
Off event: a status byte is followed by two data bytes. The data format for all MIDI events islisted
in the appendix.

The human ear is very sensitive to pitch changes, so when laying down the MIDI standard the
manufacturers decided to use a higher-resolution pitch bending scale than the 128 steps used in
most MIDI applications. The purpose was to ensure that MIDI pitch bending sounds smooth, not
jerky. This is achieved by having the two data bytes interact, where each value in the first data
byte is divided into a further 128 values in the second data byte. This is how it works:

Value of 1st data byte = 1, is then subdivided by 2nd data byte (0 - 127);
Value of 1st data byte = 2, is then subdivided by 2nd data byte (0 - 127), etc.

Status byte » $En [1]1]1] O[n[n|n|n|
{stdatabyte 0O, $00,[0JoJofo]olol0l0] to 127, Yy Kl EEEIEIE
ond databyte 00, $00,[0] 0] 0J0[0[0[0[ 0] to 127, s7E oA A1 aT4[111]

Pitch Bend

This scale provides for aresolution of 16,384 steps. Combining two data bytes to achieve ahigher
resolution is called an "LSB/MSB combination”. The 1st data byte is the "Least Significant
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Byte", the 2nd data byte the "Most Significant Byte". The diagram above is shown in decimal,
hexadecimal and binary.

The status byte is the exception to the rule: its exact value is determined by the second nibble,
which includes the MIDI channel address. Its value can therefore vary between 1 and 16. The
variable "n" is used to illustrate this in the diagram.

In reality, very few devices support the "LSB/MSB combination", either when receiving or
sending, probably because there is a fear amongst manufacturers of too much data being
generated at one time, for little perceivable benefit. Most devices use the information in the
second data byte only, which gives a resolution of only 128. In practise, this seems to be fine.

5.13.2 Tuning

A few things should be borne in mind regarding MIDI Pitch Bend operations:

- The maximum range of the bend is determined by the receiving device. The MIDI Pitch Bend
events regulate iow far the pitch bends within the maximum range. If you have set the maximum
Pitch Bend to a value of 12 semitone steps in the receiving device, then the pitch increases by
an octave when you push the pitch wheel all the way up. Conversely, if you set the maximum
to a single (semitone) step, pushing the pitch wheel all the way up moves the pitch up by a
semitone. Later on, we’ll be looking at a more advanced method that enables greater pitch change
intervals.

- If your instrument is limited to a resolution of 128, and you set the pitch bend to intervals greater
than an octave, you will start to hear the individual steps in the pitch bend.

- Pitch bending can go down as well as up, so the 2nd data byte value when it’s at rest is 64, not
0. You will need to remember this when working with Cubase’s Editors.

- In some situations, the receiving device might not return to the resting value of 64 after it has
received Pitch Bend events, such as when you fast forward Cubase in the middle of pitch bending.
Itis then out of tune with the other instruments. If this happens, move the pitch wheel up and down
once and release it in the center position to reset the value, ensuring that the Cubase Track
containing the Pitch Bend data is active, so that you have selected the right MIDI channel.

Cubase offers a number of options in the MIDI Setup dialog box designed to avoid these types
of problems. They also apply to the other types of MIDI events we are going to discuss below.

MIDI Setup |

Reset parameters

The relevant MIDI Setup functions are:
- "Reset on Track Change" returns Pitch Bend, Control Change 1 (modulation) and Channel
Pressure (aftertouch) back to their resting values when you switch to another Track. What
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happens, for instance, if you go to another Track assigned to a different MIDI channel while you
are executing a Pitch Bend? The Pitch Bend gets stuck at the current pitch, and is notreset because
you are now on another MIDI channel. The reset function takes care of this for you, so avoiding
tuning problems.

_ "Reset on Part End" does the same thing at the end of each Part, and applies to the Pitch Bend,
Control Change 1 (modulation), Channel Pressure (aftertouch) and Control Change 64 (sustain
pedal) functions. If you are recording a four-bar Part, you don’t have to worry about placing the
performance controllers back to their resting positions at the end of the Part. If it wasn’t for this
function, the next Part might start out with all sorts of extra MIDI data you didn’t want, or at least
you would have to manually ensure that the above non-note data was all at rest before the end
of the Part, a time-consuming operation.

- "Reset on Stop" automatically resets Pitch Bend and all other non-note events and sends an All
Notes Off command over all channels as soon as you stop Cubase.

Although these parameters help to avoid a number of problems, you should use them with
caution. For example, let’s suppose you have activated modulation at the beginning of a long
Track and you want it to be active all the way through: if you change Tracks while Reset on Track
Change is enabled, the modulation would disappear.

5.13.3 MIDI Channel Pressure & MIDI Poly Key Pressure ("Aftertouch”)

Here are two more types of MIDI message that Steinberg lump together under the generic term
"MIDI Controllers" even though they each have their own, distinct status bytes. Furthermore,
Steinberg mis-name MIDI Channel Pressure by calling it "Aftertouch” in the program - in fact,
the term "Aftertouch” is the layman’s term applied to both MIDI Channel Pressure and MIDI
Poly Key Pressure.

So, both these types of "aftertouch” event are transmitted when you apply more pressure toakey
aftertheinitial strike (the initial strike provides velocity, additional pressure provides aftertouch)
and is detected by sensors under the keys. What effect aftertouch data triggers is determined by
the receiving device: you can choose volume changes, vibrato, or other similar effects.

A number of synthesizers and samplers offer at least the most common form of aftertouch, MIDI
Channel Pressure. It consists of a status byte and one data byte and is MIDI channel-specific,
which means that all the notes on a given MIDI channel are affected by the aftertouch data when
it is sent.

MIDI Poly Key Pressure takes this principle one step further. This is aftertouch which is key-
specific, whereby pressure on individual keys applies aftertouch to those notes only, not to all
the notes playing on that MIDI channel. Poly Key Pressure data consists of one status byte and
two data bytes. The first data byte designates the note number, similar to the Note On command,
and the second one the amount. Poly Key Pressure can transmit a heavy data load, so it is
advisable to use it sparingly.

The hardware required is not without its costs, so few devices send Poly Key Pressure; however,
there are some devices that will at least respond to it. Later in the book, we will have ample
opportunity to experiment with this data in the Cubase Editors.

5.13.4 MIDI Control Change events

Apart from the Pitch Bend, Channel Pressure and Poly Key Pressure messages we have just
discussed, MIDI offers a type of non-note event called MIDI Control Change which has 128
different channel-specific functions. Let’s look at them in detail.

These functions all share the same MIDI Control Change status byte. There are two data bytes.
The first data byte determines which one of the 128 functions is active, the second one gives its
amount.

Each function has an amount range of 128 (0 - 127). Control Change functions weren’t properly
defined during the early years of MIDI, which caused a great deal of confusion. MIDI Control
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Changes are basically nothing more than neutral transmitters of data; in theory, each of the 128
functions should have a defined job, but these jobs have never really been standardized, and the
effect they produce depends on the device being addressed. Over time, though, manufacturers
have agreed that certain MIDI Control Changes should have specific functions.

The following list contains the 128 Control Changes and their functions, where agreed:
Bank Select MSB

Modulation

Breath controller

not defined

Foot pedal

Portamento Time

Data Entry MSB

Volume

Balance

not defined

10 Pan

11 Expression

12,13 Effects Control Changes 1 + 2

14, 15 not defined

16-19 Multi-function Control Changes 1 - 4
20-31 not defined

Control Changes 32 - 63 are LSB for Control Changes 0 - 31 and so provide a higher resolution.

O OO~ W =O

64 Sustain pedal
65 Portamento
66 Sostenuto

67 Soft pedal

68 not defined
69 Hold 2

70-79 not defined

80-83 Multi-function Control Changes 5 - 8
84 -90 not defined

91-95 Effect Intensity 1 - 5

96, 97 Value Changing plus/minus

98, 99 non-registered parameters LSB/MSB
100, 101 registered parameters LSB/MSB

102 - 121 not defined

122 - 127 Channel Mode commands

In the early stages of MIDI development, MIDI Control Changes were divided into two
categories: "continuous" and "switch". These categories were based on the functions as
interpreted by the receiving device and not on the actual data format.

In general, though, it makes more sense to distinguish between Control Changes which can
almost double in resolution (mainly Control Changes 0 - 31 as MSBs and those which are
necessary to achieve this higher resolution, 32 - 63 as LSBs), and those with the standard 128
step resolution (Control Changes 64 - 127). According to the MIDI standard, these higher-
resolution Control Changes can be combined as MSB/LSB combinations to increase the
parameter range, rather like Pitch Bend, except that here two status bytes and two data bytes are
used.

In reality, however, with the sole exception of the Bank Select command we discussed earlier
in the book, hardly any manufacturer supports this option: those Control Changes which can
support the higher resolution use either the LSB or the MSB, so producing the standard 128-step
resolution. The Bank Select command consists of Control Changes 0 and 32 plus a Program
Change event.
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Considering that the Bank Select command makes it possible to select thousands of sounds and
that modern synthesizers are increasing in memory size, use of the Bank Select command’s
MSB/LSB combination would appear to be justified. Generally, though, contemporary devices
feature two to a maximum of ten banks of sounds, for which the LSB value remains at "0". This
means that only the MSB value, i.e. MIDI Control Change 0, is relevant, accompanied by a
normal Program Change message.

It would appear that the manufacturers cannot agree on how to interpret the standard here: some
Roland devices operate akind of "reversed priority”, using only the LSB values. The resultis that
Bank 1 of these devices relates to Cubase’s Bank 128, Bank 2 to 256, etc. Keep thisin mind when
you are setting values in the Inspector and watch how individual devices actually process the
data.

The decision not to support the theoretical high resolution available for the other Control
Changes is probably a good thing: if we assume that you use the a MIDI performance controller
to its fullest extent, this would produce 128 x 128 = 16,384 possible values: moving the
modulation wheel all the way to its end stop would almost certainly produce a data logjam in the
MIDI system (remember it’s serial) and maybe lead to timing delays.

Control Changes 64 - 95, which used to be called "switch” Control Changes, are used merely as
on/off switches despite their possible 128 step resolution. Since different interpretations led to
a great deal of confusion, the following 2nd data byte values have become standard: values from
0to 63 are "off", 64 to 127 are "on". Older instruments may interpret these commands differently,
forinstance 0 =off and 1- 127 =on, or0=off, 127 =on,and 1 - 126 are ignored. If you encounter
this type of problem, you can modify the data with the help of the Cubase Editors, the Logical
Editor in particular.

The registered/non-registered parameters represent a relatively new development. Here too
MSBs and LSBs are used for higher resolutions. These two types of Control Change were
developed as a response to the uncoordinated way manufacturers were using Control Changes.
Only a few Control Changes are defined by a specific function, e.g. Control Change 7 for volume,
Control Change 1 for modulation, etc. Manufacturers have been using the undefined controllers
for their own purposes, which would ultimately lead to a communications breakdown between
devices.

We have seen that a MIDI Control Change is merely a source of values with a specific address.
What happens at that address in the receiving device is determined by the receiving device.
Supposing a manufacturer decided that his device’s filter frequency should respond to and
transmit the undefined Control Change 25: this data would then be sent to another manufacturer’s
device, where it might affect a completely different function.

As a solution, the manufacturers agreed on the use of registered and non-registered Control
Changes. Non-registered Control Changes allow the manufacturer to assign functions as they see
fit, and possible incompatibilities are accepted. Registered Control Changes, on the other hand,
are only assigned after extensive consultation. The first registered Control Change is number 0,
which regulates Pitch Bend sensitivity. It allows you to remote control the Pitch Bend range.

Control Changes can produce a massive amount of data, so extensive use of them in realtime
situations is not advisable. Apart from the MSB/LSB Control Change values which merely
define the parameter, Control Changes 6 or 96/97 still have to be used to define the specific
values. This involves a huge amount of data - stage lighting may open up a new field of
application.

Control Changes 122-127havea special application. You canuse Control Change 122 to switch
your keyboard/synth to Local Control Off via MIDI. Control Change 123 gets rid of MIDI drones
by switching all notes off. This generally useful Control Change can cause problems: some
Roland synths send this command as soon as you release all the keys. Other devices may switch
their notes off in response to this command, even though this is totally uncalled for in your Cubase
Arrangement. You should filter this controller out in Cubase’s MIDI Definition box. Follow the
method described below.
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5.13.5 The MIDI modes

The remaining Control Changes are used to select the various MIDI operating modes. Some of
you may feel that these modes are anachronisms in an age of multi-functional, multitimbral,
polyphonic work stations. However, we’ll take a quick look at them for the sake of completeness.
The receiver can be set to any of four modes which determine how it will recognize voice
messages. The modes are set with two mode messages: Omni On/Off and Poly/Mono:

Mode 1 Omni On, Poly
Mode 2 Omni On, Mono
Mode 3 Omni Off, Poly
Mode 4 Omni Off, Mono

In Poly mode, the receiver assigns voice messages to multiple voices (more than one note) which
are played polyphonically.

InMono mode, the receiver assigns voice messages in a single channel just a single, monophonic
voice. For instance, if an instrument has six voices, it can simultaneously be addressed on six
different channels. It translates different information into different notes, i.e. one note per
channel. Mono mode does not mean that you can assign different sounds to each of these notes
- this used to be a popular misconception. Mono mode is now used primarily for guitar
synthesizers, where each string is assigned a different MIDI channel to enable pitch bending,
because MIDI Pitch Bend events are channel-specific. If all the strings were on the same channel,
and you bent a note, the Pitch Bend would bend all the notes that were being played at the same
time.

In Omni On, the receiver reacts to all data received, regardless of its MIDI channel. Obviously,
this mode is not very useful when working with sequencers. However, there are several older
instruments that operate exclusively in this mode, and some of them can offer some very good
sounds. If you want your device to react to one channel only, you either need a little add-on MIDI
filter device to filter out those channels you dont want it to react to, or you can employ additional
hardware such as Steinberg’s MIDEX which enables you to assign Cubase Tracks to specific
MIDI outputs. More on this subject later.

In Omni Off, the receiver reacts only to data that is sent on the channel to which it is set.

The four modes are therefore combinations of the above. To cut a long story short, Mode 3 (Omni
Off, Poly) is the mode to use whenever you are in a sequencing situation, and this book assumes
this is the mode you are in the whole time. The others are very rare.

5.14 Tip

Make sure you finish up by returning all non-note values back to zero via MIDI when you are
experimenting with the Cubase Editors. Otherwise, they may remain "active" and produce
undesirable effects.

The exception is MIDI Control Change 7 (Volume), whose resting value is 127 (maximum
volume). Remember that the resting values of Pitch Bend’s two data bytes are 0 and 64
respectively.

5.15 Problems

All performance controllers’ MIDI non-note messages have one thing in common: they produce
adeluge of data. We’ ve already given this subject a good airing, but let’s finish by taking a quick
look at what a single movement of a pitch wheel produces when viewed in one of the Cubase
Editors - and that’s not even using the higher resolution:
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<» File Edit Structure Functions Options Modules Windows
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——e——t=—t—-~= |1nz, MNote lquant 16 | 1. 1. 8
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2. 2. 9 ————- a 67 ——— Pitch-Bend 1
2. 2, 29 ————— 64 68 —--—- Pitch-Bend 1
2. 2. 36 ———— a 69 —-—— Pitch-Bend 1
2. 2. B3 ——- 64 69 ——— Pitch—-Bend 1
2 2. 86 ————— a 7 ———- Pitc 1
2. 2.11¢ ———— &4 78 ———- Pitc 1
2. 2.178 ————— a 71 ——— Pitc 1
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2. 3.133 -~———— 64 8% —-—- Pitch-Bend 1

A single upward movement of the pitch wheel in Cubase’s List Editor

MIDI tries to limit this flood of data with the aid of the "Running Status". It suppresses the status
bytes of consecutive MIDI events if they all share the same status. So, if you use, say, the
modulation wheel, its first event will have the status Control Change 1 followed by the channel
and amount data bytes, but all the subsequent stream of events will contain the data bytes only
without the status.

Running Status for a particular stream of events is cancelled as soon as a different status byte
interrupts, such as when a note is played in the middie of the modulation events described above;
but is renewed again whenever two events are transmitted that have the same status. This is the
reason why Cubase usually sends a Note On command with a velocity value of "0" instead of an
"official” Note Off command to switch notes off: it means notes all share the same status whether
they are being switched on or off, allowing optimum exploitation of Running Status.

However, this useful function also has a few drawbacks. Some devices require the use of Note
Off commands, and older ones have serious problems with Running Status communication. A
sure sign of this is when your instrument plays the first note only, and not the following ones.
It needs the status bytes ahead of the data bytes which the Running Status has filtered out. In this
case, switch Running Status off in the MIDI Setup dialog box.

trol 8 ¥
Control @ ¥
st ¥

outputld 3 |
7 RATARI -18 §
* MRODS

4 MIDEH 1

4 MIDEH 2
J/ MIDEH 3
/ MIDEH 4

Running Status settings
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Click and hold the arrow to the right of the term "Output"; in the pop-up menu that appears, switch
Running Status off for the output your device is on by dragging the mouse pointer down the menu
and releasing the mouse pointer when the correct output is highlighted. You can see that Cubase
apparently has more outputs then the Atari can offer. Additional hardware is required, and we’1l
discuss this later.

5.16 Tips on handling non-note MIDI events

Because the use of hardware performance controllers (e.g. the pitch bend wheel) or other means
of generating non-note MIDI events (e.g. the MIDI Mixer) can produce massive amounts of data
which needlessly clog the MIDI circuit, the only real solution is to use them as little as possible.
Aftertouch data (either type) is a continuing source of problems, and is often generated
accidentally. Cubase offers an elegant solution.

Again go to the Options menu and choose MIDI Filter. Two extensive data filters are listed with
which you can prevent specific MIDI data from being recorded and transmitted via MIDI Thru.
Click the desired filter, which highlights, meaning that it’s activated. Aftertouch data is usually
created inadvertently, and should not even be recorded in the sequencer. You should always filter
it out unless you really want to record this type of data.

You can filter out Note On, Poly Key Pressure and similar data over all MIDI channels, though
you can also do it on a per-channel basis, or even per-status basis, e.g. the "All Notes Off"
command. Simply click the desired MIDI channel or event type. A total of four freely definable
Control Changes can be filtered out using the right or left mouse button to select the desired ones
in the four boxes.

The MIDI Filter box applies to the MIDI input only so that this kind of data is not recorded. What
happens if undesirable data has already been recorded in a Part? Here, too, Cubase offers several
solutions.
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FPROGRAM CHANGE
PITCH BEND
13
[ 0K
The MIDI Filter

If you want to permanently remove the values delete them with "Logical Edit" or another Editor.
We’lllook at this in one of the following chapters. Another possibility is provided by the "Delete
Controller Data" command in the Functions menu ([Control][F]), which deletes all the selected
Part’s non-note MIDI data.
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The third option solves the problem without deleting data. The Part Info box (you came across
it in the previous chapter) contains a data filter that stops specific MIDI data from being played
back from Tracks or Parts.

The fourth method involves the "Reduce Controller Data" command, and itis a very useful one.
Tt does not delete MIDI controller data, it only thins it out. Usually, there is no audible difference,
but the MIDI data load is lightened.

Although early MIDI devices were limited in the type of non-note data they could produce,
modern devices, especially mother keyboards without internal sound generation, incorporate
user-programmable performance controllers, where you can designate which type of MIDI data
is created by a wheel, joystick, pedal etc.

Cubase provides an option for those instruments that are not able to do this. Let’s look at a
possible application: your master synthesizer features a wheel which can produce modulation
(MIDI Control Change 1) only. However, you would like to address the breath controller
function in a Yamaha FM sound module (Breath Controller is MIDI Control Change 2).

Go to the MIDI Setup dialog in the Options menu where you will find the "Controller Map". Set
the source to "Modulation”, and the destination ("Mapped To") to "Breath Control" using the
mouse. The modulation wheel now generates breath controller data.

The Control Change Map

Generally, you can redefine Control Change data as you wish, such as controlling MIDI volume
from the modulation wheel. This will not work if the receiving device is unable to interpret those
MIDI commands; in that case, even Cubase can’t help, not even with the use of foot pedals or
a mother keyboard’s clever programming.

Your devices’ manuals list the type of MIDI information they support, usually in their MIDI
Implementation chart. You don’t have to look for this chart in the Cubase manual - there isn’t
one - as it can record, playback and create every possible type of MIDI event.

5.17 System Exclusive data

So far we’ ve had a look at normal MIDI data, which is the communications medium for all brands
and models of MIDI devices. However, there is another type of data tailored to specific
manufacturers and instruments: System Exclusive (SysEx).

This type of data is used to transmit sounds and other device-specific data via MIDI. This enables
you to edit sounds in your instruments with the aid of a software Editor, or load sound data into
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the computer and store it on disks. Cubase can record and play SysEx data. We’ll run through
an exercise in the MIDI Mixer section.

Every device has a different internal architecture, so SysEx data has to have an open, flexible
structure. Only the beginning and end of a SysEx message is defined by the MIDI standard: what
comes in between is up to the manufacturer. A status byte marks the beginning of a SysEx
message ("FO" hexadecimal ("240" decimal or "11110000" binary)). Another status byte ends
the message ("F7" ("247","11110111")). Any number of data bytes, though no status bytes, can
be contained between those two status bytes.

The only other common characteristic is the manufacturer’s ID, which immediately follows the
first SysEx status byte. Any manufacturer can request, an exclusive ID number from the MIDI
Manufacturers’ Association, which is then listed in the second byte of a SysEx message.

Sound data can only be exchanged between MIDI instruments with identical sound structures.
You cannot exchange sound data between different instruments, such as between a Roland JD-
800 and a Yamaha SY99. One reason is that the Yamaha device needs data to define its various
FM algorithms, a concept which doesn’t exist in the Roland synthesizer’s sound generation
system. You can send data between the Yamaha device and the JD-800 via MIDI, but neither will
respond to the messages.

The reason for this is as follows: the SY99 sends a status byte ("FO"). The Roland synth registers
the message and stands by for SysEx data. The next data byte contains the Yamaha ID code. The
JD-800 recognizes the code as alien and ignores all subsequent information. You could try to
send SY99 data to another Yamaha model such as a DX7. Itrecognizes the Yamaha ID code, but
the ID number of the synth model is listed next in the SysEx message, so the DX7 also ignores
the message. Manufacturers always use a model ID number, even though itis not strictly required
by the MIDI standard.

So what happens when SysEx messages are exchanged between identical or compatible models?
The SysEx status byte with its ID bytes is called the "Header" in SysEx jargon, and is followed
by the data bytes. Once the destination instrument accepts the Header, it then assigns the
information to its sound parameters as defined by the data bytes; in other words, the sound
settings are transmitted.

In contrast to most other types of MIDI data, SysEx messages are not MIDI channel-specific.
However, some manufacturers assign internal channels, so you might run into communication
problems even between identical devices. As a precaution, use the "Any" Track channel setting
when playing back SysEx messages from Cubase. You shouldn’t mix sound data SysEx and
notes on the same Track. Some devices can transmit "Parameter Change" SysEx messages while
you make changes directly at the instrument (e.g. the movement of a cutoff slider on the Roland
JD-800); these can be recorded by Cubase and played back. For this to work you must ensure you
have not activated a Cubase filter to block SysEx messages.

In general, SysEx is a complex subject matter; we’ll be dealing with it again when we work with
the MIDI Mixer. Until then, please avoid working with SysEx or you may accidentally delete
or change sound data, and then where will you be...!

5.18 Specialized MIDI knowledge

This chapter covered the basic MIDI subject areas. Specialized functions such as sound data
exchange, synchronization, and how to deal in detail with SysEx data will all be discussed in later
chapters. You will find a detailed technical listing of the MIDI data format in the appendix.
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6 Data Management

Cubase features a number of ways you can administer your songs, Arrangements, etc. on floppy
disk or hard disk. This chapter covers all the relevant information you’ll need.

6.1 Saving and loading

In a previous chapter we looked at the method to save and load Arrangements to and from disk.
Let’s quickly review this information and then take an in-depth look at the subject. Everything
you record in Cubase is lodged in your computer’s memory. However, this memory is volatile,
and once the power is switched off or interrupted in any way, the datais lost. So before you switch
the power off, you have to store the data permanently. The medium for this is either a floppy disk
or a hard disk.

The first chapter gave you a basic understanding of disk operations. Data is stored on disks in
file form. A file is a self-contained unit of data which can be recognised by Cubase.

You will know by now thatloading and saving data basically always starts with the same routine:
choose Open in the File menu ([Control]{O]) to load a file, or Save ([Control]{S]) to save a
Cubase file to a disk. A dialog box then appears asking you what you want to save. We will look
at the difference between the listed entries in a moment. Click the desired entry or press a number
between 1 and 8 on the alphanumeric keyboard (not the numeric keypad).

The Open dialog box on the left, Save dialog box on the right

At this point the Atari Item Selector appears, showing you the disk’s contents. Enter a name of
up to eight letters and press [Return] or click OK.
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FILE SELECTOR

Directory:
C:h*.ARR
selection: _______
ODRIVE:
e ) -
o 1]
DAMCE .ARR E F
DEF .ARA & i
HOUSE .ARR i 4
____________ K i
____________ M M
____________ i3 i

I ) o]

cancel

The Atari Item Selector (TOS 1.4)

There are a number of ways to select a file:

- Double-click the desired file in the Item Selector’s directory list. If the disk contains many files,
use the scroll bar to scroll through the list until you find the one you want; ot

- click the file in the list once (it is highlighted), and press [Return] or click OK; or

- if you know the name of the file, type it in the selection line and press [Return] or click OK.

If you are loading a file, any of the above operations will load the file into the computer’s RAM.

6.2 Working with disks - tips and tricks

We have already talked about disks ona number of occasions in this book. You will not find disk
operations difficult; nevertheless, some musicians may be computer novices and may run into
small problems, which we will discuss now. Feel free to skip this section if you are at home with
disks, and consult it later if you do encounter problems.

- Neverremove a disk from the disk drive when the drive indicator lamp is illuminated - you may
destroy data.

- If you attempt to load or save data, but have not inserted a disk, the computer will warn you.
Insert the disk and confirm with the [Return] key.

- If you can’t find the file you want in the disk directory, you may have inserted the wrong disk.
Remove it and insert the correct one. Click the speckled title bar of the Item Selector’s directory
list. The directory of the new disk is then displayed.

- If the disk contains more files than can be displayed at one time, click the up/down scroll bar
arrows and scroll through the directory.

- If you have entered a name consisting of more than eight characters during a save operation,
Cubase automatically removes the extra letters. This may lead to a problem. If you named a file
"SAVEFILE1", Cubase removes the 1 because of the eight character limit. If you later attempt
to save a file as "SAVEFILE2", Cubase removes the 2, and looks to see if there is already a file
bearing the same name. It finds the first one, and as the computer cannot save different files
bearing the same name to the same disk, Cubase asks you what it should do.

- Youare given three choices. "Replace” deletes the original file and saves your new Arrangement
as SAVEFILE. "Backup" renames the original file under the same name, but with a new
"extender" (see below). The option "Cancel" allows you to exit the Item Selector without saving
the file.
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FILE EHISTS!

Replace| | Backup | | cancel |

A file bearing the same name already exists on disk

Cubase adds an "extender" to each file name. It consist of three letters, and Cubase always
automatically adds a period and an extender to the end of a file name. The type of file dictates
which letters are in the extender. More on this in a moment.

Cubase automatically changes the original file’s extender when you use the backup function
described above.

The extender tells Cubase what type of file it is dealing with during disk operations, and tells the
Item Selector to display only those files of the same type as the one being saved/loaded etc.
During load operations, for instance, not all files on the disk are displayed, only those you can
actually load: forinstance, if you want to load an Arrangement, Cubase displays the Arrangements
on the disk with their respective extenders, and not songs, setups, etc, nor even backup files, even
though they may be on the disk.

The extender is displayed in the Item Selector’s pathname line (under the word "Directory") and
in its directory lists’s speckled title bar.

To display all the files on a disk, irrespective of their extenders, click in the pathname line: delete
the three extender letters using [Backspace], and type in a [*]; follow this by clicking in the
directory list’s speckled title bar. However, bear in mind that if you have told Cubase you want
to load, say, a song, you cannot then select and load an Arrangement, etc.

Although you cannot save files of the same name and extender on a disk, you can save two files
with the same name whose fypes are different: these are distinguished by the extender.

__ Desk File View Options

26224 butes used in 11 items.

ABEAT «PRT ALLS .ALL DAMCE « ARR HOUSE « ARF M1.DRM MUMU . ARR OFFEBEAT .FRT
RE .ORM Y DRM

SILEMCE.ALL TRAMNSFER .MID

[

A comparison between those files actually on a disk...
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Directory:
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...and those displayed under "Song" in the Item Selector

6.3 The various Cubase file types

Cubase allows you to save and load various configurations and files. Let’s take a closer look at
these. A basic understanding of the different file types is essential to load and save operations.

6.3.1 DEF.ARR

At the beginning of the Arrange chapter, we discussed the ability to tailor Cubase to your needs.
We’ll cover this first.

Set up a working configuration that you want Cubase to have when you start the program; this
can include:

- the metronome (monitor click and MIDI), Part Appearance,

- the count-in ("Precount"),

- the Tracks’ respective MIDI channels in your order of preference,

- the MIDI channel names,

- the locator positions,

- the Transport Bar settings (record mode, tempo, etc.).

DEF.ARR saves a lot more settings than the ones mentioned above, such as those from other
areas of the program which we’ll be coming to later.

Save this default Arrangement under the name "DEF" on your backup copy of the program disk.
. You may first have to delete a file bearing the same name which is already on the disk: choose
Delete Files from the File menu and double-click the file to be deleted or click it once and press
[Return]. Cubase asks you if you really want to delete this file: click "Yes", and the file is
permanently deleted (click "No" or press [Return] to cancel the Delete Files operation).

Now, whenever Cubase is booted, it looks for the file DEF.ARR and loads it automatically.

If it suits your way of working, DEF.ARR can contain recorded Parts as well. For instance, it
could be useful to have the computer load the drum groove that you always use to kick off the
basic Arrangement. Whether or not DEF.ARR contains settings only or notes as well is
irrelevant: the important thing is that the file be correctly named "DEF".
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Using the same principle, the name "DEF" can be used with all the following extenders to provide
default start-up configurations, which the program will look for and automatically load when
booting.

Tip: To create a DEF.ARR file from an existing Arrangement without saving any of its musical
Parts, use the following trick: select all the Parts of our basic Arrangement ([Control][A]) and
press [Backspace] or [Delete]. The Parts are gone. Ensure you have inserted the right disk. Press
[Control]{S] and then [2] on the alphanumeric keypad (i.e. you are saving an Arrangement). In
the Item Selector, enter "DEF" and confirm with [Return]. If another file bearing the same name
already exists on the disk, Cubase will make you aware of this. You can overwrite the file, or tell
Cubase to change its name. After the file is saved, you are back in the Arrange window. Press
[Undo] and your Parts reappear, but have not been savéd on disk.

Note: ensure you follow the above steps in the same sequence, otherwise you may not be able
to recall the Parts with [Undo].

Delete your basic Arrangement after this little diversion as we’ll load it from disk when we need
it again.

6.3.2 Song (extender .ALL)

A Song saves or loads the complete memory content of the computer. This can include up to 16
Arrangements with all their respective settings (e.g. Groups). Loading a song deletes everything
else in your computer’s memory such as Arrangements, Groups, etc., even if you abort the
operation and do not load the song. Cubase will ask you if you really want to do this.

6.3.3 Arrangement (extender .ARR)

An Arrangement saves the currently active Arrange window, or loads one of your choice. The
name you enter when saving is assigned to the window, and it remains on your screen after it has
been saved. The window size and its position on the screen are saved as well.

When you load an Arrangement, you are presented with several options after which the
Arrangement appears on the screen. The Arrangements that were on your screen before are not
gone, but covered up. Activate Tile Windows, or modify the window sizes to meet your needs.
The Arrangement you have just loaded is immediately active.

Basically, all save and load operations can be executed while Cubase is running. A newly loaded
Arrangement replaces the current one. You have the option to stop this from happening, as it
could be annoying in live gig situations: press and hold [Alternate] while the sequencer continues
to run. Load in the usual manner. After a while, a dialog box will appear with two options:
"Replace” does what it says and replaces the current Arrangement that’s playing with the new
one; "Background" loads the Arrangement but holds it in reserve - you can call it up when you
need it from the Windows menu. The current Arrangement continues to run.

Do you want to replace
the current arrangement ?

| REPLACE | |BACKGROUND |

Replace or Background

Arrangements can be loaded while the sequencer is running, which avoids embarrassing delays
on stage, provided your computer has enough memory available. If you try to load an
Arrangement and you’ve run out of memory, Cubase will alert you to this fact. You must then
abort the loading operation, but your current Arrangement continues to play.
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6.3.4 Part (extender .PRT)

Parts can be saved individually and in an Arrangement. All selected Parts are saved. If no Parts
are selected, Cubase saves all the Parts of the current Track.

The following rules apply to loading Parts from a disk: Parts are inserted into the Arrangement
at the left locator’s position. Their relative positions are maintained, as are their original Track
assignments. If the current Arrangement contains fewer Tracks than the one from which the Parts
originated, the missing Tracks are automatically created.

6.3.5 Setup (extender .SET)

In principle, a Setup is the same thing as a DEF.ARR file, with the difference that no Parts are
saved in it, so no Arrange window is generated during the loading operation. You can even load
a Setup into an existing Arrangement.

The "Drum Map" and "MIDI Mixer Map" options in the Save/Open dialog boxes are covered
in the chapters on Editors.

6.3.6 Converting other formats

Apart from the normal loading and saving operations of Cubase-specific data, it is possible to
load and save other formats as well.

Have you ever worked with Cubase’s predecessor, Pro-247 If you have, you can load its songs
directly into Cubase using the "24 Song" option in the Open File dialog box. Due to the difference
in program structures, some of Pro-24’s song parameters are not converted to the Cubase format.

If the Pro-24 song was synchronized to tape in any way, you willhave touse a special conversion
routine on it: the chapter on synchronization has all the details.

6.3.7 Standard MIDI Files

The MIDI standard includes a special format which allows disk-based data to be exchanged
between different sequencers: the Standard MIDI File Format. It is supported by Cubase.

Arrangements saved as MIDI Files can be transferred via disk to another program (not another
Cubase), provided the other sequencer can read this format. First you have to save the Cubase
Arrangement you want to transfer as a MIDI File. Then you can load it into another program as
described below. The process of course works in the opposite direction as well, i.e. from another
program to Cubase.

The program does not necessarily have to be an Atari ST program. Other computers support a
number of programs that can read and write MIDI Files. Bear in mind, though, that other
operating systems use different disk formats; for instance, the ST cannot directly read an Apple
Macintosh disk. The disk must first be formatted using MS-DOS (a format that both the Mac and
the ST can read); you then save the file in the Macintosh using the Apple File Exchange program
onto that MS-DOS disk. The Atari can read MS-DOS-formatted disks. MS-DOS computers can
read Atari ST disks only if formatted by Atari operating system TOS 1.4 or later.

If you want to add material to a hardware or software sequencer that cannot write MIDI Files,
you have to go the synchronization route. More details on this later in this chapter.

Let’s try some practical applications with MIDI Files. The MIDI File standard is designed to be
a communications medium between the most diverse systems, so the manufacturers agreed on
the lowest common denominators, which means there are limitations of which you should be
aware. A Cubase MIDI File saves:

- the active Arrangement only, not complete songs with several Arrangements,

- the contents of all the recorded Tracks. All the Parts of a Track must be connected, and this can
be done with the Glue tool,

- the tempo, Track name and time signature.
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Save the Cubase file not as a song or an Arrangement but as a MIDI File. Cubase automatically
assigns the extender ".MID". Transfer this file to another program, bearing in mind you may have
to convert the disk format as mentioned above with the Mac.

Cubase always saves MIDI Files using Format 1 (see below), if you only recorded data on a single
Track.

You can also load other programs’ MIDI Files into Cubase. Choose Open from the File menu,
and then the MIDI File entry. Cubase asks you what it should do with the MIDI File you want
to load. If you want to create a completely new Arrangement, select "No" ([Return]). If you want
to merge the MIDI File with the current Arrangement, click "Yes": the data in the MIDI File is
inserted in the current Arrangement, starting at the position of the left locator.

Do you want to merge
the midi file into
current arrangement 7

no | |vEs |

Loading MIDI Files

It is important to know that the MIDI standard includes two types of MIDI Files: Format 0 saves
all data on one single Track. Format 1 generates as many Tracks as there are MIDI channels in
the Arrangement.

Here’s a brief look at what steps Cubase takes when loading MIDI Files:

6.3.8 Loading Format 0 files with merge:

Beginning at the left locator, Cubase inserts a Track containing all new information on Track 1.
It adopts the current Arrangement’s Track name, tempo, time signature and MIDI channel. If
other Parts already exist at this position, they are covered up, but not removed.

6.3.9 Loading Format 0 files without merge:

Cubase creates a new Arrangement containing one Track which contains all the new data. Its
MIDI channelis setto "Any", which means that the events’ original MIDI channels are honoured.
Tempo and time signature are also adopted from the MIDI File. To regain the original separate
Tracks that existed in the donor sequencer, you’ll need to "remix" the Track. We’ll take a look
at this process in a moment.

6.3.10 Loading Format 1 files with merge:

Cubase inserts as many Tracks as are contained in the MIDI File with all their new data, starting
at the left locator. The current Arrangement’s Track name, tempo, time signature and MIDI
channel are maintained.

6.3.11 Loading Format 1 files without merge:

Cubase creates a new Arrangement containing as many Tracks as the MIDI File contains. Their
MIDI channels are set to "Any", which means that the events’ original MIDI channels are
honoured. Track names, tempo and time signature are also adopted from the MIDI File.
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Remix and Mixdown

V4 Special Functions

7.1 Remix and Mixdown

If you have created a new Arrangement on a MIDI File in Format O (one Track contains all the
data), you are confronted with a problem. You can play the song as usual and you can hear all
notes on their respective MIDI channels, so long as the Track’s MIDI channel is set to "Any" but
you cannot manipulate individual instruments. The Remix function, which also has wider
applications in Cubase, is the answer. You may not have a MIDI File in Format O handy, so we
will use a different route and create a similar Arrangement for this exercise.

Delete any remaining Parts from your Arrangement and record new ones in two to four Tracks,
about twelve bars in length will do. Your recording should look something like this:
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A demo recording

Now we’ll mix the Tracks together to form a single Track. Select an empty Track located above
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or below your Tracks. Set the locators to the start and end of the Parts. Execute the Mix Down

command in the Structure menu. After a moment, a Part entitled "Mixdown" will appear in the
Track you have selected.
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Delete all the Parts with the exception of the new Mixdown Part. Set this Track’s MIDI channel
to "Any" and listen to the result of your efforts. All the Parts previously held in several Tracks
can now be heard on this single Track. Before we carry on working with this Track, let’s briefly
discuss a few things about the Mixdown function.

You can use this function for other Cubase applications, such as where you have run out of
Tracks, or you want to mix certain Parts and Tracks together. The exercise above shows you how
easy this is. However, keep the following in mind:

- All Tracks that are not muted are merged together on the selected T k.

- Cubase only merges the bit of your Arrangement that is framed by the locators, allowing you
to merge portions of Tracks. Try it! Create two new Tracks 16 bars long. Set the locators
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somewhere in the middle of these Parts, say bars 5 to 9 and execute the Mixdown command. You
have now created a new Part that contains bars 5 to 9 of the source Tracks.

- The data’s original MIDI channels still apply. You must set the Mixdown Track’s channel to
"Any" to be able to hear these.

- You can happily delete the original T ks because they are easily recreated.

- The play parameters of the individual Tracks and Parts are now permanent components of the
new Track. You can no longer reverse them in the Play Parameter box; for this, you must use
Cubase’s various Editors. Consult the appropriate chapter in this book for what needs to be done
in this sort of case.

Move the Mixdown Part you have created to Track 1. You have just simulated the loading of a
Format 0 MIDI File (a single Track containing several merged MIDI channels-worth of data).
Recording from a sequencer without the MIDI File capability gives you the same result, as would
playing a mother keyboard which is able to transmit on several channels at once.

T separate the data according to the individual MIDI channels, follow these steps: select the
T ck you want to split up, mark the section with the locators and execute the Remix command
in the Structure menu. Cubase generates a new Track and new Parts for each MIDI channel in
the source Part. The Tracks are automatically assigned to the correct MIDI channels.

You should follow this by deleting the original Mixdown Part, otherwise its notes are doubled.
If the Track or Part you want to split contains only one MIDI channel, then it’s plain that you
cannot Remix it.

7.2 Useful: the Preferences

The File menu contains some very handy functions. Format Disk is used to format brand new
disks. The formatting is executed in the standard Atari way, and is largely self-explanatory. You
can also use it to format disks that have already been written on, though this deletes all the data
on the disk.

The Preferences dialog box is accessed from the File menu, and contains even more useful items.

KEY |&

0K

The Preferences dialog box

7.2.1 Auto Save

It is advisable to save your work at regular intervals. Although Cubase is a safe and reliable
program, one can conceive of a number of situations where you can lose the results of your
efforts.

Cubase features a neat way of saving your data regularly. Activate Auto Save in the Preferences
box and enter an interval of between two and 30 minutes. Cubase then automatically saves the
current song as BACKUP.ALL at the intervals you have specified.
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7.2.2 Mouse Speeder

The Mouse Speeder does what it says: it controls the speed of the mouse. Different values make
the mouse pointer move slower or faster than usual across your screen. Switch it on and change
the values. The mouse pointer moves faster at "2" than at "1", even though you are moving the
mouse at the same rate. This can be helpful when you want to move from one screen corner to
the other, especially if you have a large-screen monitor.

You may run into problems when you have to move only short distances on the screen, such as
when you are moving or copying Parts. The mouse pointer may move too fast to position them
accurately. The Threshold Factor provides a neat solution. It determines the point at which the
mouse is accelerated: move the mouse slowly and the pointer will also move slowly, move the
mouse more rapidly and the pointer will pick up speed. Set the Threshold Factor to a value you
feel comfortable with.

7.2.3 Additional options

In Cubase, you usually use the left mouse button to reduce values, the right one to increase them.
You can reverse the assignments if you are accustomed to another program’s clicking. Simply
click "Increase By Left Mouse".

"Use Crosshair Cursor" changes the mouse pointer’s appearance. This is useful for more precise
positioning operations such as when you are copying or moving items. We’ll leave the "DClick
Options" to the chapters on Editors.
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7.3 Multirecord

Until now, you have played on one Track at time and pieced your Arrangement together Track
by Track. However, you can also record several MIDI channels simultaneously or successively
on a single Track (set the Track’s MIDI channel to "Any"). This usually entails some additional
processing afterwards, in that the Track has to be split up according to its MIDI channels with
the help of the Remix function.We encountered this when we were discussing the transfer of
MIDI Files.

Again, if you record from a sequencer lacking the MIDI File option, the same method applies
(see the "Synchronization” chapter). If you have several synthesizers at your disposal, or one that
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Multirecord

can transmit on several MIDI channels at the same time (e.g. a MIDI mother keyboard), you can
address them all simultaneously "live".

The Multirecord mode is available for this and similar applications. Before going into details,
choose Multirecord from the Options menu. In the dialog box that appears, enable "Active". The
Multi-Player mode is now active, and anew column with the heading "R" appears on the Arrange
window.

Edit Structure

<> File

" HMou s= ‘
A M IS |T [R |Track Chn [
Fy Track 1 1
Fy Track 2 2
Py Track 3 3
= 4 i 4
idi b i Tearlk 5 =

The new "R" column

The Multirecord menu features four different operating modes. These four options can also be
selected in the Options menu. The function with the checkmark is the active one. If you want to
change a function, click the desired one: "Merge" is the normal recording mode. A maximum of
four Tracks can be addressed by the Multirecord mode. To allow this, click any four Tracks in
their respective "R" column slots; they do not have to be neighbouring Tracks. Depending on the
operating mode, symbols or numbers will appear in the column; these denote that the Track is
in Multirecord mode, and in some cases, enable additional options. Track assignment is
absolutely essential. If you don’t assign at least one Track to the Multirecord mode, you can’t
record.

Active

+ Merge
Channel Split
Input split
Lauer

The Multirecord menu

Now you are probably wondering what exactly the Multirecord mode does. Its advantages and
applications are best demonstrated with a number of practical exercises:

Delete all previous recordings, enclose four bars with the locators, and activate Cycle mode.
Select the Multirecord mode "Channel Split". Multirecord mode must, of course, be active.

For the following exercise, your master synthesizer must be capable of sending information on
at Jeast two different MIDI channels. Set your synth so that it transmits one sound on Channel
1, and another on Channel 2, such as bass on the lower half of the keyboard, piano in the higher
registers. Ensure that the sounds are not just addressed internally, but also sent to Cubase via
MIDI as two separate channels. Otherwise, you will not be able to see what exactly happens.

Click the "R" column of Track 1. A pop-up menu appears: select the following setting: 1, 5, 9,
13. Do the same for Track 2, but select 2, 6, 10, 14. You have just determined which of the
incoming channels are assigned to which Cubase Track. Start recording and play a Part.
Obviously, both sounds should be recorded at the same time.
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The pop-up menu in the R column

Stop the recording: Cubase has generated two Tracks. The first contains the data of MIDI channel
1, Track 2 the data of MIDI channel 2. Mute one Track and then the other for audible proof. If
you are keen on playing Parts and Tracks in a single take with an instrument that can transmit
on several MIDI channels at once, this Cubase feature will be of immense help to you.

The Track’s channel setting doesn’t matter. You can change it and reassign the MIDI channel.
If you want to return to your original assignment, select MIDI Channel "Any" or the channels
you actual used, in this case 1 and 2. All other functions, e.g. Cycle, Overdub, etc. are also
available in the Multirecord mode.

7.3.1 Tip: using ready-made accompaniments

The Channel Split option is designed for those who like to work with accompaniments, such as
those used in domestic "contemporary keyboards" or similar devices. Let’s look at one of the
popular devices, the Yamaha QY 10, although the Yamaha only serves as an example: this
function works with all of these sorts of devices.

Connect the QY10 (or any other similar device) MIDI Out to your Atari’s MIDI In. Select
Multirecord and the Channel Split operating mode. In the "R" column, assign different channels
to Tracks 1 through 4 (Track 1: 1, 5,9, 13; Track 2: 2, 6, 10, 14, etc.). Set their MIDI channels
to "Any". Cubase now adopts the QY 10’s MIDI assignments. If you already know how long you
want the Pattern to be, place the locators at the desired positions, which means you immediately
have the correct length and don’thave toresort to any cutting operations. Youdon’t require Cycle
mode or similar functions. Select the pattern you want to transfer in the QY 10. It would seem
that you are now ready to record. All you would need to do is to just start Record mode in Cubase,

and the playback of the QY10.

However, you would probably encounter several problems. Play and record operations are not
"in sync": the tempos of Cubase and the QY 10 don’t precisely match, even if they both display

the same tempo value. Synchronization is called for, and MIDI makes it possible. Choose
Synchronization from the Options menu: a wide-ranging dialog box appears.

The Synchronization dialog box
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For the moment, we are only interested in "Tempo Sync". Click and hold the arrow pointing
down, located to the right of this term. Select MIDI CLK and exit the dialog box by pressing
[Return].

onization

Activating the MIDI Clock

Now click SYNC (keyboard: [X]), located at the righthand end of the Transport Bar. We have
now carried out all the preconditions for recording. Click Cubase’s Record button. Cubase
switches to record status, but does not actually start. It won’t begin until you start the QY10’s
pattern. Do so, and the QY 10 pattern is recorded in Cubase. Stop the QY 10 after the pattern has
run through once. Go back to Cubase, switch SYNC off and listen to the recording. Cubase has
recorded the QY 10 pattern on four individual Tracks, divided into bass, drums, and two other
instruments. You can edit the Parts as usual. Here are a few guidelines:

- If you leave the MIDI channel settings at "Any", then Cubase adopts the QY 10’s MIDI channel
assignments. You can, of course, reassign channels as you please, and recall the original settings
at any later stage via "Any".

- The above method is not limited to the QY 10. It can be extended to other devices, provided they
are capable of sending their accompaniment patterns via MIDI and support the MIDI clock
required for synchronization. You may have to switch on the MIDI clock of your donor synth
before proceeding - see its manual for instructions.

- Do not use Cycle mode as you could end up with doubled notes.

- Even if you synchronize the two, you may still get little movements in timing due to things like
the tempo of the donor device being too high for the amount of data being transmitted. This data
recorded by Cubase tends to be around 1 - 3 ticks late, which is normally not a problem. If this
bothers you, carefully apply some quantization. You should acquire a solid background on
quantizing before you try things like this as it is all too easy to delete the finer details of the
recorded pattern. In any case, consult the chapter covering quantizing for more information.

- You can reduce problems by reducing the tempo before recording. You can then speed the
pattern up to its original tempo for playback purposes. Further tips on synchronization and
recording can be found in chapter 17.

- The above method is limited to recording on four channels. If your accompaniment device sends
data on more than four channels at the same time, record the pattern on a single Track, with the
same synchronization procedures. Ensure that this Track is setto "Any", and that the Multirecord
mode is not active, then "Remix" the Track.

7.4 Input Split

This allows several keyboards, drum machines, MIDI, etc. to be recorded simultaneously in a
live situation.

You need additional hardware if you want to use this Multirecord operating mode. Steinberg’s
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SMP 24 or MIDEX give you two additional MIDI inputs; add the Atari MIDI input, and you have
three input ports through which you can record simultaneously. Once you activate MIDI Input
Split, incoming signals are assigned to three Tracks via use of the "R" column. However, you
should consult the M*¥ROS chapter for some important guidelines before you try this mode.

7.5 Layer

In the Layer Multirecord mode, Cubase routes incoming MIDI commands to four selectable
MIDI channels simultaneously. It means you can create stacked sounds from several sound
modules even if your master synthesizer doesn’t transmit on more than one channel at a time.
Activate the desired Tracks in the "R" column and select the MIDI channel you want to use.

Let’s assume you activate Tracks 1 through 4 - assign them to channels 1 through 4 respectively,
and play on MIDI channel 1. While you play, Cubase duplicates the information it receives on
MIDI channel 1 to MIDI channels 2, 3 and 4, and sends them to the output. That way you can
controlup to four different devices in realtime. Atthe same time, the information is simultaneously
recorded on the four Tracks you’ve selected.

Keep in mind that every note you play is generated four times. Memory limitations may dictate
that you use a different method to create layered sounds, such as the method described in the
Arrange chapter for creating Ghost copies.

7.6 Remote control

The list of useful little details that make Cubase so easy to work with is not yet complete. There
are quite a number of sequencer functions you can carry out from your MIDI keyboard which
mean you don’t have to touch your computer to execute recording and playback functions.

Go to the Options menu and select Remote Control. Click the Remote Active box to enter a
checkmark.

The remote control function is now active. Exit the dialog box by clicking OK ([Return]). You
can also simply press [Y] to activate or deactivate the remote control function, provided you are
not in its dialog box at the time.

The remote control is designed to be very user-friendly. Press and hold the C6 key. If no
transposition function is active, then this key is the highest note on a five-octave keyboard. Press
the A#5 key while holding C6 down. Cubase starts playback. Stop the sequencer by pressing C6
and BS5 together.

Remote Control settings
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By pressing and holding the C6 key (the "Remote Key"), you are letting Cubase know that a
remote control command is on its way, as defined by the next key press. The available commands
are listed in the dialog box shown above. Remember to press and hold the C6 key first, as without
this command the keys below the C6 play normally. Avoid using this key when you are in Remote
Control mode since you may accidentally stop the recording or alter something.

You can tailor the key assignments to your preferences: the Cubase defaults are just an example.
Use the mouse to change key assignments in the dialog box, making sure that you don’t assign
the same key to two functions.

MIDI data other than note events can also be used, such as Control Changes. Click and hold the
arrow pointing down adjacent to the Note field. You can now use Control Change or Program
Change commands for remote control. The number on the left defines the command.

Although use of the Remote Key is intended to avoid confusion between remote commands and
normal note playing, there can be problems when you play chords in the upper register. If your
keyboard has more than five octaves, it is easier to define a region of your keyboard that your
playing doesn’t interfere with. It makes sense to use Control Change messages that are never
otherwise used, but take care not to run out of functions. Consult your master synthesiser’s MIDI
Implementation Chart to find out which Control Change messages are generated and used.

7.7 The Notepad

The Notepad provides a simple but very useful additional function as it allows you to type in
comments and such like. Call up the Notepad from the Edit menu ([Control][B]). There is no
"word wrap" function so you have to press [Return] at the end of each line. [Backspace] deletes
characters before the cursor.
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The Notepad

The cursor keys on your computer keyboard are used to move from line to line or between
characters. The Notepad has a number of pages which are accessed by clicking the ">>>" and
"<<<" buttons. Once you have finished your typing, click Exit. Each Arrangement has its own
Notepad.

7.8 Modules

* When you start Cubase, all the necessary data is loaded into the computer’s memory or "RAM"

(Random Access Memory). All activities take place in the RAM, including your recording. As
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the RAM is not buffered by a battery, its contents are Jost when the power is switched off or
otherwise interrupted. This is why you have to save your work at regular intervals, and load
Cubase every time you start.

Every computer’s RAM is limited; for instance, the Atari ST usually comes with one megabyte
(MB). Much of this MB is taken up by the program; what’s leftis available for your data, i.e. notes
and other MIDI events. Cubase’s increased performance specifications take its toll on the
available memory. The program uses more memory, at least when you use all of its functions.

To allow Cubase to be workable in a single MB environment, Version 2.01 had the option of
removing components of the program. Cubase 3.0 has become even more flexible in this respect.
As well as providing the basic functions, it has an "interface" which allows you to "plug" in
additional modules. This means you can load and remove certain program components to and
from the memory as required. Not only do you make best use of the available memory, you can
also upgrade the program with more modules.

The basic Cubase package comes with four modules: the Score Editor, IPS, the MIDI Mixer and
the MIDI Processor. Additional modules such as Styletrax and Cuetrax are available as optional
extras. You can load any of these modules at any time. You, of course, require more memory with
each additional module: you cannot, for instance, load all fourinto a single MB computer atonce.
If you want to use several modules at the same time, you have to increase the RAM. The Atari’s
RAM can be easily and inexpensively up graded - please consult the appendix for additional
information.

7.8.1 Operation

All modules are inactive when you install Cubase. This makes sense, as users have varying
requirements and varying RAM.

Modules
Modules. ..

MIDl Processor...
Phrase Sunth...
Copy to Phrase...

Selecting the Modules dialog box

The Modules menu heading is used to activate modules. Choose Modules from the Modules
menu. You cannot do this from inside an Editor. The dialog box appears for the inputting of
commands.

i nrmE

MIDI Processor
core Editor
hrase Synthesizer
IDI Mixer

The Module Selector dialog box
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The large area in this box displays the available modules. They are shown as active when there
is a memory size displayed beside them. Please note that the available modules are limited to
those in the CUBASE.DAT folder on your hard disk or floppy disk.

_ Can't find the File!
1%, FNT!
” (Please insert Program Disk)

[Abort ] [Tgnore]| | Retry |

The CUBASE.DAT folder is missing

If you want to load a module, your program floppy must be inserted in the disk drive. If you’re
using a hard disk, the folder containing the file must share the same path as the CUBASE.PRG
file.

ore Editor 1708134
hrase Sunthesizer 33950
IDI Miner 33756

Four modules are loaded, two of which are loaded automatically

Apart from the modules, this folder contains other important information, e.g. character fonts and
printer drivers.

You can start Cubase without the data in this file, but then you have to make do without important
functions. Cubase alerts you to the missing file several times if you do decide to give it a try.

To install a module, click the desired one (e.g. MIDI Processor or Score Editor) to highlight it,
then put a checkmark in the box next to "Active". The selected module then loads.

The memory being used is displayed, and the Active status changes from No to Yes. Follow the
same method to load any additional modules. Having to load modules every time you start the
program can become rather tedious, so Cubase offers automatic loading.

Select a module and click the Autoload box. The Preload status changes from No to Yes, and the
selected modules are antomatically loaded next time you start the program. Cubase makes a note
about which modules it needs to load by writing to disk, so make sure that, if you are using a
floppy, it is not write-protected.

Module activation and the Autoload status can be reversed by clicking the appropriate
checkmarks of the selected module once more. This way you have more memory available, and
you won’t encounter the following warning:
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Module manager:
Not enough memory!

Too little memory

7.8.2 Loading additional modules

You can also load modules not contained in the CUBASE.DAT folder. Click the Add field and
select the desired module in the Item Selection box which now appears. Cubase adds it to the list.
The module is not actually loaded, just added to the list. Follow the steps described above to load
it. Use Remove to delete a module from the list.

These Add settings are lost when you exit the program. If you want a module to permanently
appear on the Cubase list, you have toadd itto the CUBASE.DAT folder. If you are working with
a floppy, not a hard, disk, you may run out of memory. A "DD" floppy disk has a capacity of
around 720 kBytes, which is simply not enough for the Cubase program, its fonts, and dozens
of modules. Therefore, you have to first delete modules you don’t use before you can add others
to the floppy.

Remember to always work with a backup copy of your original program disk. More information
on computers can be found in the appendix.

7.9 The Input Transformer

For some applications, it is useful to modify MIDI data beforeitis recorded. Cubase 3.0 provides
a function designed specifically for this purpose, the Input Transformer. Activate it in the
Options menu. The Input Transformer dialog box is related to the Logical Editor, which we will
cover in a later chapter.
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The Input Transformer
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The Input Transformer has two functions. Firstly, data can be filtered out of the MIDI data
stream. Although this is also possible with the filters you have encountered so far, the Input
Transformer offers far more specific options.

Secondly, the structure of incoming data can be altered, making it possible to convert, say, Pitch
Bend data into modulation or volume commands.

All processing is executed in realtime: incoming MIDI data is immediately altered, recorded (if
you wish), and then sent via the MIDI Thru to your MIDI devices.

Up to four presets are available which can be activated individually or together. Click the "1" and
the white box below it. Both are located in the Presets box. You have just selected and activated
the first Input Transformer preset. All the settings that you can see apply to the currently selected
preset only.

Preset management: Preset 1 is being edited, Presets 1 and 2 are active

To define more presets, you have to first click the desired number, and then edit the settings. A
preset is not activated automatically by doing this: you must enter the usual checkmark to do so.

7.9.1 The Filter function

You need to know about the MIDI data structure to make best use of the filter functions. The
previous chapter has already supplied much of the relevant information. You need to define the
Transformer’s operating mode before you can use it to filter specific data. Click and hold the
down arrow to the left of the Init and Exit fields.

Init

{ Transform Exit

Basic setting: Filter or Transform

Select "Filter" because we want to filter specific MIDI messages in this exercise. We only need
the upper third of the T former box for this purpose. The four boxes that are arrayed side by
side are where you enter the relevant settings. "Ignore" means no messages are filtered. Click and
hold the down arrow above the Event Type entry, and select the condition "Equal".

I lanore |& lanore |&
lgnore ‘

Equal £ . & i

Une I j

Selecting the condition that defines the type of event

Cubase uses different "conditions" which have to be met before something is processed, one of
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which is the entry you have just selected, "Equal". The entry in the Event Type box was grey:
it is now highlighted, i.e. active.

Play a few notes on your master synthesizer. You shouldn’t hear anything. Why? Because
Cubase is filtering all notes from the incoming MIDI data. This is what you have just determined:
everything "Equal” to the Event Type "Note" is removed, i.e. all the notes you play are filtered
out. Now click and hold the down arrow in the Event Type box.

al |& lanore | lanore |& lanor

# E
Note " @ 3
Poly-Press
ctriChange
ProgChange
Aftertouch
Fitch—-Bend

The types of event (as defined by their MIDI status )

You can select any available event type from this list. If you select Aftertouch (MIDI Channel
Pressure), it filters out all that data. If you have studied the chapter on MIDI, you will know how
Cubase does this: it simply analyses the incoming status bytes and recognizes which ones are
Channel Pressure messages. It then simply ignores them.

In addition to this method for selecting and filtering out specific types or status of MIDI data,
there is its "reverse” variant, as it were: the condition "Unequal" is the one to use here.

Let’s stick with the example above: activate "Unequal” and keep the Event Type as "Note".
Cubase now filters out all messages that are nofnote commands, e.g. Control Changes, Program
Changes, Channel Pressure, etc.

Next to Event Type, you can define three further conditions with their criteria which exactly
define which events are to be filtered. Exactly what these boxes contain depends on the event

type.

Let’s look at an example using note commands. Leave "Note" as the event type, and set its
condition to "Equal”. Set the "Value 1" condition to "Equal" as well, and enter a value of 60 in
the upper field (this is MIDI Note 60 (C3)). The lower field remains dimmed, so you can’t enter
anything in it for the moment.

Equal Eq lanore |& lano

Filtering out the note C3

Play chromatically up or down the keyboard. You will notice that C3 cannot be heard: its key
is now muted. You can mute any key by entering its value in the Value 1 box. This process can
alsobe reversed by replacing the condition "Equal” with "Unequal": altkeys except C3 are muted.
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Ignore
Equal
Unequal
Higher
Lower
Inside

Note

The Input Transformer

lanore |& lanore |&

it

The conditions: these determine the range for further processing

You can see there are other conditions for defining the Value 1 range. Try Higher (than) and
Lower (than). These are used to divide the keyboard into sections.

Inside and Outside also define ranges. With these conditions, you mustenter an upper and alower

limit. Try the following settings:
Event type "Note" with condition "Equal”:

"Value 1" "Value 1"
Condition Value Result
Higher C3
Lower D4
Inside C3-C4

muted.
Outside C3-C4

All notes higher than C3 can be played, the rest are muted.
All notes lower than D4 can be played, the rest are muted.
All notes between C3 and C4 can be played, the rest are

All notes outside C3 and C4 can be played, the notes

between these two keys are muted.

In each of these exercises, you have divided the keyboard into playable and non-playable
sections. So far, two conditions have been interconnected: notes and range. There are other
criteria available. Value 2 (which represents the 2nd data byte of a MIDI event) is used to define
velocity values for notes. Enter the following settings in the Input Transformer:

lanore |& lanore |&
Rig g c.a
g .
Keep Keep |&
Mgl
%
BB Filter |&

Higher lgnor
1]
&% H
Keep |& Keep |&
%
#% #
Init
Exit

Only notes with a velocity value lower than 80 will be played
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Play something with varying velocities on your keyboard. All notes exceeding the 80 velocity
value limit are filtered out. Experiment with different values and criteria.

The fourth box determines the MIDI channel, allowing you to set conditions based on the
channels of incoming messages. In the following example, all MIDI channels except for
("Unequal") channel 2 are filtered out. This application is useful when you want to specify a
specific instrument, such as filtering out the bass from an auto-accompaniment program.

re | lanore |& lgnore |&  lUnequ

i - S i3 2

- # H

[ & Keep |& Keep |& Keep

re |D & # %
&% # #

2 3 [ Init
Filter & Exit |

Specifying a MIDI channel

7.9.2 A summary of the Filter function

The filter settings define the MIDI events you want to filter. As well as being able to define the
"eventtype” (MIDI status), i.e. notes, Poly Key Pressure, Channel Pressure (called " Aftertouch”
in Cubase), Pitch Bend, Control Changes and Program Changes, you can specify their Ist and
2nd data bytes by defining their "Value 1" and "Value 2" settings and their conditions. What the

"Value 1" and "Value 2" boxes refer to depends on the "event type". Here’s a detailed list:

Event Type Value 1 Value 2
Note Pitch Velocity
Poly Pressure Pitch Pressure

Control Change ~ Number Value

Program Change (none) Number
Channel Pressure (none) Value
Pitch Bend (none) Value

The MIDI channel allows a channel to be specified.

7.9.3 The Transform functions

Apart from the relatively simple Filter function, you can also manipulate all sorts of MIDI data
in all sorts of ways. This is what the "Processing” area of the Input Transformer is used for, when
used in conjunction with the “Filter" area. Their boxes, used in conjunction, define which
incoming events are eligible to be transformed (using the "Filter") and how they are to be
transformed (using the "Processing"). Begin by switching the operating mode from Filter to
Transform:
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| Filter
Eni

Switching to "Transform”

The event types can be accepted as they are, or modified as per the example at the end of this
section. "Value 1" and "Value 2" tell Cubase what to do with the individual events. You can
transform incoming values by adding to or subtracting them from a value (plus/minus), defining
a fixed value for them (Fix), inverting them (Invert), processing them with the Value 1 or Value
2 value, or scaling them with Value 1. Most of these operations will become clear as you apply
them. Enter the following settings: °

Equal |& lanore |3 lanore |& lanore |%
Note [§ & .a f
& & | H

Keep |& Keep |& Plus |& Keep |&
mate |0 [ # [~ 28 [ &
i

Init

BB B Transform/& Exnit

Increasing velocity values

All the incoming notes’ velocity values are raised by a factor of 20. A value of "20" becomes "40",
"60" becomes "80", etc. "Note" must remain as the event type (this is why you enter "Keep" for
the "Processing Event Type"), otherwise additional notes would be generated by incoming notes.

Egual |& Equal [|& lanore |& lgnore |&
trichangeld | T ez | a4 | 7
L M # [ H

Fiu |& Fin |& Keep |& Keep |&
triChangel & 7 & #
& # &

B3 Ha Init

B B Transforml & |Exit

Using the mod wheel to control volume
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The above example shows how Control Change 1 (modulation) is transformed into Control
Change 7 (volume).

al lanore | lanore | & lgno
te P caen 66 2
# & H
ep IO tnvert |& Ke Kee
F: ¢ % #
# 4

Ini

Transfo & Exit

To invert the keyboard
The keyboard is inverted: it plays "upside down".

7.9.4 A summary of the Transformer function

If the "Filter" area’s various boxes are set to "ignore" all incoming events, it means that all
incoming events are eligible for transformation; if the Filter area defines specific conditions for
specific values, then only those will be transformed. The MIDI status bytes and their data bytes
are transformable using a variety of conditions. All processing occurs in realtime, and can be
heard as it happens.

7.9.5 A concrete example

The preceding examples cover only a fraction of what is possible. It would be impossible to
document all the possible applications as there are so many.

What you have learned so far should allow you to create all sorts of Input Transformer
applications. Let’s use aconcrete example to apply thatknowledge: say you want torecord akick
drum, but you want to trigger it with your foot. Can the Input Transformer help? Yes, it can!

When it comes to using your feet in MIDIL there aren’t that many alternatives: we’ll use the
master’s sustain foot switch. As the switch does not generate note commands, but Control
Chang data, youhaveto specify that thatis the data you want to work with, using the Filter area.
The setting depicted in the following diagram shows this:

(T Equal | Equal |& lan
) 6d  e= 127 %
% &

Our example’s Filter setting
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MIDI Control Change 64, which is generated by the sustain foot switch is the one you want to
process. This switch produces two values: "0" is transmitted when the switch is released (off!),
and "127" denotes that the switch is pressed (on).

For this example, we need the "127" value only, so enter it in the Value 2 box. If you don’t, the
switch will generate two notes, one when you press it, the other when you release it.

Now that you have set the Filter conditions, hold on a minute and think of how to proceed. You
want the Control Change event to generate a (drum) note of a certain pitch. The sustain switch
does not produce velocity values, so you have to create one. The result is the following Transform
setting:

Fiu | & Fin |8 Fin |8 Keep |&
Note [& | 36 118 | 8
# by | #

Init

Transform|d Exit

The Transform setting

The above diagram shows that we are creating a "Note" event type. Value I must be set to the
kick drum’s MIDI Note Number, which of course does not necessarily have to be "36". Value
2 defines the velocity, so set it at the value you want.

The currently selected Track on the Arrange window determines the MIDI output channel, so
make sure it is set to the drums’ channel. ‘

You can also combine more than one Preset. Our final example shows how to create a keyboard
split, and also demonstrates the Input Transformer’s versatility.

Equal |& Inside |3 lanore |& lanore |&
Note [& | 8 - 137 3
68 = # H

Keep |& Plus |& Keep |& Plus |&

it

Mgle  |D 12 118 | 1
@ % | %

Init

Transform|& Exit

The Preset 1 setting. Combine it with the following Preset 2
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ual |& Inside |&

| & 61

127

=

GE

Keep

@rﬁ_ﬁﬁ ER 5

Transfo

lanore |& lgn

Y FY %

# %
Keep |9 Fi

IR 3

EH &

Init
& E

The Preset 2 setting

Start by setting the Track’s channel to "Any" so you can address any MIDI ch
Cubase plays everything up to C3 on MIDI Channel 1, a
So you have a keyboard split that addresses two
different channels. Moreover, Preset 1 is adding 12 semitones (an octave) to the lower register.

play. Thanks to Preset 1,
above C3 on MIDI Channel

7.9.6 A few tips

Here are two tips that should help you to avoid

- If you are using the Input Transformer to alter
channel is set to "Any" on

alteration.

- If you are transforming data, ensure that you define the conditions precisely. As an example,

3 thanks to Preset 2.

unnecessary difficulties:

MIDI channels, make sure the selected Track’s

the Arrange window, or you won’t be able to hear the results of the

say you want to transpose all incoming notes up an octave:

lgnore lanore |&
i}“% et
eep |% Plus
are D 12
| #
73
Transfo
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Transpose/Velocity

ual |& lanore |$ lanore [& ignore

Note |& e 44
| R HEH
| Plus |& Plus |&
Ml 12 #
# # #
Init
Transf o

Two ways of transposing

Of the predecing two diagrams, only the second one will work, because the Filter is specifying
that all notes should be transposed.

In the first diagram, incoming notes are also transposed, but because the Filter is not specifying
"Note", allincoming events, whatever their type, willhave their first data bytes altered by a factor
of +12. The result is that, say, incoming MIDI Control Change 64 events become 76, 1 becomes
13 and so on.

Your synthesizer now receives invalid sustain foot switch commands and other weird data that
might make it behave oddly.

From time to time in the Input Transformer, you may encounter the dreaded MIDI drone: the
notes are correctly switched on, but not switched off. This can happen, especially when you
transform Control Change or other MIDI commands into notes.

Cubase is not the problem. The culprits are the little quirks of MIDI communication. If you get
a drone, press the Cubase Stop button to cut them off. If the "Reset on Stop" function is active
in the MIDI Setup dialog box, all notes that are still sustaining will be switched off.

7.10 Transpose/Velocity

The Transpose/Velocity item in the Functions menu allows you to do things to all the Parts
selected in the Arrang window, or all events selected in one of the Editors.

The method is very simple: it’s a matter of entering the required values and activating "Do". To
use the Transpose function, activate it by entering a checkmark by it. The events are transposed
up or down according to the entered value, between +/-127.

Do not transpose drum Tracks as you will change their MIDI note assignments! If you make a
mistake, you can undo what you’ve done via the Undo button.
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“~

M gy

Add/Sub
, B
ey

The Transpose/Velocity dialog box

You can also transpose material using a scale correction, where notes are modified to match the
selected scale. You must determine the key and the scale.

Click and hold the Scale box. Select a scale, then enter the key in the box above it. Chapter 13
on the Logical Editor describes how scale-corrected transposition works.

The Velocity section allows specific changes according to specific criteria. Select its basic mode
under "Velocity". "No change" is self-explanatory. "Compress/Expand” processes the velocity
values of the selected Parts or events.

Enter the percentage value in the "Ratio" box. Additionally, in the Centre box, enter a value
around which the processing occurs: this is what is sometimes called the "centre key" in
compansion, and is the one that is not affected by any processing: if you enter 100, say, then all
values above and below 100 are increasingly compressed or expanded as the values move away
from 100.

Alternatively, you can let Cubase compute the mean centre value from all the available velocity
values by selecting "Average".

"Limits" enables you to define areas in which velocity value changes should occur. Notes within
the defined area are leftunchanged, all others are modified to the maximum or minimum settings.
"Add/Sub" changes all values by the amount entered here.

7.11 The Track Classes

Cubase 3.0 has introduced a new term, "Track Classes". These are used to define what kind of
data is recorded on a given Track.

Each Track can be assigned any Class. The basic setting is "MIDI" and applies to recording and
playing every kind of MIDI event. The second option is one that we’ve met before: "Group"”
defines a Track as a Group Track.

The other Classes are discussed in detail in the appropriate chapters. The number of Track
Classes will increase with the development of additional Cubase modules.
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<» File Edit Structure
| shap BAR I ttouse ‘

A IM o ITrack. IChn |Instr~ument‘

MIDI Track
gk Drum Track
; Group Track
Tape Track
Mix Track
piTrack 7 7, |

The Track Classes

Some Track Classes feature a relationship with the Part Display, allowing you to call up an Editor
by double-clicking a Part. This applies to Drum, MIDI and Mix Track Classes. This is how it

works:
By double-clicking a Part in a
- MIDI Track, you enter the Key, List or Score Editor

- Drum Track, you enter the Drum Editor
-Mix T ck, you enter the MIDI Mixer.

To assign a Class to a Track, click and hold, using the mouse pointer, the desired Track’s C
column. Select the desired Class from the pop-up menu. It is always best to assign the Class
before you record on a Track.

As mentioned above, three different double-click options are possible for the MIDIT ck Class.
You must decide which Editor you want to enter via the double-click. The File menu’s
Preferences dialog box is where you enter your choice. Select the desired Editor under "DClick
Opens". This setting applies to all MIDI Tracks.

KEY
SCORE
ok LIST

The double-click options of the MIDI Track Class
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8 The Key Editor

In this chapter, we’ll change the focus of our discussion and take a look not at Parts or Tracks
but at the MIDI events contained in them. Cubase features a number of Editors that enable you
to have direct access to Notes, Control Changes and all the other types of MIDI data. Knowledge
about how MIDI basically works, as laid out in Chapter 2, is extremely useful here.

The Editors are designed to edit specific note and other MIDI data. You can also use the Cubase
Editors to generate notes step by step, allowing difficult passages to be created in non-realtime,

The following chapters are divided into two sections. The first section covers the Key, List, Score
and Drum Editors, i.e. the "normal" Editors; the second section features the remarkable
capabilities of Logical Edit, the MIDI Mixer, IPS and the MIDI processor. Although these
components of the program differ substantially from the other Editors, they are also used to create
and change events and can therefore also be called "Editors" of a sort.

8.1 The "normal" Editors

The normal Editors, i.e. the Key, List, Score and Drum Editors all have certain handling
characteristics in common, which we’ll be discussing in this chapter. In the remaining Editors,
your attention will be drawn to any difference in handling from the Key Editor, so by getting to
know how the Key Editor works, you’ll be learning about the other Editors, too.

To enter an Editor and be able to access single notes and other MIDI data, you must first select
one or more Parts or a complete Track. The number of Parts you can select is defined by the type
of Editor. You can also create an empty Part: by selecting it you enter the Editor, too.

8.2 The Key Editor

Create an Arrangement featuring several Parts on different Tracks. We want to come up with
similar results, so please create an Arrangement similar to the one in the illustration below. You
could also use the basic Arrangement we created in Chapter 1. Select the first Part in Track 1 and
select the Key Editor in the Edit menu ([Control][E]) to enter the Key Editor.

A completely new window opens which you can size to your specifications: remind yourself
about how to move, size, etc. windows - things you learned with the Arrange window. In the
process you will notice that the Arrange window has not disappeared off your screen, but is
merely covered up by the Key Editor window.

You could use the familiar Tile Windows function to display equal-sized Arrange and Editor
windows on your screen, but for now, leave the Editor window at its maximum size.
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The Key Editor and the Arrange window (Tile Windows)

The Transport and Menu Bars below and above the Editor window are the same in all the
"normal" Editors. Their functions operate as usual. You can access an Editor while the sequencer

is running in playback or record modes.
If you are not yetused to operating a sequencer whileit’s running, do all the exercises below when
the sequencer is stopped.

8.3 The layout of the Key Edit window

Let’s take a closer look at the Editor window. This is a good opportunity to discuss the differences
between the various Editors.

Boote B Al EFunct n 16 | . . 8 J\“lJ.
4. 2. 96 |An Augn. laupnT 16 1. 1. 8 *

START ————i——i——~ TH —=———— F TCH ———— VELO-ON ——= VELO-OFF ——= CHN =7
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The Key Edit window ( without the Menu Bar or Transport Bar)
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The Key Edit window is divided into four distinct sections:

|BGote @ AN ElFunction lsnpe 16 |

1. 1. 8
| 4, 2. 96 |An Augn. lquanT 16 | 1. 1.

a8
The Functions Bar

- The Functions Bar also contains a number of icons (symbols that act as switches). It exists, with
minor differences, in all four Editors.

START ====i==i=== LENGTH -==-= PITCH ==== VELO-ON === VELO-OFF === CHN ==

The Info Line (without information as yet)

- The Info Line displays information concerning a single, selected note. The List Editor doesn’t
have it.

I <

"

The Key Editor display

- The Key Editor display has a graphic keyboard on the left, and most of it is covered by a grid
pattern. This is the area where there are substantial differences between the Editors.

o [T A EE T e T T

1<l !

The Controller Display

- The Controller Display features either small vertical beams or grey areas, depending on the
setting. The Drum Editor also has this display.

You can remove the Info Line and Controller Display from the window, or if you cannot see
them, you have to activate them so they can be seen. The "Info" and "Ctrl" buttons in the
Functions Bar are used for this purpose ([Control][I] and [Control][C]). Click both of them and
see what happens. By removing these two features, the dimensions of the grid display increase
correspondingly. Activate both features for our purposes.

MIDI notes are displayed in the Key Editor in a manner resembling a player piano’s perforated
roll. Each of the little rectangular beams represents a note.

The pitches of the beam notes are shown on the keyboard at the left edge of the screen. The length
and position of the notes can be taken from the Position Bar, which you probably recognize from
the Arrange window. Generally, the Arrange window and the Editors covered in this section
share several common features.
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Start Cubase. The Song Position Triangle in the Position Bar begins to move in the same manner
as in the Arrange window. When it reaches a beam note, it plays it. Once the Song Position
Triangle reaches the right edge, the Position Bar is scrolled forward to show you the next notes
in the Part. If you used the locators to define a Cycle whose length is the same as the Part, the
Editor display jumps back to the beginning of the Part and repeats it. If there’s no Cycle, Cubase
runs through the Arrangement as usual, i.e. the Editor window is scrolled to the end of the Part
and stays there. The Song Position Triangle disappears and starts its journey through the
following Parts in the Track, though you cannot see this.

As with the Arrange window, you can tell Cubase to scroll the Position Bar according to the song
position: choose Follow Song from the Options menu ([F]). As usual, you can use the scroll bar
along the bottom edge of the window to access elsewhere in the Part.

Even if you have only a single Part in the Editor, the Parts of other Tracks which run paraliel to
this one are played unless you previously muted these Tracks. Once in the Editor, you can prevent
other Parts from playing by clicking the Ed Solo button in the Transport Bar so that only those
Parts in the Editor are played.

It’s also possible to have several Parts in the Editor. For this purpose let’s close the Editor window
for the time being.

[reer | Erced]]

Closing an Editor

You have several options - we’ll discuss the exceptions when we get to them. Two buttons are
situated at the lefthand end of the Title Bar, Keep and Cancel. Cancel ([Esc]) allows you to close
the Editor without carrying out any of the changes you have made. Keep ([Return]) also takes
you back to the Arrange window, except that the changes you have made are saved. The
distinction between these two functions is very important: if you accidentally close an Editor via
Cancel, you lose all your editing efforts. You can use this function as a kind of "Editor Undo
function”. As we haven’t made any changes, you can exit anyway you want.

For our next exercise, we’ll enter several Parts in the Editor. There are differences between the
Editors regarding this operation, and we’ll discuss them when we get to them. The following
applies to the Key Editor: all selected Parts, regardless of which Track they happen to be in, are
entered. If no Parts are selected, then all the Parts of the currently selected Track are entered.

For this exercise, select a Track containing several Parts. Deselect all the Parts by clicking an
empty space in the Part Display and go back to the Key Editor: it displays the same song position
you were at in the Arrange window, provided the Part at that position is included in the Editor:
if you were at bar 14 in the Arrange window, you are still at bar 14 in the Key Editor; if you
selected a single Part ending at bar 5, you will find yourself at the end of that Part in the Editor.

You can use the rewind and fast forward functions or use the horizontal scroll bar to scroll
through the song. You can also type in the position in the Song Position box, or click the desired
position in the Position Bar to move through your song.

Even if you have entered several Parts in the Editor, only one of them is active ata time. Special
operations such as recording, step input and changes via MIDI are always executed in the active

Part.
In our example, the first Part is active. According to the Arrangement we created in the first

chapter, this first Part covers positions 1.1.0 to 5.1.0. This active Part range is displayed in the
Key Edit window’s Title Bar, along with the Editor and Track names.

Key — Track 1,

The active Part’s range
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This display, too, is identical in every Editor. Go from the first Part to the next, i.e. to position
5.1.0: the contents of the Title Bar change, and the note beams before position 5.1.0 change from
having solid outlines to dotted ones.

8, 5. 1.
EEE:EES )
[ [l 1% i
ELO-OM —=—— UELD-OFF ——— CHN - VELO-ON 113 vELo-OFF 78 CcHM 1
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Activating Parts

Click one of the dotted beams: the display changes. Now the events prior to position 5.1.0 are
dotted, and those following position 5.1.0 are solid. You have just activated the second Part of
your Track. The Part’s start and end positions are entered in the Title Bar. If you selected parallel
Parts that play at the same time in the Arrange window, these Parts are displayed in the Editor
window at the same time, although just one Part can be active at a time: this means you will see
solid and dotted beams in the same Part of the display at the same time. Clicking a beam selects
its Part, but you run into problems where the paralle] Parts contain notes of the same pitch at the
same positions, as they will lie one on top of the other; here, it’s impossible to select some notes.

The Goto sub-menu in the Functions Bar is designed to solve this problem. Click and hold Goto
with the mouse pointer. A menu appears featuring a number of selections, some of which we will
now get to know. "

Song-Pos
First Event LENGT}
Last Erent __@

First Selected
Next Selected
Last Selected
Prep Selected
Next Part =
Prev Part A

The Goto sub-menu

Choosing Song Position in the sub-menu moves the window display to the Song Position
Triangle’s position. First Event and Last Event move the window to the first or final events in
the active Part. Next Part and Previous Part move the window to the following or preceding Part;
these two functions only make sense if you have transferred several Parts into the Editor. All the
commands in the Goto sub-menu are used to move the window display: no data is edited, nor are
any Parts selected.

The only exception is that if one of the Parts which has been selected with the command is empty,
it is automatically activated.

139




The Key Editor

8.3.1 An important example

This Next Part or Previous Part operation is important if you later want to enter notes with the
mouse, or step by step. If you entered an empty Part along with Parts containing notes, you have
no other way of activating this empty Part.

For example, let’s assume you have entered two successive Parts in the Editor. The second Part
contains no events - you left it blank to enter notes in the Editor. You know that you can add notes
to an active Part only. You activate a Part by clicking one of the events contained in it. As the
second Part contains no events, you would appear to be stuck. If you enter notes anyway, they
are added to the end of the first Part, and not in the new one you wanted. You could of course
g back to the Arrang window, select the empty Part on its own, and return to the Editor, but
this would be rather tedious, so let’s take the easy way out via the Goto sub-menu. Get to know
the Goto sub-menu; you’ll find it in virtually the same form in the four Editors, and its operation
never changes.

8.3.2 The first edit

You now know how to move about in the Key Editor, which we’ll use as the basis for the
following exercises. We will run through two operations in the following sections:

- changing existing notes in various ways,

- creating completely new events.

8.3.3 Changes

If you move the mouse pointer across the grid of the Key Editor, Cubase keeps you updated with
two displays. Below the Goto sub-menu in the Functions Bar, you can see the Mouse Position
display. You will recognize it from the Arrange window.
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The Mouse Position display

Click and hold the Snap sub-menu and define the resolution of the mouse pointer movements,
from a dotted whole note to 64th note triplets. You can go even finer than this: "2PP" to "7PP"
equals 2 to 7 ticks, and "Off" allows positioning down to the nearest tick, the smallest possible
unit of time in Cubase. Please note that "2PP" and "Off" only work when you zoom the window,
otherwise the screen resolution is too coarse.
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You can change note values in all windows including the Arrange and Editor windows, using
your computer keyboard, via the alphanumeric, not the numeric, keypad:

1 - whole note

2 - half note

3 - quarter note

4 - eighth note

5 - sixteenth note

6 - thirty-second note
7 - sixty-fourth note

The "T" stands for triplets, the dot for dotted notes.

Apart from the time components (note length and position), each note has its own pitch. These
are displayed in the keyboard at the left edge of the window.

= Goto B2l Al =
5. 1. 96 |
START 5. 1.
Key @ = a
[l
i
i
-_—
-_——
[
-_—
[
[

plj{*’

The pitch display (in this case, B4)

Move the mouse pointer up and down. The keyboard displays the pitch corresponding to the
pointer’s position. Click one of the keys, and the note is sent via MIDI to your instrument (ensure
the Track’s MIDI channel is set correctly).

The keyboard display does not show the entire range possible. Don’t worry if an event is not
visible on the keyboard: the note is probably out of the display range. Move the keyboard display
by scrolling the righthand vertical scroll bar or arrows.

You can zoom the display resolution in the same way as the time axis: click as usual the vertical
scroll bar or arrows with the right mouse button to reduce or increase the display size. You have
to decide what size is best for you in terms of clarity and range of information.

Now, click the first event in the Key Edit window. It is highlighted, i.e. selected. You can tell
Cubase to play all the notes you click via MIDI by activating the "Ear" icon with a mouse click.

Auditioning notes by activating the Ear symbol

The Info Line displays additional information about the selected note: its starting point, length
in ticks, pitch, velocity, release value and the MIDI channel on which the note was first recorded,
i.e. the channel your synthesizer transmitted on. Cubase records this information, though the
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channel is normally ignored since it is overridden by the Track’s channel setting. The original
MIDI channel is only used if you set the Track’s MIDI channel to "Any".
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...relate to this note.

The Info Line

You can change all the values in the Info Line using, as usual, the right and left mouse buttons,
or a double-click followed by direct, typed entry.

Change the selected note’s pitch. You can see that the graphic display reacts immediately. The
note display moves upwards in the grid. Now change the starting point and the length, and watch
the graphic display adjust to the changes.

8.3.4 The graphic solution

In addition to this method of numerically accessing anote, you can also treat notes as you would
Parts. You can move, copy, etc. them with the mouse. Some of the options described below are
available in other Editors as well, and you’ll be asked to refer to the following explanations when
you go through the other chapters.

Select a Snap value of "8" and move the mouse pointer to the first event in your Part. Click and
hold it with the mouse button. The note is selected, and the mouse pointer becomes a hand
symbol. You can now drag the note around while holding the mouse button down.

Pitch changes are registered on the keyboard to the left and in the box in the Functions Bar beside
the mouse position display which shows by how many notes up or down you are transposing.

The mouse position display registers how far you are moving in time. In our example, you can
only move the note in eighths. If you require a different time value, set the Snap resolution
accordingly. Once you reach the desired position, release the mouse button to fix the note.

This allows you to "manually” quantize a note. Let’s assume you played a note at position
1.4.377, which means that it’s situated 7 ticks before the second bar’s downbeat. Select a Snap
value of "8" or "16" and drag the note to the next Snap position, i.c. the "1" of the next bar.

On the whole, handling events in this Editor is very similar to handling Parts in the Arrange
window. There you learned how to copy and delete Parts: before you drag the note, press and hold
[Alternate], then drag it. Delete the note with [Backspace] or [Delete].

You can execute all the above operations with as many notes as you want simultaneously so long
as you select the notes first. Selecting is the same as for Parts in the Arrange window:

- If you hold [Shift] down, notes are selected one after another as you click them;

- The rubber band selects all the notes it touches or surrounds. Activate the rubber band by
clicking an empty space in the grid and dragging the mouse while holding the mouse button
down;

- The Select All function in the Edit menu selects all the notes in the active Part;

- Click an empty space in the grid to de-select all selected notes;

- Use the right/left Atari cursor keys to jump from one note to another. If you hold [Shift] down
at the same time, the notes are selected or de-selected. If you select more than one note, the Info
Line displays no information as it can handle only one note at a time.

The remaining functions in the Goto sub-menu are used to access specific events:
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- First Selected moves the display window to the first event that is selected;
- Next Selected to the next selected event;

- Last Selected to the last-selected event;

- Previous Selected to the previously selected event.

These functions do not modify the data, but simply scroll the display to another position. They
are often the source of misunderstandings. If all the events in the current window view are
selected, Cubase does not respond to any of the above commands as it cannot scroll to a position
it is already at.

These functions are only really suitable for events that are further apart. The following two
examples illustrate the best use for Goto functions:

- If you’re working on a piano Track, some notes are probably pitched too far apart for them to
be displayed at the same time. Select a relatively high note (transpose one if you cannot find one
in the current Part). Using the vertical scroll bar, move the display down to the lower register and
select a low note, pressing and holding [Shift] at the same time, otherwise the first note will be
deselected. Choose First Selected from the Goto sub-menu, and the high note is returned to the
display. Choose Next Selected, and the low note is returned to the display. In other words, these
functions replace the scroll bar.

- The second example is an even more practical application. An Editor is designed for locating
and correcting mistakes, amongst other things. As it’s impossible to say where you might have
made a mistake, let’s fabricate an error or two. Go to different positions and move some notes
to the wrong pitches and positions. Go back to the beginning, activate Ed Solo and start playback.
Watch the events in the Edit window. When incorrect notes appear and are played, click them,
holding [Shift] down as you do so. It may be an advantage to slow the playback down so you have
time to react to what you hear. Stop Cubase after the Parts have been played to the end. You’ve
now marked the mistakes: the Goto functions allow you to move from one wrong note to the next
and correct them.

Did you have trouble recognizing the incorrect notes in the Edit window even though you could
hear them clearly? No problem - simply mark any event close to the position of the incorrect note.
You then use the Goto functions to localize the general area in which a mistake occurred, restart
Cubase, and have a closer look.

All the methods used to select one or more events are applicable in the other Editors as well. If
you can read music, searching for mistakes might be easier for you in the Score Editor which
we’ll come to later.

8.3.5 The Edit Loop

An Arrange Cycle created with the locators will also be played when you’re in the Editors. There
is a further "edit loop" which acts as a "loop within a Cycle". It is useful if you want to hear a
certain passage several times to discover mistakes. Cubase again offers several ways of defining
the loop’s length:

- Use the left and right mouse buttons to directly set the values in the loop boundary boxes on
the Functions Bar. You can also call these up by double-clicking ([Alternate][L] and [R]) and
typing in the values.

- Drag directly on the Position Bar in any direction. The speckled beam defines the loop’s length
and position.

2. 1. 96
2. 1. 96

The Edit Loop button with the boundary boxes
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The edit loop is active

Click the Loop button to activate the edit loop ([Alternate][O]). An active edit loop is shown in
black on the Position Bar, and speckled when it is inactive. Define an edit loop in the Key Editor
and start playback.

An edit loop can be re-defined as much as you please by simply dragging the mouse across the
Position Bar again. The new edit loop replaces the old one. To delete an edit loop, simply click
any position outside the loop within the Position Bar.

If youhaven’tactivated a Cycle with the locators in the Arrange window, everything should work
as described.

If a Cycle is active, then this edit loop cannot exceed the Arrange Cycle’s length. The Arrange
Cycle jumps back to its start once it reaches the right locator, regardless of where the edit loop
happens to be.

A number of editing options are available for editing events within edit loops. We’ll have alook
at these in a moment.

8.3.6 The Toolbox

Another similarity between the Arrange window and the Key Editor is the familiar Toolbox.
Click the grid with the right mouse button, and it will appear.

NEI Y
QlZl<]y

You know how to select a tool. You probably recognize some of them.
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f

The Eraser deletes notes with a mouse click

Q|

The Magnifying Glass is used to audition notes by clicking and holding them

f

Kicking notes earlier

oy

Kicking notes later

The two Kicker tools are used to move notes. Select the upper one and click a note. It is "kicked"
earlier by the number of ticks or the note value in the Snap box. If you set it to eighths, the note
is kicked earlier in eighths steps with each click. The same happens with the other values. The
lower Kicker tool performs the same function in the opposite direction, by kicking the notes later
by an amount equal to the Snap value.

The Pencil tool

The Pencil tool allows you to create notes (we’ll get to this in amoment) and change their lengths.
Click and hold any ending of a note with the Pencil. The note is surrounded by a dotted box. Use
the Pencil to change its length: the Snap function helps by quantizing the length. Release the
mouse button when you have reached the desired position.

At times, you may find it difficult to locate the correct position of a note. You may accidentally
create a new event instead of modifying an existing one. Use the zoom function to enlarge the
note beams, or press and hold [Alternate] before the first click to prevent new events from being
created.

5 uug;? . nﬁ .

] El i ]

Modifying the note length by dragging the Pencil tool to the right of the selected beam

To shorten a note’s length, simply click the intended end position with the Pencil, which avoids
having to drag the beam to the left to shorten it.

We’ll save the remaining two tools, the compass and Paint Brush, for later. Keep in mind that
it’s always only the latest operation that can be recalled with the Undo function.
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8.3.7 Realtime correction

You can also edit existing notes via MID] in realtime. Activate the MIDI In icon in the Functions
Bar with a mouse click and choose which of the event’s parameters you want to adjust: pitch,
normal note-on velocity or release velocity. Each parameter is represented by an icon. You can
select all of them or any combination thereof. Active functions are highlighted.

Yo HEE
bt —

Input
locity

Pitch

Ear icon for auditioning
MIDI In icon

The Functions Bar icons

Let’s assume we want to change the normal velocity values of the notes. Activate the velocity
icon and select the first note in your Part. Play a note on your keyboard. The Key Editor registers
only this note’s velocity and assigns it to the note you have selected. It then moves to the next
note. Change the velocity values of every note as you go in this way. If you want to change the
values for a specific note, click it first or select it with the Atari keyboard’s cursor keys. The same
applies to pitch changes: just select the pitch icon.

8.3.8 Creating notes

Until now we have merely modified existing notes. However, Cubase enables you to generate
new notes and other MIDI events. We’ll use some exercises to work our way through the process.
Press [Esc] to exit the Key Editor. All the edits we’ve done till now are deleted, and we’re left
with the original Part. Create an empty Part on any empty Track. Set the Track’s MIDI channel
to your piano sound and return to the Key Editor. The grid is empty, and you are going to fill it
with new notes.

Select a Snap value of "4" and enter the same value in the Quantize box. Select the Pencil from
the T Ibox and click position 1.1.0 at the C3 pitch. If the Ear icon is on, you can hear the
corresponding note via MIDL
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Select the Pencil from the Toolbox (Quantize and Snap at "4”)...
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...and follow it with three more

If you’ve been following the diagrams, you have just entered four quarter notes at 1.1.0, 1.2.0,
1.3.0 and 1.4.0. You can’t miss, as the Snap resolution ensures that you only hit quarter note
intervals, and the Quantize resolution dictates that you can create quarter notes only. The new
notes can be edited in the same way as you would any other notes. You can even add notes to
Parts already containing notes.

By changing the Snap and Quantize resolutions you can enter notes of any length and at any
position in the Key Editor’s grid. The Quantize setting defines the length of the note. If, however,
you hold the mouse button down while positioning a note, you can modify the note’s length by
dragging the mouse to the left or right. In other words, the mouse movement overrides the
Quantize factor. Of course, you can also draw notes parallel to one another to create chords.

&

The Paint Brush tool
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The Paint Brush allows you to create several notes at once. Select the Paint Brush from the
Toolbox, press the mouse button, and drag this tool through the grid. Notes are entered in the grid
according to the Snap (distance) and Quantize (length) values. All notes are at the same pitch as
the first one you painted. You can paint notes of different pitches by simultaneously pressing and
holding [Alternate].

The new notes have a default velocity of "32". Afterwards, you may choose to enter different
velocity values for each note using the Info Line, although the realtime MIDI In method

described above is the better option.

Cubase offers a way of entering three other velocity values while you are painting the notes. Press
[Shift][Control] to assign a velocity value of "110", [Control] for "96", [Shift] for "64"; "32" is
assigned automatically when no computer keys are pressed. Release velocity always has a value
of "64".

There are other methods of manipulation which we will discuss later.

New notes are usually entered at the current mouse pointer position in the grid. If you activate
the In(sert) icon in the Functions Bar, the new note isinserted and the following events are moved

later by an amount equal to the Snap value.

8.3.9 Step input

Step input is possible via MIDL Delete all the events you’ve entered so far and activate the Foot
icon. This makes the Step Position box appear in the horizontal scroll bar, which shows you
where note input will occur. Normally, this position is identical to the current song position in
the Transport Bar. However, during step input, it moves independently: New notes are always
entered at its current position.

You can change the Step Position via mouse click, ora double-click followed by typing with the

keyboard. As soon as you change the position in the Transport Bar’s Song Position box, these
two displays are again identical.

Set the song position to the beginning of your Part so that we can get started. We want to enter
a simple four-bar passage.

Enter Snap and Quantize values of "8". Play the chords Am, G, F and G eight times each. Don’t
play too quickly so that Cubase can assimilate the data. Every time you release the last key,
Cubase advances to the next Snap position.
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The result of your work

You entered the chords during the first run through. Listen to the result. Deactivate the Footicon
so the Song Position Triangle can be followed. Cubase has inputted the chords over four bars.
Each chord is an eighth note long, and there’s a chord at every eighth note interval. The velocity
values will be read and inputted with the notes. Go back to the first bar’s downbeat: the quickest
way is to press the Stop button. Make absolutely sure the Step Position box returns to position
1.1.0.If itdoesn’t, press [Clr/Home]. Let’s now add a bass line: set Snap and Quantize to "4" and
play four bass notes for each chord. Cubase inserts the notes in the grid, but this time as quarter
notes at intervals of a beat.
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Step programming is capable of a great deal more than this simple example can show. Here are
a few tips and suggestions:

- Cubase always places new notes at the current song position.

- You can combine step input with normal realtime recording. Exit the Editor via [Return] and
record the notes in realtime, using the overdub technique described in the Arrange chapter.

- Snap and Quantize values can be combined any way you like. If you want to play staccato, use
small Quantize values combined with wide Snap values (Quantize: thirty-seconds, Snap:
eighths, so thirty-second notes are placed every eighth interval).
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- You can change Snap and Quantize values during the Step Input procedure, enabling you to
devise complex rhythmic structures.

- If you accidentally play beyond the end of the Part, these additional notes are accepted at first.
Then when you exit the Editor via [Return], Cubase will ask you if you want to keep these
appended events or if they should be deleted. If you tell Cubase to keep them, the Part is extended
to include these events.

- You don’t have to enter a note at each Snap position: press [Tab] to enter a rest.

- If you activate the In button, all the notes following the current song position are pushed later
by a step each time you enter a note or rest.

- The [Insert] key enters anew note at the current note’s position. The new note’s pitch is defined
by the Fill entry (see paragraph below).

- Cubase places all new notes on MIDI channel 1. This is only used when the Track’s MIDI
channel setting is "Any". Otherwise the Track’s MIDI channel has priority.

8.3.10 Functions

Cubase features two other Editor sub-menus in addition to the Goto sub-menu, designed to ease
editing. Click and hold Function in the Functions Bar. The Function pop-up menu appears
containing a number of choices. Don’t confuse this menu with the large Functions menu in the
Menu Bar across the top of your screen.

Fixed Note
Delete Note
Keep Note
Repeat

Fill
Reverse
Delete

The Function sub-menu

All of these functions are closely related to those in the "selection” sub-menu located to the left
of the Function sub-menu, which has a number of different names depending on the setting, but
in its basic setting is called the "All" sub-menu.

fAll Events

Looped Events
Cycled Events
selected Events
Looped Selected Euv.
Cycled Selected Ev.

The All sub-menu

Although the Function sub-menu controls functions, they "look at" the "selection” sub-menu for
deciding what events they should operate on. The choices are:

_ All Events: all the events of the Part(s) in the Editor.

- Looped Events: all the events inside an edit loop.

- Cycled Events: all the events inside an Arrange Cycle, even if the Cycle is not currently on.
- Selected Events: all the selected events.

- Looped Selected Events: all the selected events inside an edit loop.
- Cycled Selected Events: all the selected events inside a Cycle.

Once you’ve activated an item, its name is adopted as the sub-menu heading. This sub-menu’s
settings can affect the Quantize function: we’1l get back to this in the appropriate chapter.
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Now that you know what you can edit, you need to find out how this is done. Go back to the
Function sub-menu. The first three selection options work for a single selected note only. By
now, you should know enough to be able to try these out without a practical example from the
book!

- Fixed Note forces notes to adopt the pitch of the selected one: the affected notes are defined in
the "selection” sub-menu (All, Looped, Cycled, etc.).

- Delete Note deletes notes of the same pitch as the selected note.

- Keep Note keeps notes of the same pitch as the selected note and deletes all the rest.

- Repeat repeats a section of the Part until the end of the Part. Cubase generates the new events
that are required. You define the "repeat Cycle" by setting the loop or the Cycle. If you choose
Repeat, the events in the loop or Cycle are copied over and over up to the end of the Part. The
"selection" sub-menu determines what happens here:

- Looped Events and Cycled Events replace the original events located there;

- Looped Selected Events and Cycled Selected Events merge new and existing events.

- Fill fills the defined area with notes whose pitch is determined by the center pitch of the graphic
keyboard as it is currently displayed at the window’s left border. Their positions and lengths are
determined by the Snap and Quantize settings. This function can only be executed when the
“selection" sub-menu heading is set to All, Looped Events or Cycled Events.

- Reverse reverses the event order. They are played back to front.

- Delete deletes all events in the defined area.

8.3.11 The Clipboard

The Clipboardis available in the Editors as well. Its use is identical to the Arrange window. Select
the events, cut them or copy them, and paste them at the current song position. Remember you
have just one Clipboard available. As soon as you Copy or Cut events to the Clipboard, the
previous data in it is lost.

8.3.12 The Controller Display

Until now we have been editing notes. Now we’ll get to work with the other non-note MIDI
events which we discussed in the chapter on MIDI. The Controller Display enables you to
quickly and easily manipulate non-note MIDI events. You know how to switch it on and off:
[Alternate][C]. You can enlarge it by clicking and holding the dividing line between the
Controller Display and the Key Edit grid: the mouse pointer turns into a hand. Keep the mouse
button depressed and drag the dividing line down. All this operation does is give you a clearer
view of the display; the whole range of values is available, regardless of the display size.
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There’s a little icon box in the upper left corner of the window. This box serves two purposes.
It displays the currently selected event type, and the vertical mouse position, which denotes this
event’s amount value. Move the mouse up and down in the Controller Display and watch it
change the value. The actual value range depends on the event type you select.

Note: Steinberg have called this function the "Controller Display". The Controller Display
displays all kinds of non-note MIDI data (Pitch Bend, Poly Key Pressure aftertouch, Channel
Pressure aftertouch, Program Changes, Control Changes and so on, plus data that has no status
of its own, such as velocity). You might have expected that something called a "Controller
Display” would display MIDI Control Change events only - this is not the case; we have had to
use the same term as the one in the official Cubase manual and the program.
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The Event Type box’s pop-up menu

In the following section, we’1l run through a few standard operations to demonstrate Controller
Display functions.

8.3.13 Modifying velocity data

Click and hold the small event type icon. A selection of the most common options appears in a
pop-up menu. Choose Velocity from this list. Each note in the grid now has a beam of varying
height assigned to it. Note that this is the case for the currently active Part only. If you see the
notes in the grid, but no corresponding information in the Controller Display, you are in an
inactive Part. Controller Display data can be manipulated in an active Part only. Clicking a note
in the grid activates its Part.

Now you’ll need the Pencil from the Toolbox. Go to one of the beams in the display and click
its upper end. Hold the mouse button down and move the mouse up and down. The upward
motion raises the velocity value, the downward motion decreases it. The exact value is displayed
in the small field under the Event Type icon.

ﬁﬁf

U o

Editing a note’s velocity
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You can also click any point in the beam with the Pencil to change the value immediately.

If several notes are at the same position, you will only be able to see one beam. When you modify
the beam, all the notes at the same time position are affected. To edit individual beams in this
situation, use the Info Line as we’ve done in the past.

You do not have to click each and every note you want to modify. Press and hold the mouse
button, then drag the Pencil across the beams. All the beams will move according to the mouse
movement. The Toolbox contains a compass tool for special applications. Select it and the mouse

cursor appears as a crosshair.

The Compass tool

Find a group of about five to ten neighbouring velocity beams. Click a value somewhere between
0 and 20 in front of the first beam and drag the mouse to the right. As long as you keep the mouse
button depressed you can draw a line. Ensure the line extends from the first to the last beam.
Select a value between 120 and 127 for the last beam and release the mouse button. All the
velocity values of the group are scaled linearly according to the line you have drawn. The
following diagrams depict how this should look:

AT

Scaling with the compass. Before...

§;§§§EH

...and after

The compass can be used to create fade outs and other similar effects. You can include as many
events as you please. Draw the line as long as you like: the Controller Display is scrolled further
when you reach the left or right boundaries of the window with the dragged mouse pointer. The
line’s angle is up to you: you can scale upwards, downwards or horizontally.

8.3.14 Handling data in the Controlier Display

Cubase allows you to record non-note data and edit it, as well as manually create new data. Let’s
start with the former. You need a master synth capable of generating the necessary non-note data.
Most synthesizers incorporate performance controllers, i.e. one, two or three wheels or levers;
maybe ajoystick; various foot pedals and foot switches. For this exercise, we’ll choose the wheel/
lever/joystick used to generate vibrato or tremolo effects. You have read the MIDI chapter and
know that vibrato is MIDI Control Change #1. Do not use the pitch bender for this exercise, even
if your synthesizer allows you to route it so it transmits Control Change 1 events.

Create a new Part along these lines: record a four bar chord and at the same time move the
modulation performance controller (wheel, etc.) to its maximum position, hold it there for a bar,
then return it to the zero position before the end of the four bars. Later, of course, you can use
the synthesizer’s performance controllers to produce all kinds of data which can then be edited
to your heart’s content, but for now, please stick to the above example so you can follow the
exercise in the book.

Select Modulation from the Event Type pop-up menu. Cubase displays the most common non-
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note events by name, not by their MIDI numbers. Don’t worry if you can’t find all the MIDI event
types listed in the MIDI chapter: we’ll discuss those in due course. Cubase offers a separate
display for every conceivable event type, but only one can be displayed at a time.

The velocity beams are no longer to be seen, but nevertheless they still exist. Instead, a grey area
resembling the one in the diagram below appears. If you don’t see it, scroll back (using the
horizontal scroll bar) to the beginning of the new Part. Enlarge the Controller Display as
described at the start of this chapter to get a better view. Put the mouse pointer on the line between
the display and the grid and hold the mouse button down; the pointer appears as a hand. You can
now drag this double line up and enlarge the Controller Display.
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Modulation events in graphic form

Use the mouse pointer to go to the beginning of the modulation "mountain". Press and hold the
mouse button and drag the mouse to the right. The line you are drawing should entirely frame
the whole heap of data. Release the mouse button: the grey area is now highlighted in black. You
can delete the selected data via [Backspace] or [Delete]. The Clipboard can be used here too.
Before you start experimenting, here are a few important guidelines.

The data is selected

As you know from the MIDI chapter, movements of performance controllers can generate a great
deal of data. In this example, MIDI data is generated in two places. One is at the beginning of
the mod wheel, etc. movement (on the incline, up to a maximum value of 127), and the other at
its end (on the decline, down to a minimum value of 0). The Controller Display contains no values
in the area between these two places. The control change value remains at 127, as illustrated by
the central area in the following diagram:
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Data was generated in these two places only

We have just learned how to select data in the Controller Display. Try to select a small area
between the incline and decline positions. When you do, Cubase selects the two highest
neighbouring values (before and after the clicked point). In our example, these are the highest
point of the incline and the start of the decline.

Partially selected data

Select just the incline and delete it with [Backspace]. Not only is the incline gone, but also the
entire area until the next controller movement, i.e. the decline. This interrelationship will be very
important for our later work, as it is a prime source of confusion. You can only edit data that
actually exists, which was generated when the performance controller was moved: Whenitis not
moved, it ceases to produce data, and Cubase "fills in" the period of non-movement with a
graphic area that looks like the "real" data, but is in fact a visual trick.

Cubase does this for even the shortest periods of non-movement, so that the result of moving,
say, the mod wheel is a series of "steps” as the wheel is moved up and down: there is always one
event at the beginning of a "step”, but none between that first event and the next one, i.e. none
wherever the display is horizontal.

The beginning of the modulation is selected...
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...and deleted

Recall the deleted data with [Undo]. Let’s get started with some detailed operations. Sharpen
your crayons and let the art class commence.

8.3.15 Editing existing data

First we’ll reduce the maximum modulation value slightly to make the modulation less intense.
As we have seen that there’s always an event at the start of a step, the maximum value event must
be situated at the beginning of the long horizontal plane. Cubase helps you to locate its position,
so you don’t have to place the Pencil at the exact spot. Press and hold the mouse button and drag
the value down. The display in the Event Type value box shows the current value. Set it to 70.
The display should now look something like this:

The maximum value is reduced...

As you can see, we have decreased the maximum value, but the task is not finished yet. The
modulation overshoots at the start and end, so we must now modify the incline and decline to suit
the new maximum level. There are two ways to correct this. Place the Pencil at the beginning of
the modulation and slowly draw it up the incline until you reach the maximum value. The values
are scaled according to the Pencil’s movement. Smooth the curve out so that you have a gradual

T1S€.

...then the start phase is redrawn
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We’ll use a different method for the end phase. Select the compass from the Toolbox. Set the
compass at the projected beginning of the decline and draw a line down to zero, keeping the
mouse button pressed. Watch the value display of the Event Type box to ensure the end value
is actually 0.

The end of the modulation is redrawn with the compass

The next exercise involves adding the time dimension to our work. This time, we are not
modifying the maximum value, but the amount of time it takes to reach the maximum value. If
the curve starts earlier, the rise (and therefore the onset of modulation) is more gradual. The only
way to achieve this effect is to create new modulation values. Until now, we’ve only modified
existing data with the Pencil. To produce new data, hold [Alternate] down while drawing with
the Pencil.

Before we start, here’s another important piece of information. Values are generated at the
positions defined by the Snap function only. We’ll soon see what this means in practical terms.
For our first exercise set the Snap value to "Off".

Hold [Alternate] down and draw a curve with a gradual rise. The angle determines the length of
the rise. Your curve should resemble the one in the following diagram.

This is what our new modulation could look like

You could also use the compass to achieve the same effect. Here too, hold [Alternate] down. New
events are generated along the line the compass is drawing.

Now delete all the data by selecting the area and pressing [Backspace] or [Delete]. You can also
use the Eraser from the Toolbox, but keep in mind that it only deletes single event values, never
an entire group of events. If that is the aim of your work then choose "Delete Cont. Data" from
the Functions menu. It deletes all the non-note events of the Parts in the Editor.

You are probably still waiting for an explanation of how the Snap function relates to the
Controller Display, so here itis. We’ll draw a new curve, first setting the Snap resolution to "4",
which denotes quarter notes. You will find that only coarse increments are possible because
Cubase is inserting the new events at quarter note positions. However, this is not subtle enough

for modulation. '
J
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You must use the Snap function to determine what resolution you want for the events. The ideal
compromise is to find a resolution where the events are close enough together so that they do not
produce audible steps between the events (this largely depends on the type of MIDI data you’re
generating: the human ear is more sensitive to pitch changes than to minor modulation intensity
differences) but not so close that you are using an unnecessarily large number of events for the
job in hand. In other words, use the coarsest Snap setting you can get away with. Controller
Display drawings at the "Off" Snap setting create a great deal of data: too much data places a
heavy load on the MIDI system, and may lead to timing problems.

The following is a good rule of thumb: draw non-note MIDI data at Snap settings of "Off" or
"PP". Then choose "Reduce Cont. Data" from the Functions menu. Cubase deletes what it
considers to be the superfluous events from the data you have drawn: you won’thear adifference,
but the MIDI system’s load has definitely been lightened.

8.3.16 A few facts about individual event types

Now that you know how to handle the Controller Display, let us discuss the characteristics of
some of the event types in the Controller Display. Some of this information is dictated by the
MIDI standard. Let’s go through the event type pop-up menu list.

Pitch Bend data can go up or down; this is why Cubase divides the Controller Display into two
horizontal halves. Downward pitch changes are drawn in the lower section, those going up in the
upper section. The center position has a numeric value of 4096 and is displayed in the field under
the Event Type box. Keep in mind that the maximum pitch bend range is defined by the internal
setting of the receiving instrument, and by not the MIDI values it receives: these determine the
amount.

What Cubase calls "Aftertouch” events (MIDI Channel Pressure) can be handled the same way
as Control Change data, as illustrated by the modulation exercise above. We covered velocity
in the first exercise.

Poly Key Pressure represents a special case. As you know, Poly Key Pressure is aftertouch
information for each individual key. Poly Key Pressure requires a graphic display to be able to
show pressure amounts for each individual key even if the notes are at the same time position
(such as in a chord). The Controller Display cannot do this on its own: you have to combine it
with the Logical Editor, which we’re covering in chapter 13 "The Lo gical Editor". For now, read
and remember the following operation, and we’ll run through a practical application in the
Logical Editor chapter.

Draw Poly Key Pressure data at the first note’s position. Cubase automatically assigns the C3
pitch to new Poly Key Pressure data. Alter this C3 to match the pitch of the note with the help
of the Logical Editor. This is explained in detail in the Logical Editor chapter of this book. The
amount values can be left as they are. The pressure values can now no longer be seen in the
Controller Display. Now draw Poly Key Pressure events for the next note. Convert the C3 to
match this next note using the Logical Editor, and continue in this way.

You can draw Program Change data, but it’s much better to use the List Editor (see below).

Modulation, Breath Control, Foot Control, Main Volume, Balance, Pan, and Expression are all
functions of the MIDI Control Change status and can be drawn in the usual manner. Balance and
Pan are similar to Pitch Bend in that they can go up and down (actually, left and right) and feature
a center position.

Damper Pedal (also called sustain foot switch) is another special case. We have seen in the
section on Control Change events in the MIDI chapter that this type of event is assigned different
resolutions in the MIDI standard. Control Change #64 is responsible for the damper pedal. In
theory, it has aresolution of 128 steps, butasit’s a switch, only the values 0 (pedal not depressed)
and 127 (pedal depressed) are recognized.

This is why some event types that act as switches allow you to enter only two values (0 and 127)
in the Display. Try to enter damper pedal data and you’ll soon see how this works.
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Switch-type events are limited to two values: 0 and 127

You have several options if you want to use an event type not included in the event type pop-up
menu. To temporarily insert a new event type, choose Unknown Controller from the Event Type
menu, and a dialog box appears where you can select any MIDI Control Change event.

Click and hold the arrow next to the "Control 0" field. Yet another list appears. You can scroll
through the list keeping the mouse button pressed, and as you do this, the selected event name
highlights. As soon as you reach the arrows at the end of the list, the list is scrolled on and you
can read the event names that lie "beyond the horizon". Release the mouse button once you have
found and highlighted the desired name. This Control Change name is then adopted by the event
type menu list. If your Part already contains these events, you will suddenly find them displayed
since the Controller Display can now recognize them (it only recognizes data that is listed in the
pop-up menu). You can now also draw the new event values in the Controller Display. Keep in
mind that each MIDI event type has its own display.
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The "Unknown Controller” setting on the left, and a part of the MIDI Control Change list
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It can be useful to permanently add two additional MIDI Control Change events to the Event
Type menu if you’re going to be using them regularly - this would avoid having to redefine the
"Unknown Controllers" each time. Click the Event Type box once with the right mouse button.
A dialog box appears. Define the two Control Changes as described above. When you click Exit,
the two Control Changes are inserted in the Event Type list and direct access to them is now
possible.

8.3.17 Some thoughts on the Controller Display

- Instruments vary quite radically in their respective MIDI capabilities, especially regarding non-
note events. Take a quick look at your devices’ MIDI Implementation Charts to find out what
type of data they can process. Generally, the Chart shows all the available events that a device
supports. Many devices can receive and process more event types than they can send. This
happens often with Poly Key Pressure as it is easier to receive than to send. The keyboard
hardware needed to send Poly Key Pressure is expensive and complicated.

- Lots of non-note data is designed to work in conjunction with notes only. After all, it doesn’t
make much sense to draw data such as either sort of aftertouch, modulation, damper pedal, etc.
for a Part that does not contain notes.

- To stop the effect of modulation, pitch bend and so on, it must be returned to its zero value. This
can lead to problems, especially if several Parts are situated one after another on a Track. Say
you draw a damper pedal On command prior to the end of a Part without the necessary command
to end it. The command tells all notes in the following Parts to sustain the notes. Although Cubase
will automatically correct some problem areas - especially those involving pitch bending - you
should still keep potential problems in mind when drawing and editing non-note data.

- Ensure the Reset on Part End function in the MIDI Setup dialog box is active. This ensures that
certain event types (Pitch Bend, Control Change 1 (modulation), Control Change 64 (sustain),
Channel Pressure (what Cubase calls "Aftertouch")) are reset at the end of a Part. This can avoid
some of the problems discussed above.

- Reset on Stop is a valuable tool as well: it sends All Notes Off and Reset All Controllers
commands every time you stop Cubase. Notes that don’t receive a Note Off command because
you stopped Cubase before they arrived are switched off anyway, and all non-note data is reset.
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O The List Editor

Commands are almost identical in all of Cubase’s Editors. Once you are familiar with the
handling in one Editor, you will quickly get used to the others. Lots of operations discussed in
the Key Editor chapter apply to the List Editor as well, though you will find some differences
because the List Editor is different in concept.

Either a selected Part or all of the Parts of a Track can be presented in the List Editor. To display
the whole Track, ensure none of its Parts are selected. It is not necessary to return to the Arrange
window prior to entering the List Editor - you can directly move back and forth between Editors.
For example, if you leave the Key Editor to go to the List Editor, Cubase automatically closes
the Key Editor.

You can also call up several Editors at the same time by pressing and holding [Alternate] while
calling up the Editors.

This allows all sorts of configurations:
- different Editors with different Parts,
- different Editors with the same Parts,
- identical Editors with different Parts.

The one general limitation is that a maximum of seven windows can be opened at one time. If
you have opened several windows, you’ll have to watch their sizes, depending on how big your
monitor is. The Windows menu’s Tile Editors command is a handy function for this purpose as
it allows all the selected Editors to be displayed on the screen, each of which has the largest
possible dimensions for the configuration you have selected.

Seven windows still take up a lot of space and will appear rather small, so a large-screen monitor
is definitely an advantage. Those of you with 12" screens can still work with several Editors at
atime if you use the Tile Editors command to help you optimally position all the selected Editors
on the screen. The Full button at the upper right corner of the active Editor enlarges it to its
maximum size. Another click returns it to the smaller format.

Remember that only one window can be active at a time. The Song Position Triangle runs in the
active window only. To activate a window, click it anywhere within its borders. Although only
one window is active, all the Editor windows are affected by changes in the active one: changes
made in one Editor are immediately adopted by the other Editors.

If aPart is contained in an Editor, it cannot be copied, deleted, moved or shortened in the Arrange
window.

Selectany Part in the Arrange window and go to the List Editor via the Edit menu ([Control][G]).
Double-clicking the Part serves the same purpose, provided the Preferences setting for the Track
Classes is correctly entered. The new window looks something like this
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The List Editor

The Functions Bar is identical to the one in the Key Editor, with a few minor differences. You
won’t find an Info Line, nor is one required, as you will see.

Two large areas occupy most of the Editor. The right side should remind you of the Key Editor’s
grid; the left side lists numerical values whose meanings depend on what’s in the active Part(s).

You can change the size of one half in relation to the other by dragging the vertical dividing line
that lies between them to the left or right.
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The grid display has been enlarged
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And now the event list has been enlarged

The List Editor does not have a Controller Display. The window’s right edge contains two items
you’ll recognise from the Key Editor: the scroll bar and the beam display.

You can zoom the window’s display scale in the same manner as for most of the other windows:
horizontally (for the grid only) and vertically (for the grid and the list). To do this, click the
appropriate arrows in the scroll bars with the right mouse button. For now, leave the List Editor
window at its original size.

9.1 The event list

The screen’s left half contains the event list. All the events of a selected Part or Track are
displayed as lines of text, one below the other, in the order in which they occur. The following
diagram depicts a note (Status column) at position 1.1.0 (Start Position), whose pitch is C3
(Value 1) and 96 ticks long (Length), which is a 1/16th. The note was played with a velocity of
32 (Value 2), and the release value is 64 (Value 3). The MIDI channel the Track was originally
received on is displayed to the right (but this is not necessarily the MIDI channel that Cubase is
transmitting this T k on, as that’s determined by the Arrange window settings).

«
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The parameters of one Note

You can edit almost any of these note parameters immediately by simple clicking. This selects
the event. Editing is the same as always: left or right mouse button click; or double-clicking
followed by typing in the input box that appears. If you move the Start Position value beyond the
preceding or following event’s position, the event is moved to a new position in the list.

You cannot change the status of most events in this Editor. The list displays all the events’
statuses you recorded in the Part, i.e. Notes, Control Changes, Program Changes, etc. plus a few
special Cubase events. Not every event has a value for each of the list’s columns. For instance,
notes are the only events featuring a Length value, Control Changes do not have a pitch value,
etc. The exact structure of individual events is dictated by the MIDI data format.

However, all events have a time value in the Start Position column. You can delete a selected
event from the list via [Backspace] or [Delete].
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9.2 The events’ statuses

Let’s take a closer look at the different types of event (we call them "statuses' as that’s what the
List Editor calls them) and the settings available for them. Please note that the events we’ll be
looking at can display all sorts of different combinations of values; it’s not possible to discuss
all the countless permutations of possible values, but we don’t actually need to as events follow
rules which they never break.

You can only see events on your screen if you have actually recorded them in the computer’s
memory. In this book, we haven’t yet done that for all events. There are also types of event that
cannot be recorded nor sent out via MIDI, but are created in the List Editor only. We will do
experiments to show how you can modify as well as create data in the List Editor.

The following explanations are each supported by illustrations showing you how the operation
should look on your screen. Keep in mind that types of events that give out "continuous" data
(Pitch Bend, Channel Pressure, Poly Key Pressure and some Control Change messages) generate
a great deal more than just one single event.

9.2.1 Control Change

The list displays two numeric values next to the start position. Value 1 defines the Control
Change number, i.e. modulation (#1), volume (#7), etc. Value 2 is the Control Change’s amount.
The Status column confirms that the event is a Control Change and lists its number again.

|_STRRT-F*OS ] LENGTH l VAL IUFILZ I VALS I STATUS lCHN I COMMENT !

S I s 68 32 -—— Control 68 1

MIDI Control Change 60, amount 32, at position 1.1.3, recorded on channel 1

Record some Control Change events (no notes) in an empty Part and return to the List Editor.
There are four ways to move through the list: using the computer keyboard’s up/down cursor
keys, fast forward and rewind, the vertical scroll bar, and by starting playback.
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2, 2,253 ————— 1 88 —--— Hodulation 1 k
2., 2,259 ————— i1 88 --— Modulation 1
2, 2.276 ————— i 82 --- Modulation 1
2, 2.282 ————— 1 82 --- Modulation 1
2, 2.32y ————— 1 &4 -—- Modulation 1
2., 2.337 ———=- 1 86 -—— Modulation 1
2, 2.344 ————— 1 86 -—— Modulation 1
2, 2.392 -———- 1 88 —-—- Modulation 1
2, 2.378 ————— 1 98 --—- Modulation 1
2. 2.375 ————— 1 91 —-— Modulation 1

A single movement of the modulation wheel produces all these events,
as displayed in the List Editor

An arrow appears down the lefthand side of the Event List, pointing to the event that is currently
being played. Choose one of the four positioning options and move through the Event List.
Depending on the type of MIDI status you have just recorded, you can see how some generate
a large amount of data.
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9.2.2 Poly Key Pressure (aftertouch)

Poly Key Pressure can generate even more data, especially if you are not aware that it is active:
each key can generate up to 128 amount values. In addition to its position and status, each Poly
Key Pressure event has two values: the key pressed (Value 1) and the amount of pressure applied
to the key (Value 2).

| START -POS | LEMGTH IUFiL 1 IUFILE I VALS I STARTUS I CHN I COMMENT ]

1.1, 2 ——- C3 32 ——- Poly-Press 1

Poly Key Pressure on C3, amount 32, at position 1.1.2, recorded on Channel 1

9.2.3 Channel Pressure (aftertouch)

Steinberg call MIDI Channel Pressure events by the generic term "Aftertouch” which is
misleading since the description "Aftertouch” applies just as much to Poly Key Pressure events.
Bear this in mind when you see the status "Aftertouch” in the List Editor - they are referring to
Channel Pressure. Either way, the list shows the position and the Value 1 value which defines
the amount of pressure applied to the keys (remember that Channel Pressure is monophonic -
apply aftertouch to one key and it affects all the notes on the same MIDI channel).

| START~-FOS l LENGTH IUHL 1 | VALE lUFlLB I STATUS lCHN ]COMMENT |

t. 1. 59 ———- 60 -—- fftertouch 1

Channel Pressure amount 60, position 1.1.5, recorded on Channel 1

9.2.4 Program Change

This event also has just one variable value (in the Value 1 column). It determines which program
is selected in your synthesizer. As with all the events in the list, this event is immediately sent
to your synth if you click or edit it when the Ear icon in the Functions Bar is active.

| START -FOZ | LENGTH IUﬁL 1 | UALZ i VALZ ISTFITLIS l CHM I COMMENT

1. 1. 4 ———— 61 -—— ProgChange 1

Program Change to program number 61 at Position 1.1.4

9.2.5 Pitch Bend

The Pitch Bend status has two variable values, scaled from 0 - 127. Pitch bending can go up and
down, so the Value 2 column’s resting value is 64 (not 0!), and Value’s 1’sis 0. Very few MIDI
devices actually use the high resolution made possible by the combination of these two values.

I START-POS | LENGTH ]VFIL 1 ' YALE I VAL l STATUS lCHN l COMMEMT l

1. 1. 6 ———- 68 32 ——- Pitch-Bend 1

Pitch Bend amount 60 + 32, position 1.1.6, recorded on channel 1

9.2.6 System Exclusive

As you know, this data is device-specific. Cubase displays the manufacturer ID in the Status
column, provided it is known. Value 1 displays the MIDI channel or device number sometimes
contained in SysEx messages. Change this entry only if you want to send this message on a
different MIDI channel or to a different device. If you have no experience of working with SysEx
data, please don’t change anything as you may corrupt sound data.
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[ STRART-FOS ] LENGTH I VAL I YALZ | YALS | STATUS I CHH l COMMENT J
t. 1. ¢ = 68 -—-- Suskx 1 F?
A SysEx event header

If you move the dividing line between the list and the grid all the way to the right, you will see
more columns. The Comment column lists the beginning of a SysEx message.

SysEx messages can be very long, depending on the device and type of message, so Cubase
displays the initial bytes only. The remaining data is stored, but not displayed.

You can also edit SysEx messages. Click the Comment field, and the following editing line
appears:

The SysEx editing line

This editing line contains the SysEx message in the hexadecimal format. The Atari’s cursor keys
are used to access individual values to change them. This editing method is suitable for short
SysEx messages only. If you try to work on a message that is too long, Cubase will warn you with
an alert box:

That's too much!

DK

You can edit brief SysEx messages only

If you are unsure about what you are doing, don’t change anything. SysEx data cannot be
auditioned while you are in the Editor, so you must do it from the Arrange window. You’ll be
introduced to better ways of generating and editing SysEx data later in the book.

9.2.7 Special Events

These are Cubase’s internal control commands which you can use to tell Cubase what should be
done. The Status column displays the type of Special Event. You canclick the Status field in order
to move between the different types. Special events, like SysEx messages, are transmitted during
playback only when you are in the Arrange window, so close the Editor before you start the
playback.

9.2.8 Text events

Text events are simply comments that you can enter in the Editor, such as naming SysEx
messages. No MIDI data is generated or modified. Click in the Comment column and type in the
desired text in the entry line that appears. Confirm it with [Return], and the text is entered in the
Comment column.

The other values shown are of no relevance. Text events can be created in the List Editor only,
and then only manually.
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I ETART-FOS | LENGTH | VAL | YALE I YALS l STATUS | CHMN ICDMMENT I

1.1. 8 ——— 68 32 ——— Teut

Text is entered in the Comment column

9.2.9 Mute events

These events are created when you mute/unmute a Track during recording (refer to the Arrange
chapter). Value 1 denotes the Track, Value 2 denotes whether a Track was muted (value = 1) or
unmuted (value = 0).

r =TART -FO= | LEMGTH [URL 1 IUH L= IUH LS |STF’|+US ICHN ICOMMENT |

1. 1. 9 ————— 1 8 ——— Track-Mute -- Drums

Track 1 entitled "Drums" is unmuted at position 1.1.9

9.2.10 The Stop event

This function allows you to set a Stop point where Cubase ends the playback. You can see how
this might be helpful in a live situation. You can line up several songs in an Arrangement and
separate them with the Stop command. Cubase plays the first piece, stops at the designated point,
and starts the next piece when you activate playback again. You could insert an empty bar
between the two pieces, and add a count-in to it. Stop events are created exclusively in the List
Editor.

l START -FOS I LEMGTH |VAL1 | VALZ ‘ VALZ I STATUS I CHH I COMMENT |

1. 1. 18 —~-—— ——=- --- Stop -

Cubase stops at position 1.1.10

9.2.11 MIDI Mixer events

MIDI Mixer events are those which have been generated in the MIDI Mixer. For now, it suffices
to know that Value 1 denotes the object number, and Value 2 its amount. Both values can be
edited. The Comment column contains the name of the object and the instrument to which it is
assigned. Right now, you are probably wondering what the purpose of this information is: we’ll
get to these events in due course.

| sterT-Pos [Lenat Jwars |vaiz [vaLs |[sTATUS ok | commenT |
1. 1. 8 ———— 7 1 ——— Mixer -— poL1e -
A MIDI Mixer event

9.2.12 The Display Filter

If you want to work on specific types of events only, it may be distracting to see all the other types
in the list. Cubase has something called a Display Filter, which you’ll find situated between the
Loop and MIDI In icons.

HO FF CT
FC AT FE

The Display Filter

Six different event types can be filtered out of the display. Click NO, and all the notes in the event
list disappear. Poly Key Pressure (PP), Channel Pressure (" Aftertouch") (AT), Program Change
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(PC), Pitch Bend (PB) and Control Change (CC) events can be filtered out of the display by
simply clicking the desired type. The events themselves are not deleted, but continue to be heard:
it’s just that they are excluded from the graphic display.

<> File Edit Structure Functions Options Modules Windows

== List - Track 5, a, 9.
EGoto  E All ElFunction BMask |snvee 16 [ 1. 1 =Y i
—~——t—-—1——— [1ns. Note louent 16 1, 1. 6|i=lrcheTre
START-FOS [renatr Juscs  [vaiz [vavs [stATus [ern | commend

1. 4.221 ————~ 64 127 —-—- Damper Ped 1 I

1. 4.372 68 A¥2 93 41 Note 1

2. 1. 8a 63 bG#2 83 53 Note 1

2. 1.178 48 F#42 98 67 Note 1

2. 1.278 34 G2 112 93 Note 1

2. 2. 85 58 F2 73 29 Note 1

2. 2.186 38 D3 66 39 Note 1

2. 2.368 ———- 64 A -—- Damper Ped 1

3. 1.188 ——~ 64 127 ——— Damper Ped 1

3. 3.3687 188 A#3 96 18 Note 1

3. 3.352 ———- 64 8 ——— Damper Ped 1

3. 4. 21 83 G3 74 64 Note 1

3. 4. 34 ~———- 64 12?7 -—— Damper Ped 1

3. 41721 53 F3 63 37 Note 1

<» File Edit Structure Functions Options Modules Windows

CANCEL d i 0 i
EGoto B ATl BFunction EMask |snap 16 1. 1. @8 Gno FP CT @ in
1. 2.192 |ins. Mote quAnT 16 | 1. 1. @ FC AT P & nd
START ~FOS l LENGTH l vAaLi | VALS | VALE I STATUS l CHN ICOMMEN'I E z2 ) a @
1. 4.221 ——--- 64 127 -—— Damper Ped 1 ' T
2. 2.368 ———— 64 # --— Damper Ped ]
3. 1.188 ————~ 64 127 -—- Damper Ped 1 'S
3. 3.3%2 ———- 64 @ -—— Damper Ped i
3. 4. 34 ————~ 64 127 --— Damper Ped 1
4, 3.168 ———— 64 8 ——— Damper Ped 1
4, 3.186 ————~ 64 127 —--- Damper Ped 1
4, 4. 32 ————- 64 B8 -—— Damper Ped 1
4, 4. 8¢ ————- 64 127 -—— Damper Ped 1
5. 1. 5% -——— 64 A --- Damper Ped 1
5. t.116 ————~ 64 12? --- Damper Ped 1
5. 1.188 ————— 64 f -——- Damper Ped 1
9. 1.292 ———- 64 12? -—— Damper Ped 1
5. 1.345 —-———— fd A —-- Namper Ped 1

A piano Track with and without notes in the display. Only the sustain pedal events remain

The Display Filter shows if data is being filtered from the display: capital letters mean that the
status is not being filtered; lower case letters mean that it is. Special Events are always displayed.

9.2.13 The Grid

Let’s take a look at the other half of the Editor. Every event has a corresponding beam in the grid
located in the right half of your screen, whose length varies according to the event. Select any
note in the list. It becomes highlighted, and at the same time its graphic beam in the grid is
selected. List entries and their grid beams always share the same horizontal line.

The rest of the grid display is similar to that of the Key Editor. An event’s position and length
can be read off in the Position Bar. Its velocity value can be changed via the beams at the right
edge of the window. When you move the mouse pointer over the velocity beams, the pointer
becomes a Pencil; click a beam and change its length by dragging it to the left or right. Its current
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valueis displayed in the eventlist. The pitch of note events and the status of an event are displayed
in the Event List only.

Modifying a velocity using the Pencil

9.2.14 What the Editors have in common

Only within the grid does the List Editor offer lots of functions that you will recognize from the
Key Editor. Since we discussed these functions when we covered the Key Editor, all you need
is a memory refresher:

- Key Editor functions such as dragging events, copying with [Alternate], deleting, selecting
several events with [Shift] or with the rubber band, etc. can all be used in the List Editor’s grid
as well. Try out all these variations. Note that if you move an event in time, the list to the left takes
a moment to restructure itself according to the event’s new position. This may lead to a little
confusion, but the event you selected remains selected.

- The Toolbox is also at your disposal. Press the right mouse button and select a tool. All tools
have the usual functions, except the compass which has no function in this Editor.

X (B
QJZ]]»

The familiar Toolbox

If you have entered a complete Track in this Editor with all its Parts, the events of the currently
active Part are framed in black. The events in the inactive Part(s) are framed with a dotted line,
the same way they were in the Key Editor. Activate a Part simply by clicking one of the dotted
events.

- The familiar edit-loop function and Goto, "selection” and Function sub-menus are also
available in the List Editor. Use them at your discretion. If you have trouble remembering exactly
how they work, look in the Key Editor chapter.

oo B

Song-Pos All Events Fided Note
First Event Looped Events Delete Note
Last Event Cuycled Events Keep Mote
First Selected Selected Events Repeat

Next Selected Looped Selected Ev. Fill

Last Selected Cycled Selected Ev. Reverse
Prev Selected Delete

Next Part

Prev Part

All the Key Editor options are available in the List Editor
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- Note On velocity, pitch, and release velocity values can be changed via MIDI: use the icon
functions. Their uses are identical to those in the Key Editor.
- The Clipboard can be used as usual.

9.2.15 Creating events

The step input method for notes that we saw in the Key Editor works here too. Activate the Foot
icon and the notes are inserted at the current song position.

The Quantize value determines the event’s length, the Snap value the time interval between
events. The [Tab] key, Insert function and the "In" icon function as in the Key Editor. Keep in
mind that with all Editors, events can be entered in the active Part only.

The List Editor features another new way to create events. Enter an empty Part in a blank Track
and return to the List Editor. Activate the Pencil from the Toolbox. Click and hold the Insert box.
Select the event type you wish to create. All the events discussed above are available. Let’s
choose a note event. Click the desired position in the grid. This creates a C3 note whose length
is specified by the Quantize setting and whose position is determined by the Snap value.

Asin the Key Editor, velocity values are affected by [Shift], [Control], or a combination of both.
If you don’t release the mouse button when you insert a note, you can simultaneously determine
its length - we saw this in the Key Editor as well. New notes are always assigned a pitch of C3.
Set the desired pitch in the Event List. In contrast to the Key Editor, not only can you create notes,
but all other event types, too.

9.2.16 A review of the List Editor’s special functions

Although the List Editor can do so much, it’s a fact that each Editor is better at some things than
at others. Let’s look at a few examples. Moving a pitch bender, volume pedal, etc. can produce
vast numbers of individual events. In theory, you could create these events step by step in the List
Editor, but it would simply take too much time. Instead, use the Controller Display of the Key
Editor which allows you to "draw" events.

The situation with Program Change events is different. They are difficult to generate in the Key
Editor, sodoitinthe List Editor. To create events such as "Stop" and "Text", which can be created
in the List Editor only, insert them into the grid first then edit them in the list.

The following paragraphs list operations that are easier to execute in the List Editor than in the
other Editors:

- Select the Program Change command from the Insert menu. Click the event at the desired
position in the grid using the Pencil-pointer that automatically appears. The event will also
appear in the list. Enter the required program number in the Value 1 column. If the Ear icon is
active, the changes are sent via MIDI to the synthesizer whose receive channel matches the
Track’s MIDI channel, allowing you to immediately audition the Program Change.

- Delete the event(s) you have just created using "Delete” in the Function menu. Select the Stop
command from the Insert menu and click it at the desired position in the grid. Ensure that the
eventis at a position beyond 1.1.0. Position 3.1.0 is fine for our purposes. Press [Return] to close
the Editor and start playback from the beginning. Cubase stops at the position where you inserted
the Stop event.

- Goback to the List Editor and delete the Stop event. Select Control Change from the Insert menu
and enter a Control Change event in the grid. It defaults to number 0, with an amount of "0". This
Control Change event, combined with Control Change 32 as an "MSB/LSB combination",
denotes the relatively new Bank Select command. Let’s assume that you want to access the
various internal sound banks of a Korg Wavestation (as it happens, the Wavestation uses the LSB
value (control change 32) only and ignores any MSB (control change 0)): enter a Control Change
0 event at the desired position in the grid and change it to Control Change 32 in the list. Its Value
2 determines the bank number: a value of "0" selects the RAM 1/2 bank, "1" the ROM/Card bank.
You then must follow this by specifying the program within the bank using a Program Change
event.
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-Keep in mind the following: according to the MIDI standard, the Bank Select command should
consist of an MSB/LSB combination. However, the Wavestation ignores the MSB value, so you
don’t have to use it. Other devices may process Bank Select commands differently, so be sure
to always take a look at the MIDI Implementation Chart of the device in question.

- Unfortunately, the number of devices capable of understanding Bank Select commands is rather
limited at this time. Those that cannot, simply ignore them.

- The Key Editor is usually the preferable option for inserting and editing notes individually as
the display is clearer and can show more notes at a time. If you still prefer the List Editor, use
its display filter to simplify matters.

- The Mask, found only in the List Editor, is a valuable function. The Display Filter suppresses
one or more complete statuses from the display; Mask, on the other hand, allows you to exclude
certain events from any editing you are doing, e.g. using the commands in the Function sub-menu
next door.

- Proceed as follows: supposing you accidentally entered a C4 note in a Part several times, select
the note in the event list and click and hold the Mask sub-menu: select "Mask It" from the menu
that appears. Now select Delete from the Function sub-menu, and all C4 notes are deleted from
that Part. Select "No Mask" from the Mask menu, and all other events reappear.

- You can see that Mask It selects all the identical events in the Part and allows you to process
them. "Identical" means that the status and the Value 1 column value have to be the same. "Mask
Event Type" is used to mask all the events of a certain status. For our example, this would mean
that all notes, not just C4’s, are masked. One conceivable Mask application is deleting
undesirable aftertouch data. The following diagrams illustrate how this is done.

<> File Edit Structure Functions Options Modules Windows
ack 6 g :
B Goto  E Al BFunction BMask |snee 16 | 1. 1. 8 NO PF CT| y 4 In
—————— i——= |ins. Hote lounr 16 | 1. 1. |G PC AT PE @lj 4 w >
STRRT -FOS l LENGTH | VAL1 I VALZ IUFILB I STATUS ICHN lCOMMENT E -1 = 4 IZI
1. 1. 88 1981 A3 32 48 Note 1
1. 1. 88 26883 F3 58 29 Note 1
1. 1. 88 2819 C3 3a 9 Note 1
dfterto
1. 2.381 --——- 16 -—— Aftertouch M1
1. 3. 35 ——-- 127 ~-— RAftertouch 1
2. 1.153 ———~- 125 -—— Aftertouch 1
2. 1.215 ——- 37 ~-— RAftertouch 1
2. 1.2449 ———- (3] --— Rftertouch 1
2. 3.187 340 E3 61 19 Note 1
2. 3.188 343 63 5? 18 Note 1
2. 3.199 361 C3 43 3 Note 1
2. 4.319 1336 653 61 15 Note i
2. 4.324 1128 C3 61 27 Note 1
Select the first Channel Pressure (aftertouch) event in the event list.
< File Edit Structure Functions Options Modules Windows
: f i :
EGota B All &l Function 16 | . 1. 8 MO FE CT| : e E
————t=—:1——~ |1nz. Mote| No Mask . 1. @ G FC AT P @ ) sl nd
START ~-POS | LensTH IUHL Mask It [chn | commenT 2 3 4 2]
1. 1. 88 1981 Mask Event Tupe | 1
1. 1. 88 2883 F3 58 29 Note 1
1. t. 88 2819 C3 38 9 Note 1
H 1
{. 2.381 ————- 46 -—— Rftertouch 1
1. 3. 35 ———- 127 --— fAftertouch 1 !
Activate Mask Event Type.
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& File Edit Structure Functions Options Modules Windows
Dooto WA | orunctin Bttasicjmer 181 1 . R A RS
START-FOS |Lensth juaLt  |vecz JvaLz [sTRTus |ehn jcommeEnT W = 3 a 2]
1. 2.381 ———- 46 -—— Afte uch 1
1. 3. 35 —~——- 127 --- Aftertouch 1
2. 1.153 ———- 125 --—- Aftertouch 1
2. 1.215 ———- 37 -—— Aftertouch 1
2. 1.249 ———-- [i] ~--- Aftertouch 1
3. 1.261 ——- 46 --—- Aftertouch 1
3. 1.267 ———- 73 --- Aftertouch 1
3. 1.2?3 —~——- 96 --— Aftertouch 1
3. 1.299 ———-— 127 --- Aftertouch 1
3. 2.386 ———- 125 --— fAftertouch 1
3. 2.311 -———- 92 -—- Aftertouch 1
3. 2.318 ————- 37 --- Aftertouch 1
. 2.34% --——— 7] --=-  ftartnurh 1
Gl P
The list now displays Channel Pressure events only.
<» File Edit Structure Functions Options Modules Windows
EGote B Al BMask snae 16 | 1. 1. 8 } &
———=it——t—=- |1 Fixed Note 16 | 1. 1. @8 AT *
START -POS Delete Note vAL=|stATus Jemn | commenT z = a
Keep Note g
1. 2.381 Repeat —-—- Aftertouch 1 o
1. 3. 35 Fill --—- Aftertouch 1 e
2. 1.153 Reverse -—- Aftertouch 1 O 7TTUmommeeRe S
2. 1.215 -—= RAftertouch 1 E]
2. 1.244 ——-—- a --- Aftertouch 1
3. 1.261 —---- 46 --- Aftertouch 1 o

Ensure you activate All Events, then choose Delete in the Function sub-menu.

<> File Edit Structure Functions Options
EGote B AN BFunction BMask lsuee 16 | 1. 1. ]
~———t==i——= |inz, Note fousnt 16 | 1. 1. @

Modules Windows

START -FOS

fLenaTh JuaLt |uaLz

I VALE | STATUS

All Channel Pressure events are deleted.
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< File Edit Structure Functions Options Modules Windows

BlGoto B Al B Function . 1. 8 MO FF
————t~——t——— |tns. NoOTe . 1. B [} PC AT I||@I|
START-POS lenatn |va Mask lenn | commenT E E 4 2]
Mask Event Type I i
&

¢l >

Now choose No Mask....

< File Edit Structure Functions Options Modules Windows

BGoto E AN B Function BMask lsnee 16 | 1. 1. @ FP

2 n

—=—=it-=i-—— [ins., Note lowent 16 | 1.1 a PC AT I-J._[_ﬁ [:
a  [2]

.
START-POS |enarr Juacs |uacz |Bacs [status Jern | commenT = E

i. 1. 88 2819 C3 36 9 Note 1 |
2. 3.187 348 E3 61 19 Note 1 -
2. 3.188 343 63 57 18 Note 1 -
2. 3.199 361 €3 43 3 Note 1 =
2. 4.319 1336 63 61 15 Note 1 (o)
2. 4.324 1128 C3 61 27 Note 1 L
2. 4.325 1851 F3 82 47 Note 1 -
3. 3.346 163 E3 5?7 38 Note 1 -
3. 3.361 1?1 €3 66 6 Note 1 -
3. 4.295 868 63 43 127 Note 1 L
3. 4.3089 849 D3 46 119 Note 1 ]
3. 4.316 829 €3 59 81 Note 1 |

&l D

...and the notes return to the display.

Although you will encounter even more powerful editing tools, the Mask function is still a quick
and easy way to process specific data of your choosing.
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1 0 The Score
Editor

The Editors we’ve looked at so far mainly rely on numerical graphics for editing operations; the
Score Editor, however, is designed for those who prefer to work a bit more musically as it
displays notes as regular notation.

The Score Editor is similar to the other Editors in many respects, so you should be able to find
your way about it fairly quickly. It has two basic functions: editing notes in the context of a
sequencer application, and management of staves and score. This chapter is concerned with the
editing function; we’ll cover its other faculties in a separate chapter.

We have mentioned before that the Score Editor is a Cubase module, which means that you must
load it separately after Cubase is first started as described in chapter 7 on "Special Functions".
If you habitually work with this Editor, you can have it load automatically whenever you start
Cubase.

We need to define what is meant by a:
- Staff: a line of bars belonging to the Parts of one Track, e.g. "drum staff";
- Staves: the plural form of "staff", i.e. one staff, two staves;

- System: two or more staves that "belong together", e.g. a string quartet’s staves constitute a
system if they are included in a "score" (see below);

- Split System: sometimes called a double-staff or piano staff, this is where a Part is divided into
a treble staff and a bass staff, e.g. "piano system";

- Score: what the conductor would look at, i.e. the entire collection of the music’s staves arranged
one below the other, e.g. if the string quartet (see above) were on its own, its four staves would
constitute a score.

10.1 The relationship between Parts/Tracks
and the notation

Cubase presents all selected Parts in the Score Editor. If no Parts are selected, it presents all the
Parts of the active Track. Because Cubase is Part-oriented, the Score Editor display is dependent
on the type and number of Parts presented in it. The following examples should help to explain
this.
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Track

Drums | Track 1 iTrack 1 |Track 1 |Track 1

Bass frrack = [Track & |Track & |Track €

Strings | Track = iTrack 3 ITrack 3 |Track 3

Piano lFians :

Bass

ol 2

BF - S N :
: \ p— A \ - e — \ ]
I ERIFIRT T FF EIIIE R I

A 3 4

s . .

B3 dasecac 3 K eI @ @ g

A Part in the Editor

If you enter a Part of one single Track, Cubase displays as many bars as possible in staves, one
above the other. Use the vertical scroll bar down the window’s right edge to get to the remaining
bars of a lengthy Part.

[RSIY}

L3

Track

Drums | Track 1 iTrack 1 | Track | Track 1
Bass | Track & |Track &
Strings | Track 3 iTrack = | Track 3 [Track = l
Piano lFPianc ;
Bass
al 2
=" D A
- -
v R REIIE T R I S =
3 4 5

#

s R LI R e~
O pEFTeRFErE” 3 ‘#hjﬂi‘g FIHR IFTEF S
) 7 b3

[
[ S

e

0 AT M P9 EIUIEE R deFY WIS
Two or more Parts of a single Track in the Score Editor

The same applies to several Parts of a single Track. Here as well, Cubase displays as many Parts
as possible. The line at the bottom of the diagram above represents the screen’s lower edge.

The remaining notes cannot be seen as they go beyond this line: use the right scroll bar to access
them.

If you select one or more Parts on different Tracks, or all the Parts of an Arrangement, Cubase
creates a separate staff for each Track, and will attempt to display as many notes as possible
across the screen.
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Track

Drums I Track 1 iTrack t | Track 1 ITrack 1
Bass Track & | Track &
Strings Track = ITrack 3
Piano [P1ane

Bass

W B _—_

R T M E I FFE T
Strings h | | \ | I |

—— A —_ —_

Several Parts on different Tracks in the Score Editor

This time, the bars disappear beyond the right screen edge. Use the horizontal scroll bar along
the lower edge to access them.

The vertical scroll bar has another function when several Tracks are displayed in the Editor.
Staves are laid out one below the other, so it accesses the staves that lie below the lower screen
edge when there are too many to be seen at once. A maximum of 16 Tracks can be presented in
the Editor, though these can each contain as many Parts as you like.
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Several non-sequential Parts in the Score Editor

The selected Parts do not have to be in sequence. Cubase creates rests for the missing Parts: these
rests are seen in the Score Editor only; the notes in the Parts are still there and are played as
normal, except you won’t see them in the Score Editor.

The above illustration shows position 5.1.0, between the first two Parts. Both bass Parts are
selected and appear in the display, but whereas the strings’ first Part is selected and displayed,
the second Part is not selected, so Cubase displays rests even though the Part actually still
contains notes. The lower scroll bar moves the display horizontally to access the notes before or
after what’s currently on the screen, the right scroll bar moves it vertically to access other Tracks’
staves.

10.1.1 In general

Make sure you thoroughly understand the relationship between Parts/Tracks and the way they
are displayed in the Score Editor. As you read through the chapter, experiment with one or more
Parts.
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10.2 Practical applications

So far we have merely discussed the theoretical aspects of how Parts are presented in the Score
Editor. Now let’s try some practical applications and see what exactly happens.

For our first exercise create a new Arrangement featuring several Parts on several Tracks. To
benefit from the book’s examples, try to stick to the structure we used before, i.e.drumsonT ck
1, bass on Track 2, etc.

Select all the Parts you created in the Arrange window so far ([Control][A]). Now choose Score
Editor from the Edit menu ([Control][R]). You could, of course, enter the Score Editor by double-
clicking a Part provided the setting in the Preferences dialog box is correct, but in this case only
the Part you click is presented, not all the selected Parts.

Track
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Piano E

All the Parts in an Arrangement are selected...
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...and presented in the Score Editor

Cubase now displays all the Parts as notation. Each Track has its own staff, with the Parts
arranged one after the other in their respective staves. The staves are arranged one below the other
according to the order of the Tracks in the Arrange window.

If you change the order of the Tracks in the Arrange window, the Score Editor displays the
changes accordingly.

The bars which lie beyond the screen are accessed by the scroll bars, as we have discussed. A
click on the horizontal arrows scrolls the notation forward/back a bar. A click in the speckled bar
"turns the page". You cannot zoom the Score Editor display in the usual fashion. More on this
topic later.
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Start the playback. The Song Position Triangle starts to move and shows the current song
position. Once itreaches theright edge, the score display automatically flips to the nextbars. This
may take a moment, depending on the number of notes involved and your computer’s
performance specifications. Here, too, you can switch the automatic scrolling off using Follow
Song in the Options menu or [F].

The options used in the previous Editors to access particular song positions apply here as well:
- The fast forward and rewind buttons.

- Enter the desired position in the Song Position box via a double-click and typed input or use
of the left/right mouse buttons.

- Press [Cli/Home] to move the song position to the first bar displayed in the Editor window.

- Press and hold [Alternate] and then click a position in the notation with the right mouse button
to move the song position to this spot.

You can work in this Editor during recording and playback, as with the other Editors.

Now stop Cubase and set the song position back to the beginning.

10.2.1 The screen layout

You now know how Parts are presented in the Editor and how to move about in the notation. So
let’s take a closer look at this Editor.
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The Score Editor

The Title Bar across the top of the screen displays the currently active Part and Track.

Below it comes the Functions Bar with the usual functions (Goto, Selection and Function menus,
etc.); a number of icons which you will be familiar with; the Snap, Quantize, Mouse Position
displays; and the edit loop boundaries. You will recognize these from the previous Editors, but
you will find out as we proceed that some functions are different.

The Info Line, which we came across in the Key Editor, is situated between the notation display
and the Functions Bar, and gives detailed information on selected notes. It can be removed from
your screen by clicking the Info button or pressing [Alternate][I]. You can determine how many
bars Cubase displays at a time by clicking and holding "Global Settings" in the Score sub-menu.
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<» File Edit Structure Functions Options Modules Windows
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Determining the number of bars in the display

You can choose between one and nine bars in the "Max Bars in Edit Mode" option. How this
relates to what actually happens on the screen depends on the size of your screen and the amount
of information in a bar. Say you select a value of 9. If a passage in your Arrangement contains
a number of empty bars, the nine bars can be and will be displayed across your screen. On the
other hand, if the passage contains thirty-second notes, the number of bars displayed is reduced
to a realistic number despite the "9" you (optimistically) chose.

10.2.2 Display options

You may find some aspects of Cubase’s notation slightly irritating at first, depending on which
notes you have entered. This is not a program error; it’s quite normal. To get the correct notation
from what you have played, there are parameters you need to set manually - sadly, Cubase cannot
do these for you. We’ll discuss the reasons for this in the chapter on notation.

What we want to do at this stag is to eliminate the major inconsistencies so that the editing of
notes is made easier. This is done using a large number of things called "display options" that
help make the display clearer and more realistic.

The basic display of staves

Click anywhere in the first staff to select it - a little black rectangle appears before the clef.
Double-clicking a staff’s clef enables you to select its clef and key: there are lots of display
options available, only a few of which relate to the editing of notes.

The correct clef and key
If you have recorded a bass line or other passage in the lower/upper registers, Cubase makes use
of ledger lines which can hinder readability, depending on which clef is in use. To change the
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clef to one that suits, double-click that staff’s clef (let’s assume it’s the bass staff we are
discussing - leave any drum Tracks as they are for Nnow).

You can now enter the correct clef and key signature in the dialog box that appears. Click the clef
with the left or right mouse button to select all the available kinds of clef, one after the other, i.e.
bass, treble clef, etc.

The second option concerns the key signature. Click the staff next to the clef with the left or right
mouse button. Each click moves the key up or down by a fifth. If you start at the default key of
C, the right button calls up G, D, A, etc. and the left button F, B, Eb, etc.

Close the dialog box after you have entered all settings by clicking OK or pressing [Return] and
Cubase will enter the settings in the display. Cancel or [Esc] takes you back to the Score Editor
without executing any of the settings in the dialog box.

The following diagram illustrates how a bass Track was assigned the correct clef and the key of
Bb major. Keep in mind that any alterations you make apply to the selected staff only, and that
alterations are displayed only after you have pressed OK or [Return]. Use of Cancel or [Esc]
aborts any settings you may have made.
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Double-clicking the staff’s clef symbol opens the dialog box
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| CANCEL
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Clicking with the left or right mouse button selects the desired clef...

—E e
Bbldajor /£ G minor
...and key signature
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Use of "OK" applies the settings to the display

The result of your efforts is notation that is much more legible. Bear in mind that all these
alterations you are making affect the display of the notes only, not the MIDI notes themselves.

Split systems

If you have recorded a passage where the intervals between notes are substantial, as happens
when you play the piano, you have the same problem of lots of ledger lines getting in the way.
The following example shows a piano Part in the Editor. This illustration shows a fairly chaotic
scene. Piano Parts are usually presented as two staves, the split system. Click and hold the
"Score" sub-menu and select "Staff Settings" in the pop-up menu that appears.
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The original piano Part already features the correct key
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....and choosing the split point

The dialog box contains a number of options: for the moment, we are interested in the split point
only. Activate it by clicking the empty box to its left so a checkmark appears and close the box
via OK or [Return].
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Cubase has now created a split system for the piano. The pitch C3 is the split point: all notes lower
than C3 are displayed in the bottom staff, those above it in the upper one. You can alter the split
point in the Staff Settings dialog box by changing the value from C3 to the one of your choice.
When you create a split system, you may need to enter the correct key for the lower staff.
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The result is notation that is already much easier to read
You can use the method described above to split any staff at any pitch.

Summary
Before we go on to the editing functions in detail, a few explanations. Keep in mind that all the

changes described above can be made individually for each Part, each Track and each staff.

Cubase 3.0 allows extensive modifications to be made to the notation. Our primary concern until
now has been to make changes to the display so as to make the editing of notes easier. You saw
that this only took a few simple steps.

These few steps are not sufficient for detailed, absolutely correct notation, especially for special
cases such as drum notation, even though Cubase can do lots of things automatically. However,
fear not, details on this will follow.

10.2.3 Editing notes

The Score Editor allows you to view and edit note events only. You cannot use it to edit MIDI
Control Changes or other events.

Click the first note. It highlights, which means it is selected. A selected note’s parameters are
displayed in the Info Line, and can be edited there as well, using the same methods you met in
the Key Editor. Changes made via mouse click are immediately reflected in the display.

10.2.4 Moving notes

Events can be edited directly in the notation. Select any note and hold the mouse button down.
The note "attaches" itself to the mouse pointer. If you move the note right or left you change its
position in time. It can only occupy positions that are allowed by the Snap resolution. If it is set
to eighths, that’s where your notes will go. We came across Snap routines when we dealt with
the other Editors.

Moving the note up or down changes the selected note’s pitch accordingly. The amount of
transposition is displayed as semitone intervals in the "Transpose" field which appears next to
the Mouse Position field.
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Notes can be moved in a number of ways

Several basic rules apply when working with notes, which are ones you will recognize from the
other Editors. Here’s a brief review:

- Several notes can be selected simultaneously in different staves and then edited together: press
and hold [Shift] and click the desired notes one after another.

- The familiar rubber band can also be used here: activate it by clicking an empty space and
dragging the mouse while holding the mouse button down. It selects all notes it touches or
encloses, even if they are in different staves.

- Use the right and left cursor keys to jump from one note to another within a staff. If you hold
[Shift] down at the same time, the notes are selected.

- The up and down cursor keys are used to go from one staff to another. If you hold [Shift] down
at the same time, additional notes are selected.

- If you select and move several notes at the same time, the relative intervals between them are
maintained.

- Pitch changes are normally "diatonic", i.e. the pitch intervals are dictated by the selected key:
say you are in the key of C major, and you want to transpose a "C" note. The intervals you are
able to change to will be those of the C major scale: D, E, F up, and B, A, G down. If you need
the "in-between" (chromatic) values, hold [Control] down while transposing the note, and you
will be able to access the semitones (C#, D#, Bb, etc.).

- You can change a note’s pitch and position at the same time. Justrelease the mouse button when
the note is where you want it to be.

- Don’t rely on the notation display when you reposition a note, but watch the Mouse position
display for its precise position.

- If you want to change just the pitch, or just the position, first select the note by clicking it, and
keep the mouse button pressed down. Press and hold [Shift]. Your next mouse movement tells
Cubase what your intentions are: if you move the note vertically, Cubase assumes that you want
to transpose it and will prevent you from moving it in time. On the other hand, if you start by
moving the note horizontally, you can only change its time position, and transposition becomes
impossible. These two options are very useful as they ensure you make the right move.

- Pressing [Alternate] at the same time as selecting a note creates a copy of it. Copies, too, can
only be transposed diatonically unless you press [Control][Alternate] to access the chromatic
semitones. Use [Shift] to limit the range of this operation.

- Notes can be moved from one staff to another with the help of the key combinations described
above.

- [Delete] or [Backspace] deletes the notes that are selected.
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10.2.5 Useful features

In common with all the other Cubase Editors, the Score Editor has a number of extremely useful
features. We ran through these, from a practical point-of-view, in the Key Editor:

- Use the Goto sub-menu to move the screen display to the desired position.

- Activate the Ear icon to send new and selected notes to your synthesizer.

- The edit loop function is available, but in contrast to the other Editors you can define it with
the two position boxes next to the Loop symbol only.

- The "selection” sub-menu next to Goto is used, as usual, to limit the effect of certain functions
(Quantize, Clipboard, etc.) on specific notes.

- The Function sub-menu contains the same features you have already met, plus others that are
particular to the Score Editor. Most of these functions apply to the page layout and printing, so
we’ll skip these for the moment. However, the Explode function can be useful for Arrangement
purposes as it divides a multi-voiced staff into single-note lines in separate staves (i.e. separate
Tracks): if you recorded a string ensemble on one Track, you can use this function to distribute
each constituent voice to a separate staff for further editing, or so that they can be sent on different
MIDI channels.

To "explode" astaff, select it first. You can only work on one Track at a time, thoughitcan contain
as many Parts as you like (remember that astaff =aT k). Unselected Parts remain untouched

by any exploding.
Try it out. Record a Track containing chords in the Arrange window and select it. Go to the Score
Editor.
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Select Explode from the Function sub-menu
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Selecting Explode makes the following dialog box appear:

DK

How many new Tracks do you want?

Tell Cubase how many separate staves you want to extract. Enter a value of 3. Once you confirm
via OK or [Return], the Track "explodes”. Cubase creates new Tracks containing the new Parts
and appends them below the existing Arrangement. The original Track now contains the highest
note of each position where there was a note or chord; the remaining notes are assigned, in
descending order of pitch, to the new Tracks which have been appended below the Arrangement’s
existing Tracks.
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The result is new Tracks...
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...that contain the re-assigned voices

Out of a chord consisting of Bb, G, Eb, and C, the original Track retains only the Bb, which is

187



The Score Editor

the highest one of the notes at that particular time position. G is moved to anew Track of its own,
and so on. The number of Tracks created is equal to the value you entered. A value of 1, for
instance, would extract the upper melody line only. Keep in mind that Cubase sorts notes strictly
by pitch only, not by musical, quasi-polyphonic criteria.

To quickly achieve the desired result, you have to know what the maximum number of notes is
atany position: remember to include the original Track in your calculations. To create a "one line
per Track" situation, the number of new Tracks you define must be one less than the number of
notes in your most polyphonic chord. You can merge Tracks you have exploded at any time using
Mixdown in the Arrange window.

10.2.6 Creating notes

Step inputting and the direct entry of notes is, in the main, identical to the methods used in the
other Editors. To practise a little, we’ll step-input a short musical phrase. Create a blank Part in
an empty Track in the Arrange window and make it two bars long (1.1.0 to 3.1.0). Assign the
Track’s MIDI channel to a synthesizer capable of producing piano sounds and go to the Score
Editor. Ensure you have only entered this one Part in the Editor.

We’ll use a simple phrase to demonstrate all the more complex step input functions. The
following diagram illustrates how this phrase will look when we’ve finished.
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Step-inputting a simple example

First we want to use a split system: go to the Score sub-menu and activate Split Point in the Staff
Settings dialog box. Leave the split point at C3. Press [Return] to go back to the Score Editor.
Now enter the bass line in the lower staff.

You need quarter notes for this purpose. Set the Quantize and Snap values to 4, or press [3] on
your computer keyboard. Press and hold the right mouse button. The familiar Toolbox appears,
but this time it contains some different tools. Select the Note symbol.
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Select the Note from the Toolbox
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The mouse cursor changes from the Arrow to the Note. The Note tool’s value always reflects the
selected Quantize value - in our case, a quarter note. Do you remember the relevance Snap and
Quantize values have when you’re entering notes directly? The Quantize value dictates the
length of the note about to be inserted, the Snap value its position in so far as it determines where
you can move the mouse pointer.

Move the Note tool to position 1.1.0 of the lower staff. You may have to rewind Cubase back
to the start. The Mouse position display helps you with this.

Move the mouse horizontally. You can see that the mouse pointer moves in quarter note intervals
as dictated by the Snap value. The current pitchis displayed in the field beside it. Move the mouse
vertically and you will see that the mouse moves in C major diatonic intervals only. If you need
semitones, press and hold [Control] while entering notes.

Luckily, we don’t need semitones for this exercise. Go to the lower staff’s 1.1.0 position, at a
pitch of C2. Click that position once. A C2 note is created. If the Ear icon is active, the note is
sent directly to your synthesizer.

Keep the golden rule in mind: a staff must be active before you can enter a note, as designated
by the little black rectangle in front of the clef. In our example, it is possible that the upper staff
was the active one; if this was the case, our first click in the lower staff did not insert the note,
but merely selected it: you need to click again to insert the note. This only applies to the first
operation in an inactive staff.

Now insert an E2 at position 1.4.0, keeping an eye on the position displays. If you need to correct
a note’s positioning, call up the Toolbox, activate the Arrow and use it to drag the note to the
correct position.

Insert the four bass notes.
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The bass notes are in place

Let’s go to the upper staff. Click it to activate it. If it was already active when you clicked it, you
may have accidentally entered a note! There are two ways you can remove this note. Select the
Eraser from the Toolbox, place it on the incorrect note and click once. The other method is a little
more versatile: select the mouse Arrow from the Toolbox, select the incorrect note by clicking
it and press [Delete] or [Backspace] to remove it. This method has the advantage that pressing
and holding [Shift] allows you to select as many notes as you please and delete them. Moreover,
you can select the rubber band for this operation.

If you have activated the "In" symbol in the Functions Bar, you are in a position to delete notes
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from a staff and the notes that follow it will automatically move earlier by a corresponding
amount.

Back to our example. Use the Note tool to go to position 1.1.0 and E3 in the upper staff. Insert
the note. We also need G3 and B3 at the same position, with their respective pitches above the
E3. Make quite sure the "In" symbol in the Functions Bar is not active, since if it is, the notes
cannot be inserted as a chord; instead, each time you enter a note, Cubase moves the existing
notes later by one Snap position.

The second chord is identical to the first, so you can copy the first one: use the mouse arrow and
the rubber band function to select the whole chord. Press and hold [ Alternate] and click the chord
with the mouse pointer, press and hold [Shift] and copy the chord to position 1.2.0.

Now release [Alternate] and [Shift]. You have just copied the chord. [Shift] ensures you alter the
position, not the pitch.

Now enter the third chord. Place the fourth chord at position 1.4.0 using the same copying
operation. The same holds true for the second bar: select all the chords in the first bar with the
rubber band and copy the whole lot to position 2.1.0.

The upper staff is halfway finished. Let’s listen to the result: activate Ed Solo in the Transport
Bar and create an edit loop two bars in length. Here’s a quick memory refresher: activate the loop
symbol, set the bar positions next to it to 1.1.0 (top) and 3.1.0 (bottom). Click Ed Solo and start
playback. Cubase repeatedly plays the two bars.
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The halfway stage: auditioning the top and bottom staves

The eighth note melody is missing from the top staff. To insert it, set Snap and Quantize to 8
(keyboard [4]). Now insert the eighth notes at positions 1.1.0, 1.1.192, 1.2.0, 1.2.192, etc. at the
correct pitches. Depending on the combination of settings, Cubase may display quarter notes and
not eighths: don’t let it worry you, since the entries are correct. It’s just that Cubase hasn’t
recognized these notes as being of the melody voice yet, and so begins by assigning them to the
chords values.

While you are inserting notes, bear in mind that you can manipulate the velocity values using
[Shift] and/or [Control] as in the other Editors.

10.2.7 Additional Toolbox functions

The Toolbox features two additional functions. We’ll save the Pencil tool for the chapter on score
printout. The Glue tool merges two notes of the same pitch: where, say, two eighths of the same
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pitch are next each other, clicking the first one with the Glue tool converts the two eighths into
a quarter note. You can use this function to create notes not featured in the Quantize menu, such
as a sixteenth tied to an eighth note.

We have already covered the Magnifying Glass extensively. The Rest tool is obviously used to
insert rests. Rest lengths are dictated by the Quantize value. The effect of inserting a rest is to
move all the following events later, regardless of whether the "In" icon is active or not.

10.2.8 Note input via MIDI
We covered this function in the Key Editor. The following section may serve as a quick review.

Let’s create a new Part in the Arrange window, open the‘Score Editor and create a split system.
Activate its upper staff to enter new notes. Activate the Foot icon in the Functions Bar for step
entry. Notes entered via MIDI are always entered at the current Step Position: the insert position
is displayed to the left of the bottom scroll bar.

We covered the basic function of this display and its relationship to the Song Position box in the
Transport Bar when we discussed the Key Editor. In contrast to the other Editors, the Step
Position in the Score Editor window does not follow the display in the Transport Bar. This means
that you can only change the position manually, and not via fast forward/rewind or similar
operations.

Go to position 1.1.0 and click it. For the above reason, refer to the Step Position display in the
Editor window, not the one in the Transport Bar. Snap and Quantize should be set to eighths. Play
the first chord of the upper staff on your master MIDI keyboard. The velocity values you are
generating are recorded as well.

Cubase jumps to the next Snap position once you release the keys, i.e. to 1.1.192. Enter the chord
sequence till the top staff’s three bars are full. Cubase places the chords automatically at the
correct positions thanks to the Snap function: all you have to think about are the pitch and velocity
values.
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The top staff is done

The entering of notes for the lower staff is just as easy. Select the bottom staff and set Snap to
half notes and Quantize to quarter notes, the Step Position to 1.1.0, and play the required notes
one after the other up to the beginning of the third bar: quarter notes are being inserted at hatf
note intervals. Quantize dictates the note lengths of the notes entered, and Snap their positions.
You control the pitch and velocity.

The third bar requires different Snap and Quantize values. The Eb is a half note, this means that
Quantize is "2". The following notes should be entered at position 3.3.0, i.e. the midpoint of the
bar. The Snap value is also 2, i.e. a half note. Now play the note. If you make a mistake, call up
the eraser from the Toolbox. Ensure the Step Position display at the lower left screen corner has
not been altered.

191



The Score Editor
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When you reach position 3.3.0, the Snap and Quantize values have to be changed to quarter note
values. Play the final two notes, and listen to the result. Remember to turn off the MIDI In
function, otherwise you’ll insert a note every time you inadvertently touch a key of your MIDI
master.

You may need to enter rests, depending on the type of music you want to create: press the
computer’s [Tab] key and Cubase jumps to the next Snap position leaving a gap.

10.2.9 Another option

You already know that you can edit existing notes by using the MIDI In function in conjunction
with the note, velocity and release velocity icons. If you can’t recall how this works, review the
section that covers these functions in the Key Editor chapter. The only difference here is that
Cubase does not move from one symbolical note stem to the next, but from actual note to note.

10.2.10 Synopsis

As usual it is entirely up to you which.of these methods of entering notes you use. You can also
combine the input methods as you see fit. If you have the skills, you can try to combine realtime
and step input methods by recording the Parts in realtime and then using the step method to insert
or edit notes where realtime entry was too difficult.
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11 The Drum Editor

The Drum Editor has been specifically designed with the creation of drum and percussion Parts
in mind. "Pro-24" users will already be familiar with the way this Editor displays its data. Before
we get down to its practical use, we should clarify a few technical points which are vital to
understanding how the Drum Editor works. Each MIDI note you play is assigned to a specific
sound in the destination sound module. Hit the note C3 on your keyboard and depending on the
way your sound module has been set up, you will bear, say, a bass drum; D3 might trigger a snare
sound, and so on. It is always the destination module which determines which sound will be
triggered.

Although an assignment of sounds to specific MIDI notes has been not been laid down, a standard
assignment has been established between most manufacturers for the most common sounds.
Nevertheless you may experience unexpected difficulties: say you entered a drum Part on a
Cubase Track, but you want to use a different sound module for the final recording. This sound
module may well use a different MIDI note assignment. The most likely result is that you will
hear the basic pattern you played, but without the original sounds that you used. What was
originally a fat kick dram is now wimpy toms, your amazing hihat is replaced by an orchestral
hit, and the snare has disappeared altogether; in short, complete chaos reigns.

Of course on most sound modules, you can change the MIDI note assignment to match your Part,
but Cubase offers a much simpler and substantially more efficient facility: the Drum Map. There
are two ways to use the Cubase Drum Editor, one with the Drum Map, the other without it. Itis
the selected Track Class which governs whether the Drum Map is active or not. We’ll keep it
simple for the initial introduction to this Editor and record drum notes on a normal MIDI Track.
Ultimately though, it is far better to activate Drum Track in the Arrange window’s Track Class
column. You’ll save yourself a lot of unnecessary work.

11.1 The initial steps

You will probably have to configure the Drum Editor to match your setup before you can start
using it. Although in principle the Drum Editor is not limited to controlling drum or percussion
sounds, it is tailored to this specific purpose. You should therefore use drum sounds in some
shape or form for the following exercises. It doesn’t matter whether they come from a drum
computer, drum sound module, or a sampler. Nowadays, many synths and workstations feature
a respectable collection of drum sounds.

Delete any Parts left over from previous editing of your Arrangement. Select Track 1, create an
empty two-bar Part, and then select it. Make sure that the Track is set to a MIDI channel which
is triggering drum sounds on your instrument. Before you open the Editor, have a listen to the
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sounds. Make sure that each note triggers a specific drum or percussion sound. If this isn’t the
case, check the MIDI channel assignment and the internal setup of your sound generator.

Enter the Drum Editor via the Edit menu, or the [Control][D] key combination. This is the only
way to do this if you want to enter several Parts on different Tracks in the Drum Editor. Later,
we will see that by setting the Track Class to Drum, you can enter the Drum Editor directly by
double-clicking a Part. The edit window that is called up has certain things in common with the
other Editors. The main section of the window is reminiscent of the Key Editor.
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The Drum Editor

Before you can start to use the Drum Editor, you will need to adjust the note assignment to that
of your sound module. These settings can be saved on disk and reloaded as required. This enables
you to set up and archive configurations for various different instruments and applications. Note
assignment is a necessary, but very lengthy process, so Steinberg supplies note assignments for
most popular synthesizers with Cubase.

Remove the program or song disk from the disk drive and make a backup copy of the Cubase
Additionals 1 disk. Choose Open from the File menu ([Control][0]) and then the Drum Map entry
in the dialog box ([6]). Drum sound assignments are in the Drumsets folder. Click Drumsets
twice. The Drum Maps contained on the disk will appear. If you find a drum set with your
instrument’s name, double-click the name in order to load it.

If this is the case, skip the following sections and go directly to the section on note input. You
may want to ensure that this drum set is loaded automatically from now on every time you boot
Cubase: copy the file onto the backup copy of the program disk, or to the Cubase file on your hard
disk. Rename this file "DEF.DRM".

If you own a device that Steinberg has not developed a preset Drum Map for, then you will have
to configure the drum set to your instrument yourself.

11.1.1 Adjusting the Drum Editor

The following operations are somewhat tedious, but you only have to do them once which will
save you a lot of work later on. The left half of the screen displays the available parameters for
each sound. We’ll look at these in greater detail in a moment. The grid in the right half of your
screen is used to create the required rhythmic structures via mouse click. First you have to assign
the MIDI notes to the drum sounds in such a way that your receiver will respond appropriately.
Once you have done this, Cubase automatically places the MIDI notes in the correct place on the
grid.
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Each line in the left half of the screen contains the parameters for a MIDI note, i.e. the
corresponding parameters to trigger a sound in your sound generator. Now let’s set up a
completely new note assignment. This system allows you to deal with up to 64 sounds and assign
MIDI notes to each of them. The initial display lists 16 sounds and their respective parameters.
The vertical scroll bar allows you to access the remaining sounds. You can zoom the display if
necessary.

The dividing line between the grid and the parameter columns can be moved in the same way
as in the other Editors. Click the line as accurately as possible. The pointer turns into a hand.
Keeping the mouse button held down, drag the line as far to the right as possible.

Now you have access to all the parameters. The number of visible columns depends on whether
you are dealing with Drum Tracks or regular MIDI Tracks. At the moment, we’re working with
MIDI Tracks, so your window should look like this:
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MIDI note assignment parameters

11.1.2 Assigning notes

Each line, and consequently each sound, should be assigned a MIDI note, which in turn is
assigned to a sound in your instrument. If you try to assign two identical notes on the same MIDI
channel, Cubase will advise you of your mistake. If you decide not to use all 64 assignment
options, you can switch the note assignment to "Off" independently for each line.

Before you start assigning notes, we want to set all notes to the same starting point: "Off". This
will prevent you being hindered by the constant re-appearance of the "Double defined INote in
your drum-set!" warning.

Double defined INOTE
in your drum-set!

[ox]

Warning: two identical notes on the same MIDI channel
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Scroll to Sound No. 1 at the top of the list using the vertical scroll bar. Hold down the [Control]
and [Shift] keys. Using the right mouse button, click and hold the little box in the first line under
the "INote" heading. You will see the value changing. Wait until "Off" appears then release all
keys. All the "INote" values will now be set to "Off". Whenever you hold the [Control] key down
whilst assigning a value to the current parameter, that value will be entered in the appropriate
column for the remaining 63 sounds. As you know, holding down the [Shift] key speeds the value
change by a factor of 10.

Now we can make the first assignment. Set the first sound’s INote to your instrument’s bass drum
sound.
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The fifst note assignment: CI triggers the bass drum

How do you know which note this is? Simple! It is the same note you have to play on your
keyboard to trigger this sound. If you have to hit C2 to play the bass drum sound, set this field
to C2. Change values in the normal way using the two mouse buttons, or double-click and direct
input. Input from the Atari keyboard is probably the best method for this particular case.

Always name the sound assigned to each line so that you can see all your note assignments at a
glance. Double-click "Sound 1" (or hit [Alternate][N] on the keyboard). Delete the old name by
pressing [Esc], and enter a new name. Every time you click this name or its line from now on,
Cubase will send out the corresponding MIDI note and the connected sound module will play
that note. This acts as an auditioning mechanism so that you can hear which sound you are dealing
with.

By activating the Ear icon, you can cause any changes you make in the INote column to be sent
out via MIDI. This means you can hear the sound which will be triggered as you assign the note.

The Ear icon: inactive (left), active (right)

This auditioning facility allows you to find the sound by ear, as opposed to knowing the precise
pitch required. Scroll through the MIDI notes with the right mouse button and audition which
sound each click triggers on your instrument.

Once you have set up the sound you want, go down to the next line with a mouse click (or the
up/down cursor arrows) and assign the next MIDI note.
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You may accidentally assign the same note twice via the mouse/direct input methods. Cubase
will alert you with a warning box. OK this and then make sure you find and remove the double
assignment.

Although you cannot delete list entries, you can change their order. Click and hold any of the list
entries and drag the field to the desired position. The entry will be inserted at this position, with
the following entries moved down accordingly.

Normally, the entire input process would have to be done for each sound and its associated MIDI
note. However, Cubase has a far simpler method that you can use. Click the INote box and
activate the MIDI In symbol in the Functions Bar.

®

The MIDI In icon: inactive (left), active (right)

Now Cubase will check the MIDI input for the note played so you can find the correct note on
your keyboard. Play across the keyboard until you find the right sound. Its assigned MIDI note
will be automatically entered in the INote box. Bear in mind that this only works in the currently
active line. Name the sound in the Sound column. Select the following lines in turn with a mouse
click (or the down cursor arrow on the keyboard), and assign the other sounds. If you have enough
sounds available, you can assign up to 64 of them.
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The sounds are assigned one after the other until the basic configuration is complete

You should now save your setup to disk so you don’t lose the results of your efforts. To do this,
use the Drum Map option in the Save dialog box. Remember that the INote column should only
be active (i.e. highlighted) whilst assigning MIDI notes. As soon as you are finished, select
another column. Otherwise, you may run into difficulties in other operations, especially during
MIDI step input.

For our purposes, create a simple setup with bass drum, snare, two toms, open and closed hihat
in the top six lines. These sounds are standard, and should be available on any drum machine or
sampler. You can, of course, assign them to different sound modules by using different MIDI
channels. The MIDI channel for each individual MIDI note is entered in the Chn column. The
MIDI channel of the Track must be setto " Any" for this application, otherwise Cubase willignore
the MIDI channel settings entered in the Editor.
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11.1.3 Input

Now that we’ve finished the important preparation, let’s start entering some notes and rhythms.
Drag the dividing line between the grid and the parameter list as far as you can to the left, so that
only the M, Sound, and Quantize columns are visible. The grid should now display several bars.
The Drum Edit window can be enlarged, reduced, zoomed, and moved in the same way as all
other edit windows.

For our first attempt, we need to see just two bars. Zoom the display scale by clicking the bottom
scroll bar’s left arrow until two complete bars are visible.

* The Mouse Position display (the same for all Editors)
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Define and activate Cycles here

Ready for note input

Now we’ll create a pattern in the same way as conventional drum machines to familiarize
ourselves with the various functions of the Drum Editor. Our pattern should be two bars long.
Setup atwo bar Cycle. You can use either a Cycle defined by the locators, or an edit loop created
via the Loop icon in the Functions Bar. You can "draw" the loop in the Position Bar the same way
you did in the Key Editor. Start playback, not recording. Press the right mouse key somewhere
within the grid to call up the Toolbox. Select the Drum Stick from it.

NEINY,
Q] &Yy

The Drum Stick in the Toolbox
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Now you can use this tool to enter notes. Click position 1.1.0in the bass drum line. Keep one eye
on the Mouse Position display. The note will be placed here and played during the next Cycle.
Enter more bass drum notes at positions 1.3.0, 1.4.192, 2.1.0, 2.3.0, and 2.4.192.

The notes are displayed as small diamonds. The Mouse Position display will help you to place
them correctly.
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The first bass drum beat is in place

The Quantize value assigned to each note dictates on which bar position the notes can be placed.
In the above example the QNT column is set to sixteenths for each sound. We’ll utilize these in
a moment. The Snap and Quantize settings in the Functions Bar (so important in the other
Editors) have no effect whatsoever during Drum Editor note input.
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The above bass drum pattern entered

Now we’ll enter the positions of the snare notes. Place a snare beat at positions 1.2.0, 1.4.0,2.2.0,
and 2.4.0in the second line. You can delete a note in several ways: click the drum stick tool again
to remove the note. You can also use the Eraser from the Toolbox. You are also already familiar
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with the third method: select the mouse arrow from the Toolbox and highlight the events you
want to delete with a mouse click. You can use the click/[Shift] method, or the rubber band to
select several notes. Selected events are highlighted and can be deleted via [Backspace] or
[Delete].
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The completed snare pattern

11.1.4 The Info Line

If you select just individual notes, you can see their parameters in the Info Line. Any changes
you make there with the mouse are also reflected in the grid.

For percussive sounds, the length value normally has little effect. Think carefully before you start
making any changes to the pitch. Each line in the grid is equal to a pitch defined by the INote.
If you change an event’s pitch in the Info Line, the event will be moved to another line in the grid
corresponding to the new pitch.

If none of the lines is assigned this pitch, the event will not be displayed in the grid, although it
is still in the Editor.
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The Info Line

11.1.5 Additional methods of input

Until now, we have only been inserting single events. In the following exercise, an eighth hihat
pattern, a number of notes will be entered with a single operation.

Enter a Quantize value of 8 for the closed hihat. Click and hold in the hihat line’s Quantize
column. A box will appear in which you can enter this value.
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Select a Quantize value of "8"

Activate the drum stick from the Toolbox and place it at position 1.1.0in the hihat line. Press and
holding the mouse button, drag it to the right. A note is entered at each eighth position in the grid.
It is the Quantize value which dictates the grid intervals. "16" equals sixteenth steps, "4" are
quarter intervals, etc.

The grid gives you a graphic representation of where notes can be placed. The current display
scale is insufficient for small values, i.e. 32nds and 64ths. You will need to zoom the display in
order to see these.
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Drag the mouse to the right while holding the mouse button down.:
the hihat pattern will be entered

In our example, we have entered eighths. You won’t make any mistakes when entering as notes
can only be entered in the current line. Even if you move the mouse up and down, the notes are
still only entered here.

Bear in mind that you can continue to draw beyond the end of a Part. Cubase will ask you if you
want keep the additional notes when you leave the Editor. If you answer Yes, Cubase will add
the notes to your Part.
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Keep appended Events 7

[es] [we]

You've drawn beyond the Part’s end. Do you want to keep the additional events?

Delete the hihat event at position 2.4.192 and enter an open hihat note in the line below it. You
can also enter some toms if you like.
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Our first drum Part completed

11.1.6 Synopsis: the rules of the game

The following rules govern drum stick entry and delete functions:

- Click the grid once to place an event, provided no other note is at this position. Events can only
be entered at the positions allowed by the selected Quantize values.

- Click a note in the grid to remove it. Events can only be deleted at the selected Quantize values.
This can cause problems: say you positioned sixteenths in the grid and then changed the Quantize
value to eighths. This of course has no effect on the existing events. However, if you try to delete
all the events with the drum stick, it will not work. Only the eighths will disappear. You must
change the Quantize value to delete the sixteenths, or select the Eraser from the Toolbox. As you
know, the Quantize setting does not affect the Eraser’s ability to remove undesired notes.

- Dragging the mouse through the line while holding the mouse button down has two effects: if
you initiate the movement at an empty position, then new events are entered at all empty spots
(existing events are not affected). If you initiate the movement at an existing event’s position,
it and all the remaining events are deleted.

- If you press and hold [Alternate], new notes are entered in every line you touch, not merely in
the line that is active.

- The Paint Brush tool works the same way as the drum stick.

11.2 Additional functions

The note length is set to a 1/32nd note. The length is of no consequence to most drum samples,
because they are automatically played to the end once they have been triggered. You may,
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however, need a different note length, depending on the sound or channel. You can set a new note
length individually for each pitch in the Len (length) column.

A hihat pattern with exactly the same velocity values throughout sounds very mechanical and
boring in most types of music. You could of course edit each value individually for every note
in the Info Line after you have entered it. However, you know how to control velocity values
during the entry process from your experience with the other Editors. One of the available
methods is to use certain key combinations. The Drum Editor also offers this option, with the
added benefit of even more precision.

Move the dividing line between the parameters and grid all the way back to the right. The columns
headed by "LV 1" through "LV 4" are the ones we are interested in. Velocity values will be
assigned to the notes according to the key combinations you hold whilst entering notes. The
different diamond patterns graphically represent the different velocities. During normal entry,
the notes are assigned the Level 1 velocity value. Holding down [Shift] assigns Level 2, [Control]
sets Level 3, and holding down both keys assigns Level 4 to the notes. You can specify which
velocity values these actually represent for each instrument.

Velocity values are fairly abstract, i.e. difficult to picture because you just don’t know how your
instruments interpret these changes. As aresult, you may prefer to input notes directly via MIDI.
Activate the MIDI icon and select a sound. The entire line will be highlighted.
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You can set individual velocity values in each of the columns "LV 1" through "LV 4"

Click the LV 1 column and play a note at the desired velocity. Your velocity value is entered.
It doesn’t matter which note you play, because the INote is already set. However, it is advisable
to play the assigned note to hear the actual sound that you are entering these velocity values for.

Repeat these steps for the remaining levels. Click the desired column and play a note at the
desired velocity. You can do this for every sound, but normally you would set these four values
once and then copy them to the other sounds. Use the standard copy function via [Control].
Proceed as follows:

Deactivate the MIDI icon and the Level 1 value you want to copy to the remaining sounds while
holding down [Control]. This setting will be carried across to all other sounds. The current value
may move up or down an increment during this operation. If this happens, adjust the entry back
to its original value with a mouse click whilst still holding down [Control].

The second method consists of entering values directly: hold [Control] down and double-click
the value. Once the empty input box appears, release [Control] and enter the value. Hit [Return]
to confirm. The new value will be copied to all other sounds.
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Equipped with this new knowledge, let’s have another go at the hihat pattern. Delete all the hihat
notes. As you know, there are a number of methods available: the rubber band, drum stick, or
the Function sub-menu, which you probably remember from the other Editors. Selecta hihat note
in the grid and choose Delete Note from the Function menu. Any notes of this pitch, in this case
all the hihats, will be deleted.

Retrieve the drum stick from the Toolbox and slowly drag it through the hihat line. Vary the
velocities by engaging different key combinations. Do not release the mouse button. The result
should resemble the following diagram:

Modules Windows
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The hihat pattern entered with varying velocities

You can use the key combinations randomly or in a specific order to create accents. Yourreceiver
must of course be able to respond to these varying velocity messages. Listen to the results of your
efforts. The column at the far right of the parameter listis headed by an M. Its function is the same
as in the Arrange window, although here you can’t mute Tracks, but you can mute individual
drum sounds. Simply click the sound’s Mute column. The dot denotes the sound is muted. Click
again to re-activate the sound.

This speedy process can, for example, be used to program rhythm patterns with two differentbass
drums. Mute one, then the other, to hear which one sounds better in context. In contrast to the
Mute in the Arrange window, this mute can’t be recorded. If you want to listen to one sound at
a time, the Solo function is very handy as it mutes all the sounds in a pattern except the one you
have selected. Click Solo or press [Alternate].

11.3 Identical functions in all Editors

We should review those functions that are virtually identical in all the Editors. In addition to the
Goto, "selection" and Function sub-menus there are the icons used for the step input method, or
to be more precise, editing via MIDI. However, it is most unlikely that you will ever need to use
the MIDI step input option in the Drum Editor, as Cubase’s graphic handling capabilities in this
Editor are quite exceptional.

Controlling velocity data via MIDI In would seem to be a more sensible application. Let’s go
back to the hihat in our pattern for a second. Clear the hihat pattern again and select the hihat line.
Activate Fill in the Function sub-menu. Cubase will enter a hihat pattern with identical velocity
values at each grid position. The Quantize setting should still be "16" for the hihat line. We’ve
now entered the required events. Now go back to the beginning of the pattern to start on the
velocity values. Activate the MIDI In icon, the velocity icon, and the first note you want to edit.
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Enter a new velocity value via MIDI for each note. As soon as you press and release a key on
your keyboard, Cubase will enter the velocity value and move on to the next note. That way you
can effortlessly enter all the velocity values, one after the other. If you want to leave an event’s
velocity unchanged, skip it using [Tab].

Make sure the dividing line between the parameters and the grid is moved at least as far left as
the Quantize column, otherwise you may have problems with INote and ONote.

11.4 A few tips

The preceding examples were limited to the graphic and MIDI input options. You can also work
on previously recorded Parts in the Editor, or go to the Drum Editor during recording (as with
all the other Editors). Remember though that the events entered in this Editor are displayed only
when the corresponding INote has been defined. If you play a C#4 note, then all graphic
information is displayed in the C#4 line. If you haven’t assigned C#4 in the Drum Editor, then
the information is not displayed in graphic symbols.

- Events that are not exactly on the correct grid position, as is usually the case when you enter
notes in realtime without Quantize, are deleted via the Eraser, and not a click with the drum stick
tool.

- The Magnifying Glass and the two Kicker tools have the same functions as in the other Editors.
- You can move any number of selected events to other bar positions or pitches by clicking and
dragging with the mouse pointer. Hold down [Alternate] to copy, delete, or move the selected
notes.-

- Most key commands and applications should be familiar from your experience with the other
Editors. If you feel the need, refresh your memory by browsing through the Key Editor chapter.
- The Controller Display we met in the Key Editor is also available here. Click the Ctrl button
in the Functions Bar or press [Alternate][C]. We’ve already looked extensively at the way
Controller Display works. Here it is best used for editing the velocity values of individual notes.
Click the desired sound in the Sound column and adjust the velocity column the way you did in
the Key Editor. The majority of the remaining controllers and editing options are less useful in
conjunction with drum sounds. Keep in mind that virtually all MIDI non-note commands are
channel specific: you cannot control MIDI volume, modulation, or pitch bend data individually
for each drum sound. The only event type applicable on a per-MIDI note basis is Poly Key
Pressure - however, most drum samples are too short and percussive to achieve any worthwhile
results through Poly Key Pressure.

If you do assign notes to several MIDI channels in your drum set, then Cubase operates in the
following manner:

- The Controller Display displays only those events assigned to the same MIDI channel.

- New data entered in the display is assigned to the same MIDI channel as the selected sound.
- Poly Key Pressure data is assigned and displayed at the sound’s INote pitch.

11.5 The Drum Map

Now that you’ve been introduced to the Drum Editor’s most important features, let’s go on to
the "Drum Map" and "Drum Tracks" that were mentioned at the beginning of the chapter. In our
exercises up to now, Cubase has accepted INote values input during recording. For instance, if
you assigned the bass drum to the C2 note, then it was recorded and later played back whenever
you played C2 on your keyboard.

If you’re a creature of habit, and always use the same setup, then this setting is entirely sufficient.
However, say you bought a new drum machine, or you want to use a different sampler in the
studio. Your drum set may control completely different sounds, or even none at all. The snare
you had assigned to C1 may correspond to the C#4 command in another device.

Most MIDI devices allow you to change MIDI note assignments to avoid this type of problem.
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Be prepared for a long and extremely boring task. But don’t despair! Cubase’s Drum Map gets
around this problem speedily and elegantly.

The Drum Map allows you to define both the INote and an additional ONote (output note) for
the MIDI notes to be sent. To work like this, you must define each Track containing drum Parts
as a Drum Track as discussed in the introduction to this chapter.

Create a new Part and move the dividing line between the sound parameters and the grid to the
far right.

< File Edit Structure Functions Options Modules Windows
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Drum Track parameters

Two new columns have now been added to the familiar ones: "Instrument” and "ONote".
Instrument displays the name of the selected sound’s MIDI channel, provided you assigned it a
name in the Arrange channel. If you didn’t, enter a name with a double-click.

The ONote column is of particular interest to us. You can assign the same valuestoa sound line’s
INote and ONote columns for your own recordings. However, these functions are especially
useful in the following applications:

Let’s assume you have created a drum Track with the conventional drum note assignments, in
the same way as in our practical exercises. Now you are in a situation where you want or have
to utilize a different setup. Cubase has recorded the events in the Parts according to the INote
settings. You would have to change every single event on the Track to change the note
assignments. For example, you assigned and recorded a bass drum and snare drum in the Editor.
The MIDI trigger notes are set to C3 and D3, respectively. Not a problem if you continue to work
with the same devices. However, another sound module may require C4 and E4 to trigger bass
and snare drums.

Conventional editing techniques offer two options in such a case: either you change the note
number assignments in the Editor, or you utilize the Logical Editor, which we haven’t covered
yet. In principle these methods are fine, they will work.

However, as a rule the Part also contains other MIDI notes that in turn trigger other sounds. Once
you start transposing, you may accidentally assign them to pitches that are already assigned to
other MIDI notes/devices. In this case, you won’t be able to separate different events of the same
pitch in the Editors. Your drum groove would be lost.

This is where the Drum Map comes in. When the Drum Map is in full use, Cubase reroutes the
recorded notes according to your instructions. In our example, you would simply set the bass and
snare drums’ ONotes to C4 and D4, respectively. The recorded events are not affected in any
way.
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You enter ONote values in the same way you entered those for the INote. This also makes it
possible to enter changes via MIDI. Activate the MIDI In symbol, select the ONote heading by
clicking it, select the required sound in the column and play the correct note on your keyboard.
Select the next sound and repeat the procedure. That way, the notes of a finished drum Track can
be assigned in a user-friendly manner without having to change the recording. In contrast to the
INote, an ONote value canbe set twice so thata single event can trigger two differentinstruments.

The INote can also be independently assigned when the Drum Map is active, so enabling you to
reconfigure your keyboard sounds.

During recording, Cubase converts all incoming notes to an internal, fixed assignment for each
of the 64 drum sounds in the Drum Editor list. The following example demonstrates how this
works: .

Without the Drum Map
note played note recorded note assigned
C3 C3 C3

The C3 note is required to trigger a bass drum sample in a module. This note must be played on
your keyboard and recorded, so the sample can later be played.

With the Drum Map
note played note recorded note assigned
C2 C2 C3

The module’s bass drum is still triggered by C3. If you want to trigger another drum sound, use
the ONote to do it. Recorded events will then be remapped to the ONote. The INote value can
be sent to any note number, so you can configure the sounds you need to trigger from your
keyboard as required. If you prefer to play the bass drum at a higher position, simply change the
INote. The event is recorded at the C2 pitch, but it is played back at the C3 pitch.

Cubase assigns fixed pitches for the first 64 drum sounds. The first of these is C2, the second C#2
the third D2, and so on. This scheme may cause some confusion when working in the other
Editors. You will need to move the Key Editor’s keyboard display on the left-hand edge of the
screen all the way down to the bottom. The List Editor displays the drum sound’s name in the
Comment column for each event. If you use a sensible scheme to assign names to the 64 available
sounds, you will find that this simplifies the entire editing operation.

11.5.1 Additional advantages

Setting up a complete map for a drum Track takes a considerahle amount of time, but the
advantages that a Drum Map has to offer are also considerable. Using Drum Maps is well worth
the effort. Always record drum notes on Drum Tracks. For example, if you’re in the production
phase of a project where time becomes critical and you want to replace a cowbell at D5 with
maracas at C4, whilst retaining the rhythmic structure. If you’ve recorded it on a Drum Track,
all youhave todoischang the ONote. If you haven’t used the Drum Map, you’re forced to move
every D5 individually, or transpose them. The danger in this of course, is that you may end up
transposing an instrument’s note to the same pitch that another instrument is using, mixing them

up.
Be sure to save your Drum Map separately via the Save dialog box, under Drum Map. The Drum

Map is also saved along with a song, but not with an Arrangement. Only one Drum Map can be
held in memory at any one time.

11.5.2 Converting Drum Maps

You may get so involved with a particular song that you end up recording drum patterns on a
normal MIDI Track, forgetting all about using Drum Tracks and Drum Maps. No need to panic!
You can convert the Parts or Tracks to a Drum Track.
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Go to the Track Class column of the MIDI Track and set it to Drum Track. Cubase will ask if
you want to convert the Parts to Drum Parts. The existing notes will be entered in the list
according to the Drum Map’s INote settings. Once this has been done, you can change the input
and output notes without affecting the original data.

Transferm Parts to Drum Paris ?

[ho] [ves]

Transform MIDI Tracks into Drum Tracks?

Take this as an example: there are several companies that sell finished drum grooves. These can
normally be loaded into Cubase. But if they’re not available in the Cubase format, they may at
least be available as MIDI files. In this case, you will need to load the file into the List Editor to
find out the note assignments so that you can identify the notes and their roles in the Drum Editor.

When the MIDI file has finished loading, convert the song’s drum grooves to Drum Tracks via
the pop-up menu of the C column. Click on OK or press [Return] in response to the question
shown in the above diagram. Go to the Drum Editor. Cubase will assign the notes according to
its INote settings. If the MIDI file’s bass drum was assigned to C1, then it will be entered in the
line with a INote assignment of C1. If the snare drum was assigned to D1, then it will be entered
in the line with a INote assignment of D1, and so on.

Itis strongly recommended that you name the sounds in the relevant column of the Drum Editor
as soon as you have loaded them. If the sounds are spaced a long way from each other in the list,
you should move them closer together.

Cubase assigns each pitch an internal Cubase note during conversion. This means you can
change the INote and ONote assignments, i.e. use the snare note for a tom sound, etc., as soon
as the conversion procedure is completed.

11.5.3 Drum Tracks and MIDI files

You can see that Cubase uses an internal note assignment system that does not make use of the
entire note range available via MIDI. The output notes are actually assigned via the Drum Map.
If you export Cubase Arrangements as MIDI files, you may encounter some problems. The
recorded low notes will be used, but not the assigned Drum Map notes. Most MIDI sound devices
won’t be able to process this data. This means you must convert Drum Tracks to normal MIDI
Tracks first.

Go to the Track Class column of the Track and switch the setting from Drum Track to MIDI
Track. Cubase will ask how notes should be converted. You must decide whether you want them
converted to the assigned input or output notes.

Transform Drum Parts to Normal

[ cancel | [In Notes | {out Notes]

Converting Drum Tracks to MIDI Tracks
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11.5.4 A tip or two

The Drum Editor’s best feature is the quick and easy way it allows you to create rthythms. This
is particularly true if you prefer working with patterns. In contrast, very few musicians attempt
to enter the drum Arrangement for a 150 bar song in a single take.

Many musicians use a continuous groove as the song’s skeleton, and then flesh it out as they go.
Once the basic outline of a song is clear, they then concentrate on the detailed drum work. If this
method of working appeals to you, create a Part several bars long, then use the Repeat function
discussed in the Arrange chapter to copy it the desired number of times. Use Ghost Parts.

The reason many musicians use a drum machine even though they have a sophisticated software
sequencer is obvious. Aside from the authentic sounds it has, a drum machine gives quick access
to rhythms and grooves created/loaded earlier. But as a Cubase user, you don’t need to miss out
on this advantage. Create Parts and Tracks in keeping with the basic groove you have in mind.
You can buy prefabricated grooves on disc if required. Load these new rhythms and edit the
Tracks to suit your material by changing Parts, cutting them, etc. MIDI Files and external Drum
Maps will need to be converted to Drum Maps which match your drum set. This should give you
an Arrangement consisting of a number of such basic grooves.

There are two ways of managing your files efficiently:

- Save each Part using a name easily associated with its potential use. Later you can load this Part
directly into your Arrangements and songs. Use a disk which you reserve exclusively for drum
Parts. The Parts are always entered at the position of the left locator. Remember that saved Parts
retain their original Track allocations. If a Part was on Track 1 when you saved it, it will be re-
loaded in Track 1 of your Arrangement. If there are other Parts on this Track, then the Drum Track
will be overlaid. You can then drag the drum Part to another Track. If you want to avoid this
overlaying, always copy drum Parts to a particular Track reserved for drums.

- Save it as a complete Arrangement together with all the rhythmic structures you will need. As
you already know, Cubase can hold up to 16 Arrangements in memory simultaneously. One of
these can be demoted to act as your drum buffer. Whenever you want to use a drum groove, load
the complete drum Arrangement, select the desired drum Part, and then use the Clipboard’s Copy
function. The drum Part will be copied to the Clipboard. Then call up the destination
Arrangement.

Use Paste to insert the Part at the current song position in the destination Arrangement. You must
set the song position to be the spot where you want to insert it. Each time you use Paste, the Part
will be entered immediately after the previous Paste.
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A special drum Arrangement containing several drum Parts. They can be...
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...entered in a new Arrangement

Once you have entered Parts in a new Arrange window as shown in the above illustration, new
Tracks will be generated for these Parts to be placed on. You may just need to move them to the
desired positions. Here too, pick names you can recognize easily for the groove Arrangement’s
individual Parts so you get a clear picture of your Arrangement.

Which of these methods you will prefer in the long run depends on two factors. If you store the
Parts separately you may well use less memory. However, you will need to keep accessing the
disk, which is rather time-consuming. The second solution, using the drum Arrangement, allows
faster access. It allows you to copy around Parts quickly to try out different rhythms in the same
context. This method uses substantially more memory because you are holding the drum grooves
initas well. If it’s a big Arrangement, and your drum Arrangement contains a lot of grooves, you
may run out of memory if you only have 1 MB available. In this case, remove all the modules
of the program which you are not using, or don’t load them in the first place. Refer to the Special
Functions chapter for more details.

11.5.5 Drums and notation

Cubase offers a number of options in its Score section for notating drum notes. Refer to the
chapter on Notation and Page Layout for important information on this subject.
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12 The MIDI Mixer

The MIDI Mixer is one of Cubase’s most powerful features. It allows access to virtually alt MIDI
events in the form of a graphic display. You can use it to control volume, pan and other MIDI
non-note data, as well as editing sound timbres and other device-specific parameters using SysEx
data. You can even use it to create editors for MIDI devices. Steinberg supplies a number of
current instrument adaptations on the Additionals disk which is included in the Cubase package.
As aresult, you don’t need any specialized MIDI knowledge for basic Mixer operation.

This chapter is divided into two sections. The first section covers practical usage of the MIDI
Mixer based on the preset applications supplied by Steinberg. In the second section we will look
more closely at the theoretical background behind the Mixer. This will enable you to create your
own Mixer applications.

12.1 Introduction

The MIDI Mixer is one of Cubase’s modules, so you have to load it (as described in the "Special
Functions" chapter) before you can start to work with it. Mixer data can be created on any track,
but the track you choose must be assigned to the "Mix Track" Class before you start recording.
The "Mix Track" assignment is the only way to enter the MIDI Mixer.
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Setting the Mix Track Class

A Mix Track can only ever be a Mix Track. You cannot convert it to another Track Class as you
can in the case of the Drum Editor. Like the Logical Editor, the MIDI Mixer has very little i.n
common with the other editors because it only affects a single Part. Before you can work in this
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editor, there must be a Part available and selected on the Mixer track. If no Part has been selected,
then Cubase will enter the first Part of the current track. If the track does not contain any Parts,
the MIDI Mixer cannot be activated. Cubase assigns a special data format to events created in
the MIDI Mixer and uses this data to generate the required MIDI information in realtime or
during playback. Keep this in mind when reading the following explanation as it is an essential
condition to understanding how the MIDI Mixer operates.

We have already seen in the section on the List Editor that Cubase records MIDI Mixer data as
"special events".

12.2 Getting started

- First of all enter several lengthy Parts on different tracks. Then create an empty Part on a new
track for the Mixer by double-clicking or using[Control][P]. It should have the same length as
the passage you have just recorded.

- Set its Track Class to Mix Track.

- Select this Part and choose Mixer from the Edit menu ([Control][M]), or double-click on the
Part to go to the Mixer.

You can only enter the Mixer from the Arrange window, not from another editor. Similarly,
exiting the MIDI Mixer always returns you to the Arrange window. The only similarities
between the MIDI Mixer and the standard editors we have already seen is that you can move,

enlarge, and reduce the MIDI Mixer as you would a normal window. However, you cannot zoom
1t.

Most of the Mixer is taken up by a number of control elements, the "objects". The MIDI Mixer
can contain up to 128 objects. The vertical and horizontal scroll bars are used to access elements
off-screen.
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The MIDI Mixer

Each object is assigned a MIDI function. The function’s MIDI data is sent as soon as you move
a fader or button. The standard Mixer preset supplied by Steinberg gives you "Volume",
"Program Change", and "Balance" objects for all 16 MIDI channels. Additional configurations
can be loaded, created, and saved.

Each Mixer object sends on its own MIDI channel which can be freely defined. This is why
setting the track channel in the Arrange window is neither possible, nor necessary.
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MIDI Thru While Mix Track is Active

However, the MIDI Thru assignment works slightly differently here, which at first encounter
may be a little irritating to those of you familiar with earlier Cubase versions: if you have selected
a MIDI track, the MIDI Thru connection corresponds to "Any". Your keyboard’s MIDI signals
will be passed unaltered through the computer.

If your keyboard happens to be sending on channel 1, then that is the channel on which data is
sent through the computer. This cannot be changed as long as a Mixer track is selected.

For some situations this way of working is not recommended, such as if you want to try out
something on different channels, and at the same time input a few notes on the corresponding
MIDI channel. You could of course keep changing the MIDI send channel on your keyboard.
However current instrument user interfaces mean that this is far too time-consuming a way of
working. Use the following technique. )

12.3 MIDI Thru while Mix Track is active

- Go to the MIDI Mixer as described above.

- Reduce the size of the window so that you can still see the elements you will need later. You
need to be able to see at least part of the Arrange window.

- Activate the Arrange window with a mouse click to bring it to the front of the screen. Reduce
its height until you see a narrow section with several tracks.

This diagram depicts how your screen should look. Owners of large-screen monitors will have
a lot more space available for this:
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The Arrange window and MIDI Mixer in use simultaneously

Now you can activate any other track in the Arrange window, change its channel assignment, and
so use the MIDI Thru function as usual. If you make any movements in the MIDI Mixer, they
are recorded on the output track indicated in the MIDI Mixer’s Title Bar, and not on the track
currently selected.

During our first experiments you can play on your master keyboard throughout Mixerrecording.
Cubase will distinguish between the two types of data so that the Mixer uses only the data it
created, and no other.
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The MIDI Mixer has a special recording mode which is different from the usual one. MIDI Mixer
events cannot be recorded via the usual recording method; on the other hand, this special mode
can only be used to record MIDI Mixer events. All normal recording operations are invalid for
as long as the MIDI Mixer is open. If you decide to try it anyway, the following message will
appear:

Record not possible
in the MIDI manager!

OK

You cannot record in the normal way within the MIDI Mixer

12.4 Initial steps

The upper half of the window contains several options next to the camera symbol, one of which
is the Mode sub-menu, used to determine the operating mode. This is critically important to your
work in the MIDI Mixer.

All control element changes are sent directly to the MIDI output, regardless of whether Cubase
is running or not. In order to record and playback changes made in the Mixer, the Operation Mode
must be switched from Local to Write. Before we look at these settings in detail, let’s run through
the other options.

Steinberg supply a simple configuration in the "DEF" file which is loaded on program start. The
window’s top row contains 16 "counters”. You can use these to generate Program Change
commands 1 to 128 on all 16 MIDI channels. Check that the mouse pointer turns into a hand
symbol when doing this. If this doesn’t happen, press and hold the right mouse button in the Mix
window and select the hand, known as the "Play" symbol, from the Toolbox which appears.

Click with the right mouse button to raise the value of a counter, and with the left mouse button
to decrease it. Observe the way your synthesizer interprets the MIDI messages generated as a
result. You must of course have selected a counter whose MIDI send channel corresponds to the
input channel of your synthesizer.

Make sure that the synth is not on a patch which has been edited but not yet saved, otherwise all
your editing work may be lost. If your machine is set to a combination program or Multi, on some
devices (e.g. Yamaha SY77 or SY99, Roland JV-80) you can switch from program to program
within the Multi.

i x! x| M (] (x|
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Program Changes using the counters

3
3

The fader objects below the counters control the MIDI channel volumes of your MIDI device(s)
which must of course be capable of responding to MIDI Control Change 7, the volume message.
Click and hold the first fader and move the mouse up and down. The fader will follow your
movements and the changes in value will be displayed in the counter and sent out via MIDL. Play
a few notes on your keyboard while doing this to hear the volume changing. You can also click
directly on the desired fader position and the fader will jump straight to it.
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Volume changes with the fader

Keep in mind that in these exercises the recording channel (and therefore the MIDI Thru channel)
must correspond to that of the volume fader, or the volume changes will be sent on another
channel so that no volume changes will be heard. This applies to all the following exercises as
well.

The final row of elements of the preset Mixer controls the pan settings of your MIDI device(s).
The knobs only display the current position graphically. If the little black dot is below and to the
left, i.e. the 7 o’clock position, the value is set to minimum. The maximum value is achieved by
turning all the way to the right. Click and hold when the mouse pointer is in the centre of the pot.
Keeping the mouse button down, move the mouse down or to the right to raise the value. Move
the mouse up or to the left to decrease the value. Here too, your instrument must be able to
recognize MIDI Control Change 10 (Pan), otherwise your movements will have no effect.

OINSIPI9IVIVY

pan 1 pan 2 pan & pan 4 pan & pan &€ pan 7 pan 2

Pan change on MIDI channel 2

Apart from these elements, the Mixer contains a number of other types of object. We’ll look at
these later. Each control element can be moved using the computer keyboard. To do this, the
desired control element must be selected. Click the desired control element (be it fader, counter
display or knob) and press and hold [Shift]: this highlights the object. Make sure that only one
object is selected as you cannot make changes with the keyboard if more are active. Now the up/
down cursor keys can be used to change the value of the selected object. The values change in
larger increments if you hold [Shift] down at the same time.

In addition to the 16 knobs, faders, and counter displays, to the far right there is a master fader.
Try moving it up and down. You will notice that the volume faders follow the master fader’s
movement. The master fader regulates the sum of the other faders’ volumes.

The master volume fader controls all the associated volume faders
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You can use the Steinberg MIDI Mixer configuration to preset your entire setup. You can also
call up the Mixer during playback and make changes in realtime, which will be immediately sent
to the appropriate MIDI channels. Keep in mind that you cannot record with the conventional
record mode when the Mixer is active.

12.5 Recording MIDI Mixer events

Of course you can record the changes you make with the control elements. The Mode switch is
located at the upper left corner of the Mixer window. This is where you tell Cubase how to process
the data you enter. "Local" is the setting we’ve used until now: it allows access to all control
elements and sends the changes to the MIDI output in realtime.

Click Local and it will change to Write. This is the only operating mode where MIDI Mixer
actions are recorded during playback to the Arrange window’s selected Mix Track for later
replay. For instance, you could change your instruments’ volume levels dynamically, thereby
create and record a MIDI mix.

Try the following experiment:

- Enter four tracks containing lengthy Parts.

- Use MIDI channels 1 - 4.

- Define a fifth track as a "Mix Track".

- Create an empty Part equal to the length of the Parts on the first track and select it.
- Enter the MIDI Mixer.

- Set the Mode switch to Write.

- Move all volume faders to the maximum setting, i.e. 127, with the master fader.
- Ensure you are not in Cycle mode.

- Start playback.

- Move the first four volume faders as required.

- Before you press stop, pull the master fader down to a value of 0 with the mouse.
- Stop Cubase.

- Return to the beginning of the Arrangement and start playback.

- This time, don’t change anything, just listen and watch.

Notonly are the fader movements you made played back via MIDI, but the objects on your screen
also move accordingly, provided the Continuous Redraw function is active. To activate it, click
and hold the Local menu at the upper left corner of the Mixer window. Choose Options from the
menu which appears, and a dialog box appears: if not already active, switch on Continuous
Redraw.

Object Definition

Activate Continuous Redraw

12.6 Repairs

You can change acompleted dynamic mix atany time. To do so, simply click and hold the control
element you want to edit. Move it during playback keeping the mouse button down. The
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previously recorded control movements during this section will be deleted, and the new
movements recorded in their place. This works for as long as you hold the mouse button down
on the control element. Once you release the object, the new recording is terminated and the
following events are replayed unchanged. Essentially, this can be seen as a special manual Punch
In/Out function for individual MIDI Mixer objects.

If you are unhappy with major portions of your Mixer recording, you can delete these completely.
Click the right mouse button. The Toolbox contains three tools you can use for this purpose.

&)
>

Deletes from the current song position to the end of the Part

&7
4

Deletes from the beginning of the Part to the current song position

‘L\?
>l

Deletes between the Locator positions

The first tool deletes all the data of one object from the current song position to the end of the
Part. The second tool removes all the data of one object from the beginning of the Part to the song
position. The final tool deletes all the data of one object between the Locator positions. This
means you can define the range with the Locators. Try deleting all the events of one object from
your mix. Select the desired tool and click the object for which you want to delete the events. The
object is briefly highlighted so you know this selection has actually happened.

You can delete the events of all objects in a specified range if necessary. Use the Locators to
define the range and then choose Delete Range from the Local menu. This will delete all Mixer
events in the range you have defined.

All the events recorded in an entire Mixer session can be removed using an even simpler method.
Exit the MIDI Mixer with Cancel or [Escape] instead of Keep (|Return]). All events entered since
you last entered the MIDI Mixer will not be stored. However this does not apply to any changes
made manually to the MIDI Mixer objects themselves.

12.7 Problems and solutions

When you move a Mixer object, Cubase records these movements as special events and converts
them to MIDI data. In the preceding exercises and numerous other uses, Cubase uses these
special events to generate normal MIDI Control Changes. Depending on the number of changes
and the extent of the object’s movements, a large amount of data may well be generated. As large
data loads can cause timing delays and similar problems, Cubase offers a number of options
which can be used to reduce data loads to a minimum.

You will find the Quantize function in the Options dialog box of the Local menu. It defines the
time intervals at which the object element changes are produced in the Mixer. The display defines
this in ticks. Higher quantize values produce larger intervals when an object’s value moves
slowly from O to 127 during playback. This may resultin jumps or steps. You must decide if these
Jjumps are acceptable. Keep in mind that even small jumps in volume and pitch are easily audible.
In this case, select lower quantize values and let Cubase deal with the larger data load.
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However, a fine resolution is not necessary when it comes to changes in Pan. Here you can select
higher Quantize values to reduce the data load. The standard Reduce Controller option in the
Function menu does not work in this context. Similarly, the MIDI Mixer movements cannot be
displayed in the Key or Drum Editors’ Controller Display because Cubase records object
movements in the MIDI Mixer as special events (not detectable by the Controller Display) and
converts them only afterwards.

12.8 Snapshots and static mixes

One of Cubase’s special functions not only reduces the data loads generated, but comes in handy
for other uses as well.

At the beginning of a Mixer recording, the objects are in a particular starting configuration. You
must ensure that Cubase records this initial configuration. There are two ways of doing this. With
the song position set to 1.1.0 and the Write mode active, set the objects to the required positions.
This ensures Cubase records object changes at the current song position. You should not start
playback for this exercise. You are recording a single definition at a single song position, so the
Mixer does not save any dynamic changes, but just the final positions of the movements.

You can place this sort of static set-up at any song position. Go to the desired spot, activate Write,
and set the objects to the desired positions. The last position for each object will be the one used.

This set-up recorded in this way can also be saved as a Snapshot. Set up any object conflguratlon
making sure the Mixer is not in Write mode, otherwise, the set-up will be saved as a static mix.
Now click the Camera icon.

<» File Edit Structure Functions Dtions Modules Windows
[_uF:r Eemeet]  Miner - Track 5, ANy 5. 1. I |
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The fader positions are saved as a Snapshot

The empty line to the right now displays a small picture which represents your Snapshot. Move
the faders and record a new Snapshot. Altogether you can make up to twelve Snapshots.

oA »m\.

You can store up to twelve Snapshots using the Camera

Now click the first Snapshot. You will see your first fader settings displayed. Click any Snapshot
to see its settings displayed. The advantage of this option is that only static settings are recalled,
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and not any movement operations. As with the static mix, the amount of data generated here is
substantially lower.

A Snapshot is saved in a temporary buffer. However, this does not mean it is automatically
assigned to your recording. You must activate Snapshots in the Write mode to add them to your
recording - only then will they be played back. In this case, it doesn’t matter whether they were
recorded during playback or as a static mix when Cubase was stopped.

12.9 Snapshot options

You can of course name your Snapshots. Double-click the icon and enter a five letter name in
the box.

Naming Snapshots

Click a Snapshot icon with the right mouse button in order to delete it. Click on Delete in the
dialog box which appears.

Delete Snap-Shot '9' ?

Cancel Delete

Deleting Snapshots

Snapshot settings can be reprogrammed. Activate the desired Snapshot, set the objects to their
new positions, and then click the appropriate Snapshot symbol whilst holding [Shift]. Any
changes made will now be recorded. Make sure you’ve selected the appropriate mode - Local
- because in Write mode your new settings would be stored at the current song position as a static
mix in the current Arrangement.

If you have already placed the original version of the Snapshot in an Arrangement then these new
settings wili not be used.

12.10 Replace

In order to alter already placed settings, particularly Snapshots, you must use the Replace
function. This function allows Cubase to record new data to replace pre-recorded information.
This can include the setting of a single object or a complete Snapshot.

Go to a song position situated just behind the event you want to change. Activate Replace in the
Mode menu. Use the appropriate objects to enter the new events or activate a Snapshot and edit
it. Cubase inserts the recording from the current song position and replaces the first corresponding
object it comes across with the new object settings.
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12.11 Basic rules

When trying to keep the amount of data down, you should follow these rules:

- Wherever you can, use Snapshots instead of dynamic mix operations.

- Tt is better to click the desired fader position than to move the fader there linearly.
- Use the Quantize function in the Local menu.

-T to insert operations of this type between playback notes.

These basic rules will help you to avoid timing problems creeping in.

12.12 The Mixer Maps

The abilities of the MIDI Mixer are not limited to the features discussed above. The Additionals
disc contains several preset Steinberg Mixer applications in the Mixer Maps file. Most of these
Mixer Maps are small editors for popular devices such as the Korg M1, Kawai K1, Oberheim
Matrix 1000, and others.

Within Cubase, eight different Mixer Maps can be held. A Mixer Map is a self-contained editor
featuring a number of objects. These Maps are loaded into "Slots". You can define which Slots
you want to use in the Arrange window.

Follow these steps:

- Return to the Arrange window.

- Move the dividing line between the Part Display and the Track List to the right until you can
see the Output column.

- Activate Setup Mixer Maps in the Options menu or double-click the Output column of your
Mixer Track in the Arrange window.

The dialog box depicted below is used to assign the eight slots. You can load or remove maps
at will.

Defaul t 49

Empty i)
Empty B
Emptuy B
Empty i)
B
B

The Mixer Map dialog box

Now we’ll load a few maps:

- Insert the Additionals disk containing the Mixer Maps.

- Click one of the eight Slots to select it.

- Click Load.

- Select the desired map from the Mixer Maps file in the Item Selector. Confirm via [Return].
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FILE SELECTOR
Directory:

C:“CUBASE.ADD“MIHERMAP . * MIH_________

Selectinn:!

DR 1DE :
[(A] B
D
16PRGS .MIH E F
JHEP .MIH 5 H
LHPS MIH § 4
M1 MIH 39 f
M3 MIH i B
MATRIH .MIH i £
MIDI MIH
PROTEUS .MIH DK
UDFHSYSEH .MIH
Cancel
Selecting a Mixer Map

- Cubase will load the Map into the selected Slot.

- You can now select additional Slots and load Maps into them.
Default 49 : |
D118TONE 115 | Save
JUND 45
LHPS_1 1 25
E pty 8
Empty i)

Empty B

Loading several Mixer Maps

The Mixer Maps are now held in the memory of your computer. The number of objects in each
is displayed in the dialog box. Each Map can contain up to 128 objects. A Mixer Map can be
removed just as easily by selecting the Map you want to clear and clicking Remove.

Each Mix Track you create can have a different Map assigned to it. Click and hold with the mouse
pointer on the Output column of the Mix Track: a selection list appears from which you can
choose one of the eight Mixer Maps. Each Part you create in this Track accesses the Mixer Map
entered in its Output column.

221



The MIDI Mixer

<» File Edit Structure Functions Options Modules Windows
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Each Mix Track can access one of the eight Mixer Maps

Most of the Maps supplied by Steinberg enable at least partial parameter editing of synthesizers,
Mixers, and similar devices. We’ll take a look at this in detail when we cover advanced
applications.
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An example of one of the supplied setups: a Lexicon LXP 5 Editor

12.13 The first edits

Until now, we’ve accessed existing objects, worked with them, and recorded the results in the
Arrangement. We haven’t actually edited the objects themselves. This is what we will do now.
So as to work with familiar events to start with, let’s begin by creating the Map used at the
beginning of this section for setting volumes, pan, and program changes. But first we must delete
the existing elements.

- Return to the Mixer.

- Select the Arrow tool from the Toolbox.

- Select all Mixer objects using the Select All command from the Edit menu. ([Control][A]). All
the objects will be framed by a dotted line.

- [Backspace] or [Delete] will now delete all objects.
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<» File Edit Structure Functions Options Modules MWindows
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...and then deleted

You should have an empty Mixer window in which we will now place objects. Select the New
tool from the Toolbox. The mouse pointer will become a cross.

First we want to install a counter display for a Program Change. Click with the cross in the
required position, ideally in top left corner. Anextensive dialog box will appear when you release
the mouse button.
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The dialog box used to create new objects

Enter a name for the new object in the Name box, e.g. "1". The only limitation for names is that
they can not exceed twelve letters. Obviously, the name you enter does not affect the object
function in any way.

In the next step, we will define the MIDI Channel on which the object sends its messages. As you
know, you can assign the channel individually for each object. Set the Channel parameter for our
first object to "1". You can also route each object to different MIDI outputs, something we
haven’t done as yet because this function did not apply to any of the previous exercises. Refer
to the M*ROS chapter for more information. If you have already assigned the MIDI channels,
the Instrument field’s pop-up menu contains the correct MIDI channel designation.

A very important aspect of the MIDI Mixer object creation process is specifying the MIDI
message you want the object to generate.

Prog ram_____ | — N
| 122 M ____

tus|GBcontroller &

Note ey ey

Poly-Press 8,Variable > Learn
ctriChange
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{ cancel

Selecting the Program Change status byte

The MIDI Message field in the dialog box is used to define this. For the first exercise, let’s keep
this setting fairly simple. Click and hold with the mouse pointer on the Status field, which is
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where you select the status byte of the MIDI event you want to generate. Let’s select ProgChange
(which is short for Program Change). You will have learned from working through the MIDI
chapter that a MIDI event’s status byte defines which MIDI operation will be carried out.

The Input Line located under the Status field contains the following information:

| EB!““!——!——!——!——!——!——s——!———!——!——:——:——!——

| ProgChange,Variable (33

The Input Line: the hexadecimal numbers above, their meaning below

The display consists of two components: the hexadecimal code above and the code’s meaning
below, provided the program recognizes it. You don’t need to have a thorough understanding of
the hexadecimal number system for the examples in this section. However, the sections which
follow and more complex applications require this knowledge.

MIDI Program Change commands consist of two bytes, the status byte, in this case "C0", and
a data byte that specifies the program you want to call up. The second byte is entered in the Input
Line as "XX", which is a variable that represents the byte you will edit with the control elements
in the MIDI Mixer. We’ll take a closer look at this in a moment.

This already completes the MIDI message assignment for our Program Change object. The
following operations apply to this object’s graphic display and its specific function. The Object
field is used to define its graphic display. You already know three of the options - the fader, the
knob and the counter display. Three other objects are available:

[alals
@ L b kA

The familiar objects

The function of the horizontal fader is identical to that of the vertical fader, only the graphic
display is different:

The horizontal fader

The push button is different from all other objects in that it can only send two different values.

The push button

The "Text" event fulfils no MIDI function. It is simply used to label the Mixer or to describe its
elements. You can use the Text function to add comments on the Mixer Map or to designate
certain elements.

TERT

Entering text

The only other settings that are also important to our first object are the Value Min and Value
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Max entries. Leave these at "0" for the minimum and "127" for the maximum values. These
parameters are used to limit an object’s value adjustment range. Most synthesizers and MIDI
sound modules accept Program Change commands from 0/127, so no changes are necessary.
However, if you have assigned MIDI Channel 1 to a sound module that has a more limited
number of programs, then you should enter this device’s highest program number.

N.B. Different instruments use radically different numbering systems. Some devices use a bank
system (A-1, A-2..D-16), others start at "1" rather than "0". This does not affect the MIDI
message because MIDI always counts from 0 to 127. However, you have to know which
programs these numbers address. Refer to the appendix for a conversion table.

Object Definition

CO,HH, _,__
[¢| ProgChange

The different types of object

Select the counter object. This is all we need to do to define the first object, so now click OK
([Return]). The counter display is at the desired position in the Mixer. Before we try it out, here’s
a brief explanation of the tools in the Toolbox and their functions:

- The Hand is used exclusively to manipulate objects.

- The Arrow allows you to change existing objects.

- The New tool creates new objects and calls up the definition box exclusively for this purpose.

Select the Hand tool and move the values in the counter display up and down. Follow the results
these movements produce on your sound module. If you defined a maximum value other than
127, that is as high as the counter will go. Press and hold [Shift] and the value changes will be
larger increments. Ensure you are in the Local and not the Write mode, otherwise your
experiments will be entered in the current Arrangement.

Now activate the New tool in the Toolbox and define fifteen more counter displays. Note that
the cross position corresponds to the object’s left upper corner. Don’t feel you have to work
through the following steps to enter the remaining counter displays. Steinberg has, after all,
supplied you the completed Map. These practical exercises are designed to help you understand
how objects are created, not to force unnecessary work upon you.

The procedure for the remaining objects is as follows: click the desired position with the cross.
Now all you need to do in the Object Definition box is move the MIDI channel setting up by one
for each object, select the desired object shape, in this case a counter display, and enter a name
forit. You can copy existing objects: select the Arrow tool from the Toolbox and drag the counter
display to the desired position while holding [Alternate] and the mouse button down.

As soon as you release the keys, the Definition box will appear. You can now enter the desired
parameters. The object type is already set to the counter display.
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You can prevent the object and instrument names (if indeed you have set any) from being
displayed via the Show fields, if you wish.

If you run into any space problems, you can move any existing objects at any time. Select the
Arrow tool from the Toolbox and select an object with a mouse click. Hold the mouse button
down and drag it to another position. Cubase places the objects on an invisible grid, which makes
precise positioning much easier. Press and hold [Control] to disable the invisible grid. This
allows you to move objects very small distances. One or more selected objects can be deleted
via [Backspace] or [Delete].

Anexisting objectcan be edited as much as you want later on. Double-click it or select it and press
[Control][1]. This opens the Object Definition box in which you can enter any parameter changes.

Now we’ll go on to the next item in the Map, the volume faders. We will create at least one of
them to get some practice. Select the New tool from the Toolbox and click the desired position.
Enter the name and the MIDI channel. Click and hold the Status field and select Control Change.
A MIDI Control Change event consists of three bytes: the status byte "B0", which defines it as
a Control Change message, and two data bytes. The first data byte specifies the Control Change
function.

For our example, we need Control Change number 7 for volume. The input line contains
Controller 0, soit mustbe changed. You have two options. If you click the inputting field, a cursor
appears. Use the keyboard cursor keys to move this cursor to the second byte. Delete it with
[Backspace] and enter "07". You can delete the entire line via [Escape] if this should become
necessary. Keep in mind that the input field displays hexadecimal numbers. Volume’s hex value
happens to be the same as the decimal number, but this does not apply to all values. For instance,
sustain Control Change 64 has the hexadecimal number 40. Refer to the appendix for a complete
conversion table.

Direct typed input is only necessary for values which, for instance, refer to SysEx data. Cubase
offers a simpler option for handling Control Changes: click and hold the down arrow next to the
Controller field. A Control Change selection list appears. Select "MainVolume": the first data
byte is automatically entered in the input line.
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Control 28
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Quick access to the Control Change first data byte

This list may seem too long to scan comfortably, but as soon as you click and hold the bottom
arrow, the list scrolls down automatically giving access to the remaining entries. The second data
byte, i.e. the variable value, doesn’t change of course as this value is generated using the object.
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Select the correct object type, in this case the vertical fader, and exit the Object Definition box.

Now that we’ve created the desired object, we want to adjust its size. Select the Arrow tool from
the Toolbox and click the fader. It will be framed by a dotted line. A black square is located at
the bottom right corner. Click and hold here with the mouse button and then drag downwards with
the mouse. In this way you can change the object to any size you like.

The size does not dictate the maximum value range, but keep in mind that you cannot access the
finer resolution intervals if the object display is too small. Object enlargement is designed for
fader, text and button objects only.

Ydlume 1

volume 1

The defined object entered ... and ... enlarged to its final size

You can’t start changing values in this mode. For that you have to activate the correct tool, i.e.
the Hand tool.

12.14 New objects

In the following exercises we are going to create a number of new objects with the instructions
in shorthand. Please follow these in the order they are listed. Set all new objects to MIDI channel
1. Check that the receiving device is set to the same MIDI channel.

12.14.1 Sustain button

- Status byte: Control Change.

- Damper Pedal from the Controller field.
- Object type: push button.

- Value Min: 0, Value Max: 127.

In our example, the button sends two values: Min Value, which is 0 because the pedal is not
depressed, and the Max value of 127 denoting that the pedal is pressed, in which case the button
is shaded grey. You can change these values to achieve other effects. If you define a volume
Control Change for the button, you have a mute button. You only have to change the Control
Change number from Damper to Main Volume. You will need to reverse the values, i.e. 127
when not depressed and 0 when the mute is activated. To do this, click DIR in the Definition box.
If the Rev entry is check-marked, the object’s function is reversed. For a vertical fader, this would
mean the O value is at the top instead of the bottom.

12.14.2 Panpot

- Status byte: Control Change.
- Pan from the Controller field.
- Object type: rotary knob.

- Value: 0 - 127.
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A pan control has a special characteristic which you can allow for in the Definition box. Pan is
usually moved from the centre position to the left or right. The corresponding MIDI values are
64 at the centre position, 0 to the far left, and 127 to the far right. Activate the Centered parameter
in the Definition box by clicking on the box at the right. The knob display has a centre mark so
you can get to see its position better - it has no effect on the MIDI output. You can enter names
for the values to help with identifying the function. Use "L" for the minimum value, "R" for the
maximum value. Both will be displayed in the MIDI Mixer, but they have no effect on any
operations.

12.14.3 Bank Select (e.g. for the Korg Wavestation)

- Status byte: Control Change.

- Control 32 from the Controller field.
- Object type: push button.

- Min Value: 0, Max Value:1.

You can use this configuration to button between the banks of the Korg Wavestation. Press once
for the RAM 1/2 bank, press twice to activate the ROM and Card bank. This only works when
you specify a program in the bank after the Program Change command. Therefore, create another
counter display with a Program Change status. Limit the value range from 0 to 99. Program
changes from 0 to 49 select the programs in the first two banks, ROM or RAM 1, 50 through 99
address the programs in the other two banks, Card or RAM 2.

Limiting the value range in this way ensures that you do not send values to the sound module that
it can not recognize. If you send Bank Select values greater than 1, the instrument will not
respond.

12.14.4 Additional controls

The number of possible status bytes tells you that there are virtually no limits to what you can
do. You can create Pitch Bend, Modulation or other non-note MIDI data. You can also create
"note buttons" which allow you to remote-control mutes in some mixing desks via MIDI. The
process is the same as the one discussed in the exercises above.

Many instruments allow you to control various parameters via MIDI. For this the manufacturers
use the standard MIDI Control Changes. If one or more of your instruments allow realtime
Control Changes to affect their internal reverbs or filter parameters, you can use this to your
advantage: find out which MIDI Control Change is assigned to which parameter.

A number of devices even allow you to define these assignments. Create an appropriate object
in the MIDI Mixer. Ensure the MIDI channel and Control Change number settings are correct
and define the appropriate value range. For example, if you can access 50 different reverbs in an
effects device, it is unnecessary to assign a value range of 0 to 127 to a Mixer control object.

The majority of MIDI devices allow internal parameter changes at least on a System Exclusive
basis. You should leave trying to use this way of working until we have run through some
practical exercises on SysEx data.

12.15 Back to the beginning

For the following exercises, we’ll return to our starting point, so recall the Steinberg Mixer
preset. We’ll take a look at the remaining three topics: Master Fader, Text objects, and Remote
Controllers.

12.15.1 The Master Fader

Switch to the mouse Arrow tool and open the Object Definition box via a double click on the
master fader.

229



The MIDI Mixer

| Master____ o W-——— N
B 127 _——

status|SBEController ©

BB,B_l',HH,__,_._,___,,___,__,__,_._._.___,__,__,__,___
G| ctrichange ,Mainlolume,Variable 153
Link | No Ctrl
3
ATARI

The Object Definition box for the master volume fader

In order to create a configuration where one fader becomes the master and several othersits slaves
(i.e. they follow its movements), several characteristics must first be programmed. So that
Cubase can create several independent masters, all the objects in a group are assigned to Master
Groups: all objects including the master fader must belong to the same master group. You can
check this by looking at the master group settings of the master fader and other faders. They all
belong to the same group, in this case 3.

Up to 128 different master groups are possible. Try changing a fader’s master group setting and
then return to the Mixer. Now move the master fader: the fader whose group assignment you just
changed will not follow its movement anymore. The Reverse parameter next to the master group
causes the opposite movement to that of the master fader. In other words, in the standard setting,
the fader follows the master fader’s movement. If you click the empty box beside Reverse, then
it reverses to move in the opposite direction. If you move the master fader down, all the other
faders in the same group move up.

The master fader’s parameters

Now that we know how to assign a fader to a master fader group, we have to find out how to
redefine a fader as a master fader. The Mode field serves this purpose. You can only assign one
master fader per master group.

NO
Prop.
_ Link

The Mode field’s options
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Click and hold the downward arrow. You can select one of three options form the list. "No"
means that the object is not a master fader. Link and Prop assign the fader to a defined master
group. The two settings have different connotations: Link ensures all faders in the group follow
the master’s movement exactly. Prop(ortional) ensures the proportions between the individual
faders remain. Try this little experiment. Set the setting of the master volume fader to Prop in the
Definition box and return to the Mixer.

ae a2

er

All assigned faders follow the master fader’s movement exactly in Link mode

&

f . H 0L

TEE er

The relative positions between faders remain in Prop mode

Set the master to a value around 50, the 16 faders to different values, and then move the master.
You can see the relative positions between faders remain. Drag the master fader toits upper limit.
The faders all move to the upper limit, but as long as you hold the mouse button down, the relative
positions are still valid. Drag the master fader back down. The faders return to their initial
relationships. However, if you move the master fader and the others to the upper limit and release
the mouse button, the original positions are deleted. This holds true for the bottom limit as well.

12.15.2 Text objects

The text object is specifically for labelling your MIDI Mixer. Select New from the Toolbox and
click any open position with the cross. The only two parameters we’ll concern ourselves with for
the moment are the object type (select Text), and the Name box above it. You can enter up to
twelve letters. They are then entered in the Mixer’s Text box. If you need more letters, you have
to create another text object. Keep in mind that you only have a total number of 128 objects
available, so don’t have too much text in the Mixer when you are using lots of objects.

12.15.3 The Remote Controller

Each individual object can be remote-controlled using a MIDI Control Change. The Remote
Controller field is used for this function. Go to the Object Definition box of the master fader and
click and hold the downward arrow of the Remote Controller.
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Setting the Remote Controller

Select Modulation from the selection list which appears, then return to the Mixer. Ensure that
you are in Play mode. If the mouse pointer has turned into a hand then you are. Select the master
fader by pressing [Shift] and clicking it. You can now use your master synthesizer’s modulation
wheel to remote control the master fader.

Bear the following rules in mind:

- Ensure the messages coming from the master match the fader input Control Change number.
- The same applies to the MIDI channel numbers. Select MIDI Output in the Object Definition
box of the master.

- The fader(s) must be selected in Play mode.

_ Cubase filters those Control Changes that are used for the remote control of the MIDI Mixer
out of the MIDI Thru circuit to avoid the possibility of data overspill.

This allows you to redefine Control Changes in real time. For instance, if you assign the
modulation wheel as an external performance controller for a fader that is generating Pan values,
you can then control the Pan from the modulation wheel in realtime. The values of the
performance controller are used to control the fader only, and are not sent on. This ensures you
only control the pan, and don’t accidentally cause modulation to happen somewhere.

12.16 Saving your maps

You should always save Mixer Maps you have modified or created. First go to the Mixer Map
dialog box in the Options menu. Double-click the current Slot and enter a new name. Click the
Save button. The map is permanently saved to floppy or hard disk.

12.17 SysEx data

Until now, we’ve worked exclusively with MIDI Control Changes and in areas where the
majority of devices react the same way to standard commands. The MIDI chapter covered the
basic structure of SysEx messages. These MIDI messages can be used to access virtually all
parameters in your device, edit them, or exchange complete sounds and sound banks.

A detailed introduction to all aspects of SysEx data would exceed the bounds of this book, so we
will concentrate on the important aspects only. Not all of this information is necessarily related
to the MIDI Mixer, but we will use this opportunity to get to know SysEx data in this context.

12.17.1 Sounds

Each sound in a sound device is the sum total of its parameter settings, i.e. filters, waveforms,
envelopes, etc. This data can be sent viaMIDI as SysEx messages. You canuse Cubase toarchive
sound data and complete sound banks for each of your devices.

This method has a few disadvantages when compared with conventional editors and sound
banks; for instance, the sounds’ names are not displayed. However, it also has decisive
advantages. Although you can use Program Change commands to select the correct memory
locations for different songs, if you have changed the sounds in your synthesizer via MIDI or
cartridge, the correct program number is activated but the sound currently stored with that
number may be different.

This is why it is advisable to archive the sound data assigned to the program numbers. This
method ensures that at the start of a song the right sounds are transferred to your sound modules.
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12.17.2 Recording data

Sound data can be recorded in complete blocks in the normal way in the Arrange window.
Whether the data block consists of a single sound or a complete sound bank is immaterial.
Recording sound data is a lengthy process and generates large data loads. You should not mix
this kind of data with normal data such as notes. Keeping these types of data at different points
avoids the annoying side-effects that occur when normal data is mixed with SysEx MIDI
messages.

Reserve several empty bars before the music begins for sound data. Of course, handling SysEx
data is only required if you change the sounds in your synths from time to time, or if you have
an enormous library of sounds to choose from. If you never exchange sounds in your devices,
you can skip the following exercises.

A large number of synthesizers and MIDI devices allow you to transfer their memory contents
at the push of a button. This is the simplest and best option to use to save sound data in Cubase.
With some MIDI devices, you can even choose if you want to transfer all the sound data, just
some specific sounds in a bank, or individual sounds.

If your instrument features this option, data transfer to Cubase should present no problems. We’ll
use the Roland JV-80 as our example. Save the internal sound data on another storage medium
such as a sound card to avoid permanently losing data during our experimentation.

This is what you do:

- Ensure first of all that the MIDI Thru Filter in the Options menu’s MIDI Filter function is active
to avoid a MIDI loop.

- Make absolutely sure that the MIDI Record Filter is set to allow SysEx data to pass: the System
Exclusive entry must not be highlighted.

- Select a free track and mute any tracks you may have already recorded on. Return to the
beginning of the Arrangement.

- Press the Write/Compare button at the top right corner of the JV-80’s control panel. You are
now in the JV-80’s communication menu.

- Select the Bulk entry from the Roland display with the arrow keys. The entry flashes.

- Press Enter on the JV-80. You can now choose what kind of data you wish to send to Cubase.
Let’s stay with the Internal presets for now.

- Press Enter, which puts the unit into stand-by mode.

- Start Cubase recording.

- Press the Roland’s Enter button again as soon as the Cubase count-in is finished to initiate the
transfer of data.

Do not use Cycle mode and ensure Punch Out is switched off. Never start the recording before
the count-in is finished, otherwise the MIDI data may be recorded incompletely. The track
channel must be set to "Any". The same holds true when you send data back to the instrument.

The JV-80 display shows Now Sending. A row of dots denotes the MIDI data transfer, and
Cubase’ s MIDI Input display indicates a continuous activity. Stop the recording as soon as no
more MIDI data is being transferred. Go to the List Editor and take a look at the massive data
mountain you have generated.

You have effortlessly duplicated the JV-80’s sound data from its internal memory to the
sequencer. The transfer from Cubase to the Roland is just as simple. Return Cubase to the
beginning. Ensure the JV-80’s Memory Protect function in the Write/Compare menu is
deactivated. Set Cubase to playback. All sounds will be sent back to your instrument. Do not stop
Cubase until the load operation is completed.

12.17.3 SysEXx in various devices

This example should familiarize you with how data is recorded and transferred. Many devices
have quite a few options enabling you to transfer the entire memory content or portions thereof
via MIDI. Data transfer for complete sound banks or single sounds is too complex a subject to
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go into the details here. The following gives an overview of the various data transfer options, so
you at least have some help in choosing the best method for your situation.

- Data transfer with the push button method as in the above example. This method should be fairly
simple in most cases, as you can see by the JV-80 example.

- Loading sounds via the normal MIDI transmission. This is the simplest download method.
There isn’t much to worry about.

- Some devices do not allow you to initiate a dump by a button push. You will need a Dump
Request to cause them to send their data. You can create a dump request in the List Editor, such
as for the Yamaha DX7: create an empty Part, select it, and go to the List Editor. Use the Insert
menu to enter a SysEx event in the first bar. If you can’t remember how to do this, refer to the
chapter on the List Editor. Move the dividing line between the grid and event list to the far right
until the Comment column is visible. Double-click the Command column of the SysEx event you
have generated. An input line will appear which already contains the two entries, "FO" and "F7".
All entries in this line must be made using the hexadecimal number system.

- Now you need to enter the Yamaha DX7’s dump request code. We want to transfer all 32
internal sounds to the Atari’s memory. Go to the DX7’s operating manual and find the correct
command in the MIDI Implementation Chart. In case you don’t have this available, here is the
information: Yamaha lists the command structure in binary numbers, not in hexadecimal (the
table in this book’s appendix can be used for converting). The command’s structure looks like
this:

1. Byte "FO": Tells Cubase a SysEx message is on its way.

2. Byte "43": The Yamaha company ID.

3. Byte "20": A sub-status byte that defines the MIDI channel.

4. Byte "09": Tells the DX7 to send all 32 sounds via MIDI.

5. Byte "F7": Ends the SysEx message.

- Enter the number sequence, "FO", "43", "20", "09" and "F7", in that order in the Editor line.
Each byte must be separated by a comma. If you forget a comma, Cubase will let you know
immediately. Exit the input line via [Return] and go back to the Arrange window.

- The MIDI channel of the dump request track must be setto "Any" and the DX7 to MIDI channel
1. Select a new track and start recording. Cubase sends a dump request and the DX7 responds
by sending the 32 internal sounds to its MIDI output. This data will be recorded by Cubase on
the new track. Do not stop Cubase until the MIDI Input display ceases to move.

- To download the data back to the DX7, proceed as follows: delete the DX7’s internal data or
load several cartridge sounds to its memory so you can monitor if it has received the sounds
correctly. Mute the track containing the dump request. Deactivate the Memory Protect function
on the DX7, otherwise data loading will be impossible. Leave all other settings as they are and
start playback. The sounds will be transferred back. Once the transfer is complete, you can listen
to the results.

This method can be used for other devices. However, there are a few things which might prevent
data transfer:

- Some synthesizers operate on specific MIDI channels when using SysEx data, even though this
isnotabinding MIDI standard. The DX7 is one of these devices. This means that several identical
devices within one MIDI system can be addressed independently. Always leave the Cubase -
MIDI track channel containing the sound data at the "Any" setting. This ensures the MIDI
channel setting of the send device is used. If you change the MIDI input channel of a device after
sound transfer, you may run into problems when you attempt to download, as the sound module
may ignore the SysEx data being sent on the original channel.

- Other devices use a "Device number” that can be set in the module. Leave the MIDI channel
and device numbers at their standard settings. If you have two identical devices you will
obviously need to assign a different device number to each.

- Edit the recorded MIDI data only when you know exactly what you’re doing and how you’re
going to achieve your aim. Extremely long SysEx message chains such as sound banks cannot
be edited in Cubase.

- Many devices use what is known as Handshaking for uploading and downloading. The sender
and receiver communicate in both directions during the load procedure.
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- This type of transfer technique requires extensive programming, so we will avoid handshaking
routines for the time being.

- Keep in mind that most devices cannot produce any sounds when transferring large amounts
of SysEx data. Data transfer from Cubase to MIDI devices should be carried out at a suitable
point, i.e. where it does not interfere with timing.

12.17.4 More on SysEx

Let’s go back to the MIDI Mixer. As well as SysEx messages allowing the transfer of complete
sound banks, they can also be used to edit individual parameters, such as a synthesizer’s filter
frequency during recording. Some devices, e.g. the Roland JD-800, transmit Parameter Change
SysEx messages in realtime, i.e. as you change the settings on the device. You can record these
changes in the Arrange window using the normal Record mode.

The MIDI Mixer offers extensive applications for most devices that do not send Parameter
Changes via MIDI, but can still interpret SysEx data. We’ve already discussed the Mixer Maps
Steinberg has supplied that work on the basis of SysEx data. Now we will take a closer look at
them.

Go back to the MIDI Mixer and load the Steinberg Editor Mixer Map for the Lexicon LXP 5.
If for some reason this map is not included, select another one. You can include all object
movements in your Arrangement during Cubase Mixer recording. For instance, you could record
changes in the LXP 5’s effect intensity. The same applies to synthesizers. In many cases, the
Mixer Map can be used as an editor to create new effects when Cubase is stopped. You will need
to bear three things in mind:

- The positions of the Mixer objects will not normally reflect the current settings in your MIDI
receiver. This may cause undesirable effects: a synthesizer’s filter may be completely open and
you want to change this setting via the appropriate MIDI Mixer object and record it. The object
you want to use to control this filter frequency is at the zero position. As soon as you click it with
the play hand to move it, the filter setting will jump to the zero position and must then be moved
back up to the desired value. You’ll hear an unpleasant glitch when playing back your recording.
- If you edit a device using the MIDI Mixer, keep in mind that the changes are temporary: most
devices store these changes in a temporary buffer. If you want to retain an edited sound or effect,
you must save it in the respective device.

- Some editors are tied to a particular channel, i.e. they process SysEx data on a single specific
MIDI channel. Your device must be set to that MIDI channel, otherwise it won’t follow the MIDI
Mixer edits.

Let’s return to the LXP editor. Select the Arrow tool from the Toolbox and open the Object
Definition box for the LFO Rate. This controls the modulation rate of, say, a chorus effect. You’ll
recognize most settings from the previous exercises. The input box in the MIDI Message box is
of special interest here. It contains neither controllers nor events, but exclusively SysEx
messages. You can find the appropriate bytes in the operating manuals of the respective devices.
All you need to find out is what the structure of the parameter’s SysEx code looks like so you
can enter the correct code here. Cubase has a "Learn” mode for all MIDI messages, where
incoming MIDI messages are automatically analyzed. Cubase finds out the required status bytes,
message length, and the positions of the variables for you. Try it out: click Learn, move a
performance controller on your master back and forth, and click Learn again. The input line will
display all the necessary information. You can even design a new object. This extremely simple
solution can be applied to SysEx data, which makes the creation of your own editor a simple
affair. However, the device must be able to transmit these Parameter Changes via MIDI and send
them to Cubase. Unfortunately, very few devices can do this, so you are usually forced to enter
the SysEx code manually.

12.17.5 The checksum and some special cases

In the last few years, the MIDI implementation of all devices has grown more complex and more
confusing. The different methods used to structure and transmit data require a great deal of
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specialized knowledge on the part of the user. In the past, creating a fairly simple editor for the
first Yamaha DX7 was quite feasible. However, many new devices require a great deal more
knowledge and time for such an endeavour.

However, even Cubase cannot generate all the messages needed for SysEx activities, since each
manufacturer has developed his own way of dealing with SysEx.

Many devices use a "Checksum" during parameter changes. This checks if all bytes were
correctly received at the end of a data transmission. If even a single byte is missing, an error
message is sent. If the Checksum is not sent and recognized, SysEx message cannot be sent.
Cubase automatically computes the Checksum for most Roland devices.

The Controller field has additional options available for special SysEx messages sent to devices
by various manufacturers. Some of these applications, such as sound settings using sample
selection in a ROM player, require you to enter higher values then the 128 maximum possible
via MIDI.

- "LXP Uni" and "LXP Bi": both are specifically tailored to the Lexicon LXP 1.

- "MIDI-Byte>2 Nibbles": in this case a MIDI byte is divided into two 4-bit packages (nibbles)
and sent in the MIDI format.

- "Full Byte>2Nibbles": The variable is extended to a full byte. The value from 0 to 255 is divided
into two and sent in two bytes. The Ensoniq VFX uses this function, for example.

- "14 bit": The variable is converted to a bipolar 14-byte format used for example by the M and
T series Korg synthesizers.

-,,"7bit +MSB": The variable is extended to a full byte format (0 - 125). This format is used by
Oberheim Matrix synthesizers, among others.

If you want to use one of these formats, enter the variable in the input line of the SysEx message
at the position you want to change. The following byte must be set to "00", to leave room for the
extensions discussed above.

It would take too much time and space to discuss all the details here: please refer to the operating
manuals of your devices.

12.17.6 Some good advice

Do not work with SysEx data until you are absolutely sure you know what you are doing. Only
a few experts succeed at programming complex Mixer Maps for sound editing. If you want to
try it anyway, use Steinberg’s Mixer Maps or special editor programs. Find out if it is possible
to change your instrument’s sound parameters via MIDI Parameter Changes. This is a much
simpler method than dealing with SysEx messages. The results are the same, just the effort and
complications are so much less than with SysEx messages. Besides, Parameter Changes don’t
suffer from the typical SysEx communication problems that occur when other MIDI messages
are sent at the same time.
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1 3 The Logical
Editor

The four Cubase editors we’ve already looked at enable you to edit and create various MIDI
events simply and clearly. You have probably noticed that the major differences in the editors
are basically due to the form of display. The basic functions and editing possibilities are not that
different; it’s just the graphic representation that varies. You can select your favourite editor for
any particular situation, as each editor has a use to which it is especially suited.

The editors we will cover in this chapter, and the next one, are different to the editors we have
covered so far, both in their function and operation. MIDI is an essential factor here, so prepare
yourself by reviewing Chapter 5 if you still don’t feel at home with this subject.

The Logical Editor enables you to extensively manipulate your recorded material. It does
however require more abstract thought, but don’t let the sheer magnitude of features bother you.
Once you understand its basic functions, you’ll see that the Logical Editor is a valuable creative
tool. We’ll approach this editor in the usual way, with the help of practical examples. At first,
we’ll stick to the basics so you quickly get an idea of what it’s all about. Then we’ll use other

examples to show what logical editing is ultimately capable of.

13.1 Starting is the easy bit

Logical edit functions work on all the selected Parts. If no Part is selected, then all the Parts on
the active Track are edited. This differs from the way the other editors work, where you select
the Parts and work on them one after the other. Here, all Parts are edited at the same time.

Note: if you call up the Logical Editor from another editor, pay attention to the setting in the
"selection” sub-menu. If the setting is "All", then all the events in the Part are edited by the
Logical Editor. The "Selected" setting means that only the events that were previously selected
in the other editor will be edited.

If you didn’t select an event before you changed to the Logical Editor, then editing is impossible.
If you are not quite clear about the significance of the "selection" sub-menu and its options, refer
to the relevant section in the chapter on the Key Editor. The top field in the Logical Ed<ns1:XMLFault xmlns:ns1="http://cxf.apache.org/bindings/xformat"><ns1:faultstring xmlns:ns1="http://cxf.apache.org/bindings/xformat">java.lang.OutOfMemoryError: Java heap space</ns1:faultstring></ns1:XMLFault>